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1 Introduction 
 

Thank you very much for purchasing our product. 

Olympus Dictation Management System is a Dictation/Transcription system that supports assignments of 

various sizes, from individual users to multiple users. 

 

Olympus Dictation Management System Outline 

Licenses 

Devices Connectable to Dictation Module 

Supported File Formats 

 

Check the details about the system requirements. 

 

http://olads.olympus-imaging.com/RSS/odms_requirements/index.htm
http://olads.olympus-imaging.com/RSS/odms_requirements/index.htm
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1.1 Olympus Dictation Management System Outline 
 

Olympus Dictation Management System R7 (ODMS R7) is a software product optimized to manage the 

workflow from dictation to document. It can be used to import audio data highly compressed with an 

Olympus digital voice recorder (hereinafter referred to as "the recorder") to a PC. 

 

ODMS R7 offers the following: 

⚫ Download a dictation file to a shared folder automatically when you connect the recorder to the PC 

so that it can be assigned to a transcriptionist. 

⚫ A dictation file can be assigned to a transcriptionist by directly recording to a PC using RecMic. 

⚫ A downloaded file can be assigned to a transcriptionist via e-mail or FTP. 

⚫ Efficient transcription is facilitated by use in combination with speech recognition software. 

(Background speech recognition and real-time speech recognition) 

⚫ The recognition rate of documents for which speech recognition has been performed can be further 

improved by adaptation. 

⚫ Transcription documents can be shared in a folder or sent via e-mail or FTP, and are linked 

automatically with the original dictation files. 

⚫ The status of a transcription can be determined at a glance. 

⚫ Transcription can be performed while listening to the dictation file in the Playback Control window. 

⚫ Security and other advanced settings can be configured in addition to the items that can be 

configured on the device. 

 

ODMS R7 supports virtual environment, and is compatible with Citrix XenDesktop as well as XenApp 

Published Desktop and XenApp Published Application. 

It also supports Terminal Services provided by Windows Server products, allowing this product to be used 

via the Terminal Services Client Virtual Driver. 
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1.1.1 System Configurations of ODMS R7 

 

ODMS R7 offers two system variants with different administrative configurations. 

• Standalone System 

With this configuration, an individual user enters the supplied license ID (for a single license), installs 

the software on the system, and configures settings of the software. User profiles (various settings 

for each user) are located on local PCs and managed by individual users. 

 

 

 

 
About silent installation with a volume license ID 

Silent installation with ODMS R7 DM/TM Volume License for Standalone can 
standardize the settings of multiple users. For information on how to achieve this, 
refer to “Installation Guide.” 
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• Workgroup System 

With this system configuration, an administrator installs and configures the modules for each user, 

and centrally manages and operates them under a volume license. This system requires System 

Configuration Program (SCP) to be installed to manage the user profiles and license. 

The user profiles are managed in a database, and are used to assist each user in changing and 

locking individual settings and in installations. 

 

 

 

 
About Workgroup System installation 
For information on how to set up the Workgroup System, refer to “Installation 
Guide.” 
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1.1.2 Modules and Tools 

 

• Dictation Module 

Dictation Module is software that enables an author to easily download and manage dictation files. 

It also supports direct recording using an Olympus USB microphone such as RecMic. 

In addition, hands-free recording is also possible using a 4-pedal foot switch such as the RS31. 

Configuring the automatic settings of the workflow enables Dictation Module to automatically 

download and automatically transfer (via a designated LAN network, e-mail, or FTP) after the 

recorder is connected to a PC so you can share your dictation files with a transcriptionist or perform 

transcription automatically using the speech recognition functions linked with Dictation Module. 

 

• Transcription Module 

Transcription Module is software that allows you to playback dictation files with your hands free by 

using a USB foot switch such as the RS-31. 

It can streamline transcription by, for example, automatically specifying a document template and 

starting your word processor when transcription starts. In addition, it can reduce the workload and 

improve the productivity of a transcriptionist by using the speech recognition functions to 

automatically create a document and synchronize with the voice to make corrections. 

Furthermore, playback control, user interface, foot switch customize function, and other settings 

required for transcription can be accessed easily. 

 

• System Configuration Program (Workgroup system only) 

 

SCP is software for administrators, which is used when structuring a Workgroup system. It facilitates 

management of software settings for end users (authors and transcriptionists) and update of 

firmware. 

 

• SCP Client 

SCP Client is installed on the client PC, and is resident software that operates in conjunction with SCP. 

The software starts up automatically when the PC is started, and when it detects a connection to a 

DVR, it automatically downloads the files and stores them in a specified location. 

 

• Device Customization Program 

This is a tool to manage device settings in a template, and supports the customization of device 

settings and the importing/exporting of settings. It allows you to connect devices by USB and then 

configure the same settings on multiple devices. 

Furthermore, the device settings of individual users can be managed by using the import/export 

functions. 

 

• Client Virtual Driver (Workgroup system only) 

Client Virtual Driver is installed on a client PC when using Dictation Module and/or Transcription 

Module under a virtual environment installed on a server. 
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A Citrix XenApp driver or Windows Terminal Service driver is provided, and communication between 

the client PC and server is supported to make it possible to use all of the Dictation Module and 

Transcription Module functions. 
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1.2 Licenses 
 

A license is required to use ODMS R7. ODMS R7 is provided under the following types of licenses: 

• Single License (ODMS R7 DM/TM Single License for Standalone) 

This is a license ID, bundled with a recorders or foot switches, which allows single licensing of ODMS. 

The license bundled with the recorder allows the Dictation Module to be installed on a PC. The license 

bundled with the footswitch allows only Transcription Module to be installed on a PC. 

• Volume License (ODMS R7 DM/TM Volume License for Standalone) 

This is a combined license ID that groups several single licenses into one license ID for both Dictation 

Module and Transcription Module. A volume license is managed as a floating license. 

 

Purchasing an Initial or Additional Volume License 

In exchange for the corresponding number of single licenses, a volume license is available free of charge. 

Please contact our support team for details. 

 

Other License Keys 

ODMS R7 license keys vary depending on the system. 

Use the appropriate license for each system. 

Please contact our support team for information on re-issuance or replacement of a license. 

The following table shows the licensing scheme for ODMS R7 system configurations: 

 

System Name Required License 

Standalone System ODMS R7 DM Single License for Standalone 
ODMS R7 TM Single License for Standalone  

 ODMS R7 DM Volume License for Standalone*1 

ODMS R7 TM Volume License for Standalone*1 

Workgroup System ODMS R7 Volume License  
 

 

 

*1: If not using centralized user management with SCP and sharing data only, a system can be 

configured under a ODMS R7 DM/TM Volume License for Standalone. 
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1.3 Devices Connectable to Dictation Module 
 

Dictation Module supports the following Olympus devices: 

 

Device Type Models 

DVR 

(Mass storage recorder) 

• DS-9500 

• DS-9000 
• DS-7000 
• DS-5500 
• DS-3500 
 

RecMic 
(Digital microphone for 
dictation) 

• RM-4110S 
• RM-4100S 
• RM-4015P 
• RM-4010P 

• RM-4000P 
• DR-2300 
• DR-2200 

• DR-2100 
• DR-1200 
 

Foot switch • RS31H  
• RS28H 

• RS27H 
• RS31 
• RS28 
• RS27 
 
To use a foot switch of the RSxxH series with ODMS, you need to 

switch the mode to Olympus mode. 
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1.4 Supported File Formats 
 

Dictation Files 

The following table lists the file types supported by each function: 

Functions Supported File Types (Extensions) 

Playback, import, 
and export 

Non-encrypted file: DS2, DSS, WAV, WMA, and MP3 
Encrypted file: DS2, $DSS, $WAV, $WMA, and $MP3 

In addition to the above, if a codec that works with Microsoft® DirectShow® 
Filter has been installed, an imported file can be played, but we do not 
guarantee proper operations. 

New recording and 
editing 

Non-encrypted file: DS2, DSS, WAV, and WMA 
Encrypted file: DS2, $DSS, $WAV, and $WMA 

When making a new recording, the recorded file is encrypted if the folder 
where the file was saved with exit recording status is an encrypted folder. 

File splitting/joining Non-encrypted file: DS2, DSS, WAV, and WMA 
Encrypted file: DS2, $DSS, $WAV, and $WMA 

 

Document Files 

The following file formats can be handled under the default setup. 

• Text file (XXX.TXT) 

• Rich Text Format file (XXX.RTF) 

• Microsoft Word format (XXX.DOC/.DOCX) 

To use another file format, registration is required. 

 

 
Configure document type as an optional setting by selecting Folder Design and then 
Attributes.  
=> [Folder Design]-Attributes 
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2 Fundamentals of Olympus Dictation Management 

System 
 

This chapter describes the fundamentals of Olympus Dictation Management System (ODMS R7). 

 

Dictation File Name and Author ID 

Process and Status 

How Folders Work 

Worktypes and Option Items 

Direct Recording 

Ownership Attribute 

Local Mode and Network Mode 

Clean 

Voice Comments 

Storage Mode and Composite Mode 

Backing Up 

Debugging Option 
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2.1 Dictation File Name and Author ID 
 

Dictation File Name 

A dictation file created with an Olympus recorder is automatically named with eight characters in the format 

below. A file directly recorded with the Dictation Module also follows the same naming process. 

Author ID (leading four characters) + Job No. (a four-digit number beginning with 1) 

 

Author ID 

The Author ID, which is registered as part of the file name, represents the Author of the file. The Dictation 

Module can register up to ten Author IDs and transfer them to the recorder. If no Author ID is registered, 

the log-on ID for Windows is used as the Author ID. 

 

Job No. 

The Job No. is automatically set when a recording is made. Each time a dictation file is created, a new 

number is provided for it. The Job No., which is an essential number for file management, cannot be reset 

by the user. Removing batteries from or formatting the memory card of the recorder will not reset the Job 

No. 
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2.2 Process and Status 
 

This section provides the workflow from the creation of a dictation file up to final transcription and deletion 

of the dictation file in an ODMS R7 Standalone System and Workgroup System. 

 

Sending a dictation file via email or FTP to an external site where it is transcribed: 

 

 

Sharing a dictation file on the network and transcribing it: 
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ODMS R7 manages a workflow with the following combinations of processes and statuses: 

: Supported : Not supported 

 Process Status 
Dictation File 

Editing 

Transcription / 

Speech 

Recognition 

Location of Dictation File 

[1] Record Running -   

  Pending   In the Recording Folder 

  Finished    

[2] Send Waiting   In the Outbox 

  Failed    

  Finished   In the Sent Items 

[3] Transcription Running  -  

  Pending    

  Finished    

[4] Speech 
Recognition 

Waiting   In the Speech Recognition 
queue 

  Running  -  

  Pending    

  Finished    

[5] Delete Finished   The Recycle Box is cleared 
automatically after a certain 
length of time (Settings can 
also be configured for 
immediate deletion upon 
completion.) 

 

Operations after Deletion 

By default, transcribed dictation files are automatically moved to the Recycle Box and then deleted 

permanently after a certain length of time. Files in the Recycle Box can be restored with the Restore 

function, but once deleted permanently, they cannot be recovered. Make sure that the configuration 

matches your requirements. 
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2.3 How Folders Work 
 

In the Dictation Module, dictation files and document files are managed in the Dictation Tray and the 

Document Tray, respectively. Files are managed in different folders based on which process is being 

performed. Properties for each folder can be configured and centrally managed by an Administrator. 

 

There are two types of folders managed in Dictation Module: virtual folders and folders other than virtual 

folders. 

A virtual folder does not represent a physical path. It serves as a container of multiple folders and is called 

a "Tray". 

Folders other than virtual folders are registered and managed in Dictation Module as shortcut folders with 

arbitrary folder paths. The user can rename a folder, but doing so just renames the shortcut folder. The 

actual path cannot be changed. When a folder represents a path in a local PC, it is displayed as  (normal 

color). If the path is over the network, it is displayed as  (blue). 

 

 
As for folders managed with Transcription Module, their current settings can be 

verified and modified in the Folder Design dialog box. 

 

Folder Descriptions 

Folder Functions 

 

2.3.1 Folder Descriptions 

 

This section describes how each folder works. 

 

Folder Name Description 

Dictation Tray 
This is a virtual folder, provided as a root folder, for managing dictation 
files. It serves as a management container and has no specific function. 

 
Download Tray 

Folder A 

 - Folder G 

These are folders used to download and manage dictation files from the 
recorder. 
Dictation files in the recorder folders are downloaded into the 

corresponding Download folders. Each Download folder can be 
configured for a selected path. 

 
Custom Folder 

Subfolder 

This user-defined folder manages dictation files. It is used as a 
download destination folder and has functions similar to the Download 
folders. Different custom folders can be specified for each Author ID. 

 
Recording Folder 

This folder manages dictation files in the process of recording (Pending 
status). In Pending status, the Recording tray path can only be a local 
PC folder. A network folder cannot be specified. 

 
Outbox 

( E-mail FTP) 

This folder stores the dictation files waiting to be sent via email or FTP. 
Outbox consists of two separately managed folders: E-mail and FTP. 

Items distributed to Outbox are automatically sent when the automatic 
sending option is selected. With the manual sending option selected, 
they remain in this folder until the user manually sends them. The 
sending method is configured with the option settings for email and 
FTP. 

If items in the Outbox are deleted, their sending operations are 
canceled and the actual dictation files are deleted. 
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Sent Items 

This folder manages the dictation files sent via email and FTP. 
When a dictation file has been sent, the item is then moved into the 

Sent Items folder. Process/Status of the transferred Dictation File 
changes to Sending.Finished. Sent Items has a Clean attribute that can 
be configured to specify time elapsed after sending. This makes it 
possible to clean up old files. Files in this folder can be moved to other 
folders. 

 
Finished 

This folder manages dictation files that have completed transcription 
and speech recognition. This folder is provided with a Clean attribute to 
save disk space. A dictation file for which a transcription has been 
completed is deleted after a prescribed length of time elapses. It cleans 
up old dictation files after a specified length of time. The automatic 
collection option for a workflow is configured to automatically move the 
dictation files that have completed transcription or speech recognition 

into this folder. 

 
Backup 

This folder backs up dictation files when downloaded or imported. If a 
downloaded or imported Dictation File is lost, it can be restored from 

the Backup folder. Since repeated backups can consume too much disk 
space, the folder has the Clean attribute for deletion of old backup files. 

 Recycle Box This folder temporarily stores old or unnecessary dictation files. Its 
function is similar to that of the Recycle Bin in Windows. Deleting 
dictation files in this folder eliminates them permanently and makes 
their restoration impossible. With the General option for a workflow, 
you can select whether the dictation files in folders are deleted 

permanently or moved to the Recycle Box folder. Dictation files in the 
Recycle Box folder can be restored to their original location with the 
Restore command. This folder has the Clean attribute so that old 
dictation files can be automatically deleted. 

Speech Recognition  This virtual folder manages the speech recognition process. 

When speech recognition is enabled in the state in which speech 
recognition software is installed, the following folders are displayed 
under this virtual folder. 

 

 
Queue 

 
 

This virtual folder stores the dictation files before speech recognition. 

When speech recognition of the dictation file is executed, a progress 
bar is displayed in the list so that you can check the processing 
progress. 

 
Finished 

 
 

This virtual folder stores the dictation files for which speech recognition 
is finished. 

The execution result of speech recognition is displayed as history. If an 
error occurred, clicking that error allows you to check details. 

 
Adaptation 

( Waiting List) 
 

This virtual folder manages information about revisions done by the 
user to text after speech recognition. 
If information about revisions to text is included in document files 

received by e-mail or FTP, it is saved in this folder. You can set the 
dictionary file to be updated based on the revision information when 
revision information is registered to Waiting List from the menu. 

Furthermore, setting revision information to be registered to Waiting 
List automatically in Option Settings allows you to set the dictionary file 
to be updated automatically after revisions. 
 

 Document Tray 
This virtual folder manages document files. Registered document files 
can be managed in the My Documents folder with their extensions 
registered using an attribute of the folder. Since this is a virtual folder, 
document files cannot be dropped into it. 

 
My Documents 

This folder manages document files. A document file received via email 
or FTP is stored in this folder. An existing document file from the 
outside can also be dropped into this folder. A document file in this 
folder can easily be associated with a dictation file. Double-clicking a 
dictation file associated with a document file opens the document file. 
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2.3.2 Folder Functions 

 

This section describes each folder’s capabilities and limitations. 

: Supported : Not supported 

 

Folder Name Renaming 
Subfolder 

Creation 

Adding 

Encryption 

Attribute 

Adding 

Ownership 

Attribute 

File 

Dropping 

Dictation Tray      

 Download Tray 

Folder A - Folder G 
     

 Custom Folder 

Subfolder 
     

 Recording Folder     *1 

 Outbox 

（ E-mail, FTP） 
    *2 

 Sent Items     *1 

 
Finished      

 Backup     *1 

 Recycle Box      

Speech Recognition      
 

Queue      

 
Finished      

 
Adaptation 

( Waiting List) 
     

Document Tray      

 
My Documents      

*1 Files can be removed from the folder, but cannot be dropped into the folder from the outside. 

*2 When a file is dropped into the Outbox, a dialog box will appear to configure settings for 

sending via E-mail / FTP. 
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2.4 Worktype and Option Item 
 

Worktypes and Option Items are IDs, like an Author ID, used to classify recorded files. 

A Worktype is defined as a string, including a department name or the category name of a recorded file. 

Option Items are used to further embed detailed information in a Worktype. 

 

Each recorded file is assigned a pre-defined Worktype. 

For example, with a Worktype associated with a document file template, the template can be opened and a 

document is automatically created in the appropriate format before dictation file transcription begins. 

 

The Dictation Module can register up to twenty Worktypes. Each Worktype can have up to ten Option Items 

registered. 

 

The following diagram shows the relationship between Worktypes and Option Items. In this diagram, a 

Worktype FAX is associated with two Option Items labeled TO and TITLE. 

 

 

 

An Option Item consists of input data and its label. Once a label has been registered, its value can be 

entered. An Option Item is usually input with a bar code. 

 

 
Whether to input multiple labels at once with a single bar code scanning or to input 
them separately with a series of bar code scannings can be configured in the 
Worktype Property dialog box.  
=> [Workflow] - Worktype 
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2.5 Direct Recording 
 

Direct Recording is for recording directly onto the hard disk drive of a PC using a connected recorder or 

RecMic as a microphone. 

 

In Direct Recording, the recording state is managed in two statuses, Pending and Complete, both of which 

are required to finish a recording. 

A dictation file with Pending status is saved in the Recording folder, where it can be selected and edited to 

resume recording. Since the files stored in the Recording folder are on the local PC, a Transcriptionist cannot 

open them. 

A dictation file with Complete status can always be transcribed. Once a transcription has begun, it cannot be 

edited. A dictation file with Complete status can be edited until transcription begins. 

 

Creating a Dictation File 

Editing a Dictation File 

 

Direct Recording settings are configured with the option settings. 

=> [Workflow] –Direct Recording 

 

The following settings can be configured: 

• Recording format 

• File naming rule for a new dictation 

• Job data settings 

• Voice comment settings 

• Start window changes 

• REV button settings 

• VCVA function settings 
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2.6 Ownership Attribute 
 

The transcription Module is initially configured to automatically move a transcribed Dictation File to the 

Finished folder in the module. This clarifies how many dictation files remain for transcription. However, once 

a dictation file has been moved to the Finished folder in Transcription Module, it is invisible to the Dictation 

Module and may be inconvenient for the Author. For this reason, the folder has an attribute, based on 

Author privileges, to prevent a dictation file from moving to the Finished folder in the Transcription Module 

after transcribing. This attribute is called the Ownership attribute. The Ownership attribute simply prevents 

a dictation file from being automatically moved to the Finished folder in the Transcription Module once the 

transcription has been completed. Transcriptionist or Author can move the transcribed file to another folder. 

 

=> [Folder Design] – Attributes -Ownership 



 27/231 

2.7 Local Mode and Network Mode 
 

When a folder represents a path in a local PC, it is displayed as  (normal color). If the path is over the 

network, it is displayed as  (blue). 

With access to the network, files in a folder assigned a path over the network can be listed. Such a 

configuration is called the network mode. 

If the download destination is a folder on the network, when a server crashes or when no network access is 

available, audio and document files cannot be downloaded. 

 

To avoid this inconvenience, if assigned a network path that is temporarily inaccessible, the destination 

folder is automatically switched to a local path, allowing file downloading. This is called the local mode. 

If a file was downloaded in the local mode, and the system switches back to the network mode, the folders 

for the network and local modes are both displayed, and the file downloaded in the local mode is 

automatically moved to the folder associated with the network mode. 

A file temporarily placed in the local mode can be identified by its icon. The icon changes back to normal 

when the file moves to the network mode. 
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2.8 Clean 
 
Clean is a folder attribute that deletes files. Old files can be deleted through one of two methods: by directly 
deleting them, or by moving them to the Recycle Box and then deleting them with the Recycle Box delete 
option. 

Folders with the Clean attribute are listed below. These folders may contain transcribed dictation files. They 

have the Clean attribute to clean up old dictation files. 

 

◼ Folders that can be cleaned 

Folder Dictation Module Transcription Module 

Download Tray 

Folder A - Folder 

G 

  

Custom Folder 

Subfolder 
  

Sent Items  --- 

Finished   

Forwarded ---  

---… Unsupported function 

… Cleanable 

… Uncleanable 
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2.9 Voice Comments 
 

There are two types of voice comments recorded by an Author with the Dictation Module: instruction 

comments and verbal comments. 

 

◼ Instruction Comments 

Instruction comments can be created only with Direct Recording and cannot be composed when making 

a recording with a standalone recorder. Instruction comments are maintained as files separate from a 

dictation file and provide a transcriptionist with overall instruction. A  mark in Instruction Comments 

column indicates there are instruction comments. 

 

◼ Verbal Comments 

Verbal comments are voice comments embedded in a dictation file. Verbal comments can be recorded 

with supported recorders. Unlike instruction comments, verbal comments are provided for transcription 

of audio data immediately following the commentary. For this purpose, verbal comments can be 

recorded at any position in a dictation file. With a recorder, they can be recorded only while the verbal 

comment recording button is being pressed during Dictation File recording. With Dictation Module, 

whenever the verbal comment recording button is being pressed, a verbal comment can be recorded, 

even when a dictation file is not being recorded. 

 

Instruction comments and verbal comments cannot have index marks inserted. 
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2.10 Storage Mode and Composite Mode 
 

Olympus recorders implement some or all of three standard USB classes of storage, audio, and HID. To 

provide stable operation, they switch between the following two modes in accordance with the current 

application: Storage mode (storage class only) and Composite mode (auto and HID class composite device). 

With the Dictation Module, Storage class is used for dictation file downloading, while Audio+HID class is 

used for Direct Recording. 

 

The modules listed below, which fully supported by the Dictation Module, are three-class composite devices 

(Storage + Audio + HID) when operating in Composite mode. With these models, specifying Composite 

mode enables dictation data download, Direct Recording, and all other operations without mode switching. 

 

In the case of models other than those listed above, some models do not have a Storage class in Composite 

mode. When such a model is connected, users need to switch to Storage mode during dictation file 

downloading, while users need to switch to Composite mode for Direct Recording. With the Dictation 

Module, Composite mode is entered automatically whenever the Direct Recording window is displayed. 

When ODMS R7 returns to the Main window after a recording has been completed, the recorder is 

automatically switched back to Storage mode. Storage and Composite modes can also be switched 

manually. 
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2.11 Backing Up 
 

After a folder's backup settings are configured, any file dropped into the folder will be automatically backed 

up to the other specified folder. 

 



 32/231 

2.12 Debugging Option 
 

The Dictation Module provides a Log Tool, which is a function to log information that enables analyses of 

problems that only occur in certain PC environments. By sending the log data of problematic areas to your 

dealer or distributor, you can receive advice to facilitate a resolution to the problem in a timely manner. 

Log Tool is provided as ODMSLogTool.exe in the Dictation Module installation folder. It allows for per-module 

configuration of log outputs. 

 

For more information on how to use Log Tool, refer to "Collecting Information with Log Tool." 
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3 Basic Operations 
 

This chapter describes the basic operations of Dictation Module. 

 

Starting and Exiting Dictation Module 

Downloading a Dictation File 

Importing a File 

Copying or Moving a Dictation File 

Playing a Dictation File 

Creating a Dictation File 

Editing a Dictation File 

Sending a Dictation File via E-mail 

Sending a Dictation File via FTP 

Managing Document Files 

Receiving a Document File via E-mail 

Receiving a Document File via FTP 

Speech Recognition 
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3.1 Starting and Exiting Dictation Module 
 

To start and exit Dictation Module, perform the following procedures: 

 

Starting  

Auto-starting  

Exiting  

 

 

Dictation Module and Transcription Module cannot be started simultaneously on the 

same PC. 

 

Starting 

To start the Dictation Module, perform the following steps: 

 Procedure A 

1. From the Windows [Start] menu, 

select [All Programs] - [Olympus Dictation Management System] - [Dictation 

Module]. 

 Dictation Module will start and the Main window will appear. 

 Procedure B 

1. Double-click a DSS or DSS Pro file through the Windows Explorer. 

 Dictation Module will start and the Playback Control window will appear. 
 

Auto-starting 

 Procedure 

1. Start the resident Device Detector5 and check Dictation Module. 

2. Connect the supported device to the USB port of the PC. 

 Dictation Module will automatically start and the Main or Playback Control window will appear. 
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Exiting 

If in the Playback Control or Direct Recording window, return to the Main window and then exit Dictation 

Module. 

 Procedure 

1. Select [Exit] from the [File] menu on the Main window. 

Or click  in the upper right corner of the Main window. 

 Dictation Module will close. 
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3.2 Downloading Dictation Files 
 

Downloading refers to copying a file from a device and transferring it to the Dictation Module. To download a 

file, follow the procedures described below. Downloaded files are stored in the Download Tray. 

 

 
Download settings are configured in the Workflow dialog box.  
=> [Workflow] - Download 

 

Downloading All Files 

Downloading Files into Specified Folders 

Downloading Specified Files 

 

3.2.1 Downloading All Files 

 

To download all files from a device, perform the following steps: 

 

 

When using a model with the Music folder, executing [Download All] cannot download files 
in the Music folder. 

 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open.  
The Device Tree View will display the model of the recorder and file information. 

 

 

When connecting or disconnecting the device while the Main window is open, device 
information will be updated in the Device Tree View. 

3. Verify that the device is in Storage mode. 

If it is in Audio mode, select [Change Device Mode] from the [Device] menu. 

4. Select the device in the Device Tree View and click . 

Or right-click the device and select [Download All] from the context menu. 

 All files in every folder in the device are downloaded (copied) into the corresponding folders A-

G in the Download Tray.  
The file name format is “Recorder user ID (leading four characters) + four-digit number.” 

 

 

• If multiple devices are connected, the Device Selection dialog box will appear by 

clicking [Download All] on the [Device] menu. Select the device and click [OK]. 

• Files in a device can also be deleted when they are downloaded.  
=> [Workflow] - Download 

• Downloading can be automatically started when a device is detected.  
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=> [Folder Design] - Auto Download 
• When WCS is enabled, the statuses of the downloaded files can be managed. 

Refer to Help for the Wireless Communication Service for details. 
 

 

3.2.2 Downloading Files into Specified Folders 

 

To download all files into a specified folder at the same time, perform the following steps: 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open. 

3. Right-click a folder of the device and select [Download Folder] on the context menu. 

 Files in the specified folder are downloaded into the corresponding folder in the Download tray.  

The file name format is “Recorder user ID (leading four characters) + four-digit number.” 
 

 

If multiple devices are connected, the Device Selection dialog box will appear when 
[Download Folder A (or B-G)] is selected from the [Device] menu. Select the device 
and click [OK]. 
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3.2.3 Downloading Specified Files 

 

To download one or more specified files, perform the following steps: 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open. 

3. Select a folder from the Device Tree View. 

 Files in the folder will be listed in the Content List View. 

4. Select a file in the Content List View and select [Download Selected Files] from the 

[Device] menu. 

 The selected files are downloaded into the corresponding folder (for example, folder A to folder 
A) in the Download Tray of the Dictation Tree View. When the corresponding folder is disabled, 

the files cannot be downloaded. 
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3.3 Importing a File 
 

Importing is for capturing an external Dictation File not managed by Dictation Module so that Dictation 

Module can manage it. 

Supported Dictation File formats are listed below. These files can also be dragged and dropped with a tool 

such as Explorer. 

 

Dictation File DS2 (DSS Pro), DSS, WMA, WAV, MP3 

Encrypted File DS2 (DSS Pro), $DSS, $WMA, $WAV, $MP3 

 

Specifying a file with a format other than the ones above causes a warning message to appear.  

However, if a codec that can work with Microsoft® DirectShow® Filter has been installed, dictation files with 

other formats can also be imported. Once a file format has been imported, it can be re-captured by 

dragging and dropping it every subsequent time. 

 

 Procedure 

1. Click  on the toolbar. 

Or select [Import Dictation] from the [File] menu. 

 The File dialog box will appear. 
 

2. Select in the file location list the folder of the file to import. 

Set the import destination folder using [Change]. 
 

3. Select a file from the list and click [Open]. 

 The specified file will be copied or moved to the folder selected in “Destination”. 
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3.4 Copying or Moving a Dictation File 
 

To copy or move a dictation file, perform the procedures described below. 

 

Copying a File to the Dictation Tree View 

Moving a File to the Dictation Tree View 

Copying a File to a Specified Location 

Uploading a Dictation File to the Device 

Exporting a File 

 

3.4.1 Copying a File to the Dictation Tree View 

 

To copy a file to the Dictation Tree View, perform the following steps: 

 

 Procedure 

1. Select a file in the Content List View. 

Selecting [Select All] from the [Edit] menu selects all files in the List View. 

2. Click  on the toolbar. 

Or select [Copy to Folder] from the [Edit] menu. 

 The Copy to Folder dialog box will appear. 

3. Select a destination folder and click [OK]. 

 The selected file will be copied to the specified folder. 
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3.4.2 Moving a File to the Dictation Tree View 

 

To move a file to the Dictation Tree View, perform the following steps: 

 

 Procedure 

1. Select a file in the Content List View. 

Selecting [Select All] from the [Edit] menu selects all files in the List View. 

2. Click  on the toolbar. 

Or select [Move to Folder] from the [Edit] menu. 

 The Move to Folder dialog box will appear. 

3. Select a destination folder and click [OK]. 

 The selected file will be moved to the specified folder. 

 

3.4.3 Copying a File to a Specified Location 

 

To copy a file to a specified location, perform the following steps: 

 

 Procedure 

1. Select a file in the Content List View. 

Selecting [Select All] from the [Edit] menu selects all files in the Content List View. 

2. Click  on the toolbar. 

Or select [Copy] from the [Edit] menu. 

 The specified file will be copied to the clipboard. 

3. Select a destination folder in the Dictation Tree View or specify a folder with the 

Windows Explorer. 

4. Click  on the toolbar. 

Or select [Paste] from the [Edit] menu. 

 The file will be pasted into the specified folder. 

 

3.4.4 Uploading a Dictation File to the Device 

 

Uploading is copying a file in the Content List View and transferring it to a connected device. 
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File types not supported by the device cannot be uploaded. 

 

 Procedure 

1. Select a dictation file in the Content List View and click  on the Device Tree View. 

Or select [Upload Selected Files] from the [Device] menu. 

 The Upload dialog box will appear. 

2. Select a destination folder and click [OK]. 

 The selected file will be copied to the specified folder. 
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3.4.5 Exporting a File 

 

This function can export audio and management files to external media. 

Management files are files for storing important dictation information for dictation files. 

 Procedure 

1. Select a file in the Content List View. 

Selecting [Select All] from the [Edit] menu selects all files in the List View. 

2. Click  on the toolbar. 

Or select [Export Dictation] from the [File] menu. 

 The Export dialog box will appear. 

 

By checking the deletion option check box in the Options field, the original file is deleted 

after exporting has been completed. 

3. Select a destination folder and click [OK]. 

 The selected audio and management files will be exported to the specified folder. 

 

 

The export function only supports copying to an external location. Specifying a path 
managed by Dictation Module results in an error. 
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3.5 Playing a Dictation File 
 

This section describes how to play a dictation file. 

 

 

Starting and Stopping Playback 

Shifting the Playback Position 

Adjusting Playback Conditions 

Intro-Scanning 

Inserting an Index Mark 

Exiting the Recording Window 

 

 

3.5.1 Starting and Stopping Playback 

 

Typical tape recorder operations such as playback, stop, fast-forwarding, and rewinding are available. 

The Playback Control bar on the Main window and Playback Control window offer the same operations 

during playback. 

 

 Procedure 

1. Double-click a file to play from the Content List View. 

Or click [Play] from the context menu. 

Or select the file and click . 

Or select the file and select [Play/Stop] from the [Play] menu. 

 Playback of the file will begin. The Position control (▽) indicates the current playback position. 

 shows the total length of time in white and the current position in blue. 

2. Click  during playback. 

Or select [Play/Stop] from the [Play] menu. 

 Playback of the file will stop. 

 

 

• Clicking  again after stopping playback restarts playing from a previous 
position set by a length of time specified with [User Setting] - Playback Control - 
Auto backspace on the Playback Control. 

• Clicking a DSS file with the Windows Explorer directly opens the Playback Control 
window and starts playing the file. 
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3.5.2 Shifting the Playback Position 

 

This section describes how to play a file from a specified position. 

 

Moving to a Desired Position 

Skipping to an Index Mark or Verbal Comment Position 

Moving the Position Control with the Keyboard 

 

Moving to a Desired Position 

 Procedure 

1. Click on a desired position on the Play bar or drag the Position control there. 

 The Position control will move to the specified position. 
 

Skipping to an Index Mark or Verbal Comment Position 

On the Play bar, a red mark ( ) represents an index mark and a light blue bar represents a verbal 

comment. 

 Procedure A 

1. Click  or . 

Or select [Previous/Next Index Mark] or [Previous/Next Verbal Comment] from the 

[Play] menu. 

 The Position control will move to an index mark or to the edge of a verbal comment before or 

after the current position. 

 

 Procedure B 

1. Click  on the toolbar. 

Or select [View All Index Mark] from the [Play] menu. 

 The View All Index Mark dialog box will appear. 
 

2. Select an index mark and click [Skip]. 

 

Moving the Position Control with the Keyboard 

If the Play bar is highlighted (surrounded by a dotted line), the Position control can be moved with the 

keyboard. 

 

Keyboard Operations Position Control Behavior 
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 Moves to the left 

 
Moves to the right 

Home Moves to the beginning of a file 

End Moves to the end of a file 
 

3.5.3 Adjusting Playback Conditions 

 

Dictation Module can provide better sound quality of recorded sound. Functions can be selected from the 

Playback Control bar on the Main window or from the Playback Control window. 

 

 

• The following controls except for Volume Adjustment Control are 
hidden initially. Modify the initial settings to display them.  
=> [User Setting] - Playback Control - Control Indicators 

• Depending on administrative settings, some menus will be hidden. 

 

Adjusting Volume 

Adjusting Speed  

Suppressing Noise  

Adjusting Tone  

 

Adjusting Volume 

This function is used to adjust the playback volume. 

 Procedure 

1. Drag the slider on the Volume Adjustment control. 

Or select [Up] or [Down] for Volume from the [Play] menu. 

 The playback volume will adjust. 
 

Adjusting Speed 

Playback speed adjustment allows for slower playback of demanding sound parts and faster playback for 

less demanding parts. 

 Procedure 

1. Click  or , or drag the slider on the Speed Adjustment control. 

Or select [Up] or [Down] for Speed from the [Play] menu. 

 The playback speed can be adjusted to nine levels between 50% and 200% without changing 
the voice pitch (sound pitch). 
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Suppressing Noise 

Noise cancellation is useful for easier listening of noisy recordings. 

 Procedure 

1. Click  or , or drag the slider on the Noise Cancellation control. 

Or select [OFF] , [1], [2], or [3] for Noise Cancellation from the [Play] menu. 

 The noise cancellation effect can be adjusted to the following four levels: OFF, 1, 2, and 3. 

 

 

In some recording environments, noise cancellation may not work effectively. In 
certain noise cancellation levels (1-3), the volume level may be too low, or the sound 

quality may change. 
 

Adjusting Tone 

Move the slider to the [-] side to emphasize bass sounds and to the [+] side to emphasize higher sounds. 

The [+] side is generally more suitable for easy listening. 

 Procedure 

1. Click  or , or drag the slider on the Tone Adjustment control. 

Or select [Up] or [Down] for Tone from the [Play] menu. 

 The tone can be adjusted in increments of 1%, from 100% on the [-] side to 100% on the [+] 
side. 
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3.5.4 Intro-Scanning 

 

This function sequentially plays only the first five seconds of the files displayed or selected in the Content 

List View. When all the files have been intro-scanned, a beeping sound is produced. A file with a recording 

time of less than five seconds is played through before the next file is played. A file being played back is 

highlighted in the Content List View. 

 Procedure 

1. Click  on the toolbar in the Main window. 

Or select [Intro Scan] from the [Play] menu. 

 Files displayed in the Content List View will be intro-scanned sequentially from a selected file. 
If no file is selected, intro-scanning will begin with the first file on the list. 

2. Click . 

Or select [Play/Stop] from the [Play] menu. 

 Intro-scanning will stop. 

 



 49/231 

3.6 Creating a Dictation File 
 

This section describes how to create and edit a dictation file. 

 

Making a New Recording 

Adding a Recording to a File 

Partially Deleting a File 

Inserting an Index Mark 

Exiting the Recording Window 

 

3.6.1 Making a New Recording 

 

This function can be used to perform Direct Recording (create a new file) in the Direct Recording window 

using a digital voice recorder or RecMic as a microphone. 

 

 

The volume, status, and user ID of recorded sound are displayed on the status bar 
during recording. 

 
The recording quality should be configured in advance.  
=> [Workflow] - DirectRecording 

 

 Procedure 

1. Connect RecMic or a supported digital voice recorder to a USB port on the PC. 

2. Click  on the toolbar. 

Or select [New Dictation] from the [File] menu. 

 The Direct Recording window or Direct Recording bar will open. 
 

When creating a new file, the folder name is "Recording folder," and the file name format 

is "the leading four characters of the user ID + four-digit sequential number.extension". 

3. Select the Microphone Sensitivity. 

Select Conference mode, Dictation mode, or Close-Talk mode (DS-5500 only). 

 

 

Some Olympus recorder models do not support selection of Microphone Sensitivity on 
the Direct Recording window. With these models, use the Sound and Audio Devices 
setting on the OS Control Panel to adjust the microphone input level.  
Supported recorders listed under “Devices Connectible to Dictation Module” and 

RecMic support all Microphone Sensitivity adjustments. 

4. Click . 

 Recording will begin. It can be operated via RecMic, used as a microphone, or via the buttons 
on the digital voice recorder. 
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  is the button for recording verbal comments. Use  for normal 
recording. => Recording a Verbal Comment 
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5. Click . 

 Recording will stop. 

6. Exit the Recording window. 

 

3.6.2 Adding a Recording to a File 

 

This function adds a recording to an existing file. When repeatedly starting and stopping recordings, each 

recorded segment will be appended to the file to create a single continuous recording. 

Starting recording after shifting the Position control to a previously-recorded position results in either an 

overwrite recording or an insert recording. 

Additionally recorded files are saved in the Dictation tray. 

 

 Procedure 

1. Connect the RecMic or a supported digital voice recorder to a USB port on the PC. 

2. Right-click the file to be configured and select [Edit Dictation] from the context 

menu. 

Or select the file and click  on the toolbar. 

Or select the file and select [Edit Dictation] from the [File] menu. 

 The Direct Recording Window will open. 

3. Move the Position control to the intended recording position. 

4. Select the recording mode. 

Select  for insert recordings or select  for overwrite recordings. 

5. Select the Microphone Sensitivity. 

Select Conference mode, Dictation mode, or Close-Talk mode (DS-5500 only). 

6. Click  to start recording. 

7. Click . 

 Recording will stop. 

8. Exit the Recording window. 
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3.6.3 Partially Deleting a File 

 

To partially delete a recorded file, perform the following steps. Partially deleted files are saved in the 

Dictation tray. 

 Procedure 

1. In the Direct Recording Window, move the Position control to the desired deletion 

starting point and click . 

Clicking  again will unlock the starting point. 

2. Move the Position control to the desired deletion end point and click . 

 The confirmation dialog box for deletion will appear. 

3. Click [OK]. 

 The specified range will be deleted. 

4. Exit the Recording window. 

 

 

3.6.4 Inserting an Index Mark 

 

An index mark can be inserted and deleted in the Main Window or Direct Recording Window. 

 

 

Index marks cannot be inserted into instruction comments. 

 

 

Inserting an Index Mark 

To insert an index mark, perform the following steps: 

 Procedure 

1. Select a file in the Content List View. 

 The file will be displayed on the Playback Control bar. 

2. Move the Position control and click  on the toolbar. 

Or select [Insert Index Mark] from the [Play] menu. 

 An index mark will be inserted at the Position control location. 



 53/231 

 

 

The maximum number of settable index marks is 16 for a DSS file and 32 for a DSS 
Pro/WAV/MP3 file. 

 

Deleting an Index Mark 

To delete an index mark, perform the following steps: 

 Procedure A 

1. Move the Position control to the index mark to be deleted by clicking  or . 

2. Click  on the toolbar. 

Or select [Delete Index Mark] from the [Play] menu. 

 The index mark will be deleted. 

 Procedure B 

1. Select [View All Index Mark] from the [Play] menu. 

 The View All Index Mark dialog box will appear. Index marks are displayed in the format of 
HH.MM.SS. 

  

2. Select an index mark and click [Delete]. 

 The index mark will be deleted. Multiple index marks can be deleted at once. 
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3.6.5 Exiting the Recording Window 

 

To finish recording operations, perform the following steps: 

 

 Procedure 

1. From the Direct Recording Window, click [Finished] after recording and editing a file. 

 The Dictation Finished dialog box will appear. Clicking [Pending] finishes recording operations 
in the Pending status of recording. 

 

  
 

items Description 

Filename Enter the file name. 

Folder to Save From the list, select the folder in which the 
file is to be saved. 

Send the 
Dictation 

If the folder for saving is configured with 
the automatic E-mail/FTP sending option, 
select whether or not to send the file. 

Background 

Speech 
Recognition 

Selects whether or not to register to the 

Recognition Queue. 

 

2. Click [OK]. 

 The file will be saved with Complete status. 
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3.7 Editing a Dictation File 
 

DSS files, DSS Pro files, and other files recorded with an Olympus recorder can be edited. 

 

 

Edited files are always saved as new files.  
MP3 files, some WAV files, and WMA files cannot be edited. 

 

The following functions are available. 

 

Converting the File Format 

Splitting a Dictation File into Two Files 

Joining Multiple Dictation Files into One 

Recording a Verbal Comment 

Recording an Instruction Comment 

Changing the Status of a Dictation File 

 

3.7.1 Converting the File Format 

 

This function converts a dictation file in the Content List View into a specified file format. With multiple files 

selected, it converts all of the files into the specified format. 

 

 

When Format Conversion is enabled in the folder property settings, files in the folder 
are automatically converted into the specified format according to the settings.  

=> [Folder Design] - Actions - Format Conversion 

 

 Procedure 

1. Right-click a dictation file in the Content List View, and select [Convert Dictation 

Setting] from the context menu. 

Or select the dictation file and click  on the toolbar. 

Or select [Convert Dictation] from the [File] menu. 

 The Convert Dictation Settings dialog box will appear. 

2. Select the Format_and_Attribute and click [OK]. 

The resulting file will be saved in the same folder. Select whether or not to delete the 

original file after conversion. 

 The file will be converted to and saved as a file with another format, and the original file will 
be deleted based on the folder property settings. 
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Format and Attributes of the Resulting File 

The following tables list the formats and attributes that can be assigned to the resulting file in the Convert 

Dictation dialog box. 

 

Format 

Attributes 

Codec 
Sampling 

Frequency 

Quantization Bit 

Rate 

Channel 

(Recording Mode) 

WAV PCM 44.10 kHz 16 bit stereo 

PCM 32.00 kHz 16 bit stereo 

 PCM 22.05 kHz 16 bit stereo 

 PCM 16.00 kHz 16 bit stereo 

 PCM 44.10 kHz 16 bit mono 

 PCM 22.05 kHz 16 bit mono 

 PCM 12.00 kHz 16 bit mono 

 PCM  8.00 kHz 16 bit mono 

 

Format 

Attributes 

Codec Bit Rate 
Sampling 

Frequency 

Channel 

(Recording 

Mode) 

DSS DSS 13.7 kbps 12 kHz mono (SP) 

DSS Pro DSS 13.7 kbps 12 kHz mono (SP) 

DSS 28 kbps 16 kHz mono (QP) 

 

Format 

Attributes 

Codec Bit Rate 
Sampling 

Frequency 

Channel Constant / 

Variable Bit Rate 

WMA WMA 8 kbps   8.00 kHz mono CBR 

WMA  16 kbps 22.05 kHz mono CBR 

 WMA  32 kbps 44.10 kHz mono CBR 

 WMA  48 kbps 44.10 kHz mono CBR 

 WMA  12 kbps  8.00 kHz stereo CBR 

 WMA  32 kbps 22.05 kHz stereo CBR 

 WMA  64 kbps 44.10 kHz stereo CBR 

 WMA 128 kbps 44.10 kHz stereo CBR 
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3.7.2 Splitting a Dictation File into Two Files 

 

With this function, a dictation file in the Content List View can be split into and saved as two files. 

DSS, DSS Pro, WAV, and WMA files can be split. The resulting file format can be selected. 

 

 Procedure 

1. Select a file in the Content List View and click  on the toolbar. 

Or select [Split] from the [File] menu. 

 The Split File dialog box will appear. 

 

  
 

Items Description 

Input file name The name and time length of the file to be 

split are displayed. 

First half Type in a name for the first half of the 
resulting file. 

Last half Type in a name for the last half of the 
resulting file. 

Split position With the slider, specify the point of 
separation in the original file. 

,  
With these buttons, playback of the file 
can be started, stopped, and verified. 

Display for 20 
seconds 

Checking this option zooms in on a 20-
second range centered on the slider, 
allowing for fine-tuning at the point of 
separation. 

File type 

Format 

 

Specify the file format of the resulting file. 

File type 
Attribute 

 
Specify the attributes of the resulting file. 
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2. Type in the names of the two resulting files that will represent the first and last 

halves of the original file, respectively. 

3. Specify the split position with the slider. 

4. Click [Split]. 

 The file will be split at the Position control point, and the first and last halves will be saved with 
their specified names in the original folder.  
The default naming format of the two resulting files is "the original file name + _A or 
_B.extension.” The original file will remain intact. 

 

 

• File status after splitting is [Recording Finished]. 

• If files to be split each have instruction comments, the newly split file will retain all 
of the instruction comments from the original files. 

 

3.7.3 Joining Multiple Dictation Files into One 

 

Multiple files selected in the Content List View can be joined into and saved as a single file in the same 

folder. 

DSS, DSS Pro, WAV, and WMA files can be joined. 

 

 

Joining two split files again may result in noise at the point of attachment. 

 

• File status after joining is [Recording Finished]. 
• If files to be joined each have instruction comments, the newly combined file will 

retain all of the instruction comments from the original files. 

 

 Procedure 

1. Select the files to be joined in the Content List View and click  on the toolbar. 

Or select [Join] from the [File] menu. 

 The Join Files dialog box will appear. 

With  and , playback of the files can be started, stopped, and verified. 
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2. Specify the sequence of the files to be joined using [Up] and [Down]. 

3. Type in the desired name of the resulting combined file in the [Output file name] 

field. 

As the default setting, the resulting file name is the original file name with the addition 

of “C.” 

4. Click [Join]. 

 The joined file with the specified file name will be saved in the same folder.  
The default naming format of a joined file is "the original file name + _C.extension." The 
original files will remain intact. 

 

3.7.4 Recording a Verbal Comment 

 

Verbal comments are recorded at any position in a dictation file based on the need for instructions. A 

Transcriptionist will transcribe a dictation file according to the verbal comments recorded in the file. Verbal 

comments can be recorded with Dictation Module as well as any recorder that supports Verbal Comment. 

With a recorder, they can be recorded only while the verbal comment recording button is being pressed 

during Dictation File recording. With Dictation Module, whenever the verbal comment recording button is 

being pressed, a verbal comment can be recorded, even when a dictation file is not being recorded. 

Verbal comments cannot have index marks inserted. 

Verbal comments are displayed in light blue on the Play bar. They can be recorded as insert recordings or 

overwrite recordings. 

To delete a verbal comment, use the partial deletion function for a recorded file. 

=> Partially Deleting a File 
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Verbal comment recording can be disabled.  
=> [Workflow] - Direct Recording - Voice comments 

 

 Procedure 

1. In the Direct Recording Window, move the Position control to a point for verbal 

comment insertion. 

2. Select the recording mode. 

Select  for insert recordings or select  for overwrite recordings. 

3. Select the Microphone Sensitivity. 

Select Conference mode, Dictation mode, or Close-Talk mode (DS-5500 only). 

 

 

Some Olympus recorder models do not support selection of Microphone Sensitivity on 
the Direct Recording window. With these models, use the Sound and Audio Devices 
setting on the OS Control Panel to adjust the microphone input level.  
Supported recorders listed under “Devices Connectible to Dictation Module” and 

RecMic support all Microphone Sensitivity adjustments. 

4. Verbal comments can only be recorded while pressing . 

During the recording of a dictation file, a verbal comment can still be recorded while 

pressing the button. Releasing the button allows normal recording to resume. 

Verbal comments are displayed in light blue. With  or , the Position control can 

be moved to an index mark or to the edge of a verbal comment before or after the 

current position. 

5. Exit the Recording window. 

 

3.7.5 Recording an Instruction Comment 

 

An instruction comment can be created only with Direct Recording and cannot be prepared when making a 

recording with a standalone recorder. An instruction comment is maintained as a file separate from a 

dictation file and provides the Transcriptionist with instruction. A  mark in Instruction Comments column 

indicates there are Instruction comments. 

 

 

Instruction comment recording can be disabled.  
=> [Workflow] - Direct Recording - Voice comments 

 

Attaching an Instruction Comment 

Use the following procedure to attach an instruction comment. 

 Procedure 
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1. Click  in the Direct Recording Window. 

 The Play bar will be surrounded by an orange line. 

2. Select the Microphone Sensitivity. 

Select Conference mode, Dictation mode, or Close-Talk mode (DS-5500 only). 

 

 

Some Olympus recorder models do not support selection of Microphone Sensitivity on 
the Direct Recording window. With these models, use the Sound and Audio Devices 
setting on the OS Control Panel to adjust the microphone input level.  
Supported recorders listed under “Devices Connectible to Dictation Module” and 
RecMic support all Microphone Sensitivity adjustments. 

3. Click  to start recording an instruction comment. 

4. Click  to stop recording. 

5. Exit the Recording window. 

 

Deleting an Instruction Comment 

Use the following procedure to delete an instruction comment. 

 Procedure 

1. Click  on the toolbar in the Direct Recording Window. 

 The instruction comment will be deleted. 
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3.7.6 Changing the Status of a Dictation File 

 

This function changes the status of the currently selected dictation file 

 Procedure 

1. Select a file in the Content List View and click  on the toolbar. 

Or select [Change Status] from the [File] menu. 

 The Change Status dialog box will appear, and any of the following statuses can be selected. 

 

Items Functions 

Recording.Pending Set to the pending status of recording. 

Recording.Finished Recording has been completed. 

Transcription.Finished Transcription has been completed 

Speech Recognition.Pending Speech recognition is underway. 

Speech Recognition.Finished Speech recognition has been completed 

 

2. Select the status and click [OK]. 

 This will change the status of the selected file. 
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3.8 Sending a Dictation File via E-mail 
 

The E-mailing function offers manual transmission via the menu and automatic transmission with periodic 

confirmation. 

 

 

To send a file via email, an email profile needs to be configured in advance.  
=> [E-mail / FTP ] - E-mail 

 

The following two methods are available to send a file via email. 

 

Automatic Transmission via E-mail 

Manual Transmission via E-mail 

Registering an Email Address 

 

3.8.1 Automatic Transmission via E-mail 

 

If a folder is configured for auto send of e-mail, any files stored in the folder are stored in Outbox, and sent 

to a specified addressee at a specified time. 

 

 
To automatically send an email, the folder needs to be pre-configured for automatic 

sending.  
=> [Folder Design] - Actions - Send via E-mail 

 

Automatically Switching E-mail Profiles 

When configuring automatic transmission, it is beneficial to set an alternative profile at the same time so 

that if an email cannot be automatically sent with the [Auto Send via E-mail] setting, the profile switches 

and the email can then be automatically sent with the [Auto Send via E-mail (Alternate)] setting. 

=> [Folder Design] - Actions - Send via E-mail (Alternate Profile) 

 

3.8.2 Manual Transmission via E-mail 

 

To specify and send a file via email, perform the following steps: 

 

 

• To send a file via email, an email profile needs to be configured in advance.  
=> [E-mail / FTP ] - E-mail 

• For information on how to register an address, refer to Registering an Email 
Address. 

 

 Procedure 

1. Select a file. 
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2.Click  on the toolbar, and select a mail profile to be used. 

Or select a mail profile with [Send Via E-mail] on the [Tool] menu. 

 The Set E-mail Destinations dialog box will appear. 
 

  

3. Click [To], [CC], and/or [BCC]. 

 The POP/SMTP Address dialog box will appear. 
 

  
 

 
Use the [New Contact] button to register a new address.  
=> Registering an Email Address 

 

4. Select addresses from the Address Book and click [To:=>], [CC:=>], and/or 

[BCC:=>]. 
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5. After completing configuration, click [OK]. 

 The selected addresses will be displayed in the Send E-mail Destination dialog box. 

 

  

6. Type in the “Subject” and the “Message”. 

Enter the mail body to the "Message". 

7. Click [Send]. 

 The email will be saved in the Outbox folder. 

8. Select the files configured for sending in the Content List View and click  in the 

Information View. 

 The Information View will display the mail body. 

9. Click  at the right of  of the tool bar, then select [Send] or [Send and Receive]. 

Or select [Send and Receive], then [Send] or [Send and Receive] from the [Tool] menu. 

 The emails in the Outbox folder will be sent. 
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3.8.3 Registering an Email Address 

 

To register an email address, perform the following steps: 

 Procedure 

1. Click [New Contact] in the POP/SMTP Address dialog box. 

 

  
 

 The New Contact dialog box will appear. 
 

  

2. Type in a contact name and its email address in the “Display Name” and “E-mail 

Address” fields, respectively, and then click [OK]. 

 The address will be registered in the POP/SMTP Address dialog box.  
Selecting the registered address and clicking [Properties] enables editing of the address.  
Clicking [Delete] will remove the registered address. 
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3.9 Sending a Dictation File via FTP 
 

The FTP sending function offers manual transmission via the menu and automatic transmission with periodic 

confirmation. 

To send a dictation file via FTP, perform the following steps. Automatic and manual transmission are 

available. 

 

 

To send a file via FTP, an FTP profile needs to be configured in advance.  
=> [E-mail / FTP] - FTP 

 

Automatic Transmission via FTP 

Manual Transmission via FTP 

 

3.9.1 Automatic Transmission via FTP 

 

With a folder configured for automatic FTP transmission, files in the folder are automatically sent to a pre-

determined destination at regular intervals. 

 

 
To automatically send a file via FTP, the folder needs to be pre-configured for 
automatic FTP transmission.  
=> [Folder Design] - Actions - Send via FTP 

 

Automatically Switching FTP Profiles 

When configuring automatic transmission, it is beneficial to set an alternative profile at the same time so 

that if a file cannot be automatically sent via FTP with the “Auto Send via FTP” setting, the profile switches 

and the file can then be automatically sent via FTP with the “Auto Send via FTP (Alternate)” setting. 

=> [Folder Design] - Actions - Send via FTP (Alternate Profile) 

 

3.9.2 Manual Transmission via FTP 

 

To manually send a file via FTP, perform the following steps: 

 

 
To send a file via FTP, an FTP profile needs to be configured in advance.  
=> [E-mail / FTP] - FTP 

 Procedure 

1. Select a file. 

2. Click  on the toolbar. 

 The Set FTP Destinations dialog box will appear. 
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3. Click [To]. 

 The FTP Profiles dialog box will appear. 
 

  

4. Select an FTP profile and click [Select]. 

 The FTP address will be displayed in the Set FTP Destination dialog box. 
 

  

5. Click [Send]. 

 The file will be stored in the Outbox folder. 

6. Click  at the right of  of the tool bar, then select [Send] or [Send and Receive] 

Or select [Send and Receive], then [Send] or [Send and Receive] from the [Tool] menu. 

 The files in the Outbox folder will be sent. 
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3.10 Managing Document Files 
 

Document files are managed in the Document Tray. They can easily be registered by dragging and dropping 

them with a tool such as Explorer. 

File name extension registration must be performed on the Folder Settings dialog box to enable 

management with Document tray. Document Tray cannot manage any document file whose file name 

extension is not registered. 

 

Adding a Managed Document File Type 

Associating a Document File with a Dictation File 

Dissociating a Document File from a Dictation File 

 

3.10.1 Adding a Managed Document File Type 

 

To add a new type of document file, perform the following steps. The following is an example of adding a 

document file with the ".WRI" extension to the Document Tray. 

 Procedure 

1. Click  in the Dictation Tree View. 

 The Folder Design dialog box will appear. 

2. Click [Document Tray] in the Folder Tree. 

3. Select [Document Type] from the Folder Property and click . 

 The Supported Document Type dialog box will appear. 

4. Type in the extension (WRI) to be added and click [Add]. 

5. Click [OK]. 

 Files with the added extension (XXX.WRI) will be displayed in the Document Tray. 
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3.10.2 Associating a Document File with a Dictation File 

 

To associate a document file with a dictation file, perform the following steps: 

 Procedure 

1. Select a dictation file in the Content List View and click [Associate with Document] 

on the [File] menu. 

Or select a dictation file in the Content List View and click  on the tool bar. 

 The File dialog box will appear. 

2. Select a document file and click [OK]. 

 The document file name of the associated document file will be displayed in the Document 
column of the Content List View. Selecting a dictation file in the Content List View highlights the 
associated document file in the Document List. 

 

 

Selecting a dictation file and clicking [Open Document] on the [File] menu causes the 
associated document file to be opened with its associated application. 

 

 
The document file associated with the dictation file cannot be sent via e-mail or FTP. 

 

 

3.10.3 Dissociating a Document File from a Dictation File 

 

To dissociate a document file from a dictation file, perform the following steps: 

 Procedure 

1. Select a dictation file in the Content List View and click [Remove Association with 

Document] on the [File] menu. 

Or select a dictation file in the Content List View and click  on the tool bar. 

 The file will be dissociated from the document file and the document file name will be removed 

from the Document column. 
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3.11 Receiving a Document File via E-mail 
 

To receive a document file via E-mail, manual reception via the menu and automatic reception with periodic 

confirmation are provided. 

A received document file is stored in the Document tray or My Documents folder. 

 

 

• The receive file settings must be configured before a document file can be received.  
=> [Workflow] - Receive 

 

The following two methods are available for receiving a document file. 

 

Automatic Reception via E-mail 

Manual Reception via E-mail 

 

3.11.1 Automatic Reception via E-mail 

 

With automatic reception pre-configured, E-mails with document files are automatically received at regular 

intervals, and the received documents are stored in the Document Tray. 

 

 

• To receive a file via email, an email profile needs to be configured in advance.  
=> [E-mail / FTP ] - E-mail 

• To automatically receive a document file, pre-configuration is required.  

=> [E-mail / FTP ] - Send / Receive  

 

3.11.2 Manual Reception via E-mail 

 

To manually receive a document file via email, perform the following steps: 

 Procedure 

1. Select [Receive] or [Send and Receive] by clicking  on the right side of  on the 

toolbar. 

Or select [Receive] or [Send and Receive] from [Send and Receive] in the [Tool] menu. 

 Document files will be received manually and stored in the Document tray. 

2. Right click the document file then select [Open Document] from the Context menu. 

Or select [Open Document] from the [File] menu. 

 The associated application with the document file opens the document. 
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3.12 Receiving a Document File via FTP 
 

To receive a document file via FTP, manual reception via the menu and automatic reception with periodic 

confirmation are provided. 

Received document files are stored in the Document tray. 

 

 

• The receive file settings must be configured before a document file can be received.  
=> [Workflow] - Receive 

 

The following two methods are available for receiving a document file. 

 

Automatic Reception via FTP 

Manual Reception via FTP 

 

3.12.1 Automatic Reception via FTP 

 

With automatic reception pre-configured, document files are automatically received via FTP at regular 

intervals, and the received documents are stored in the Document Tray. 

 

 

• To receive a file via FTP, an FTP profile needs to be configured in advance.  
=> [E-mail / FTP] - FTP 

• To automatically receive a document file, pre-configuration is required.  
=> [E-mail / FTP ] - Send / Receive  

 

3.12.2 Manual Reception via FTP 

 

To manually receive a document file via FTP, perform the following steps: 

1. Select [Receive] or [Send and Receive] by clicking  on the right side of  on the 

toolbar. 

Or select [Receive] or [Send and Receive] from [Send and Receive] in the [Tool] menu. 

 Document files will be received manually and stored in the Document tray. 

2. Right click the document file then select [Open Document] from the Context menu. 

Or select [Open Document] from the [File] menu. 

 The associated application with the document file opens the document. 
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3.13 Speech Recognition 
 

A recorded dictation file can be converted to text automatically using speech recognition software. 

ODMS R7 comes with a collection of speech recognition functions that have been dramatically improved and 

enhanced. Also, the Adaptation function learns from user corrections made to text output by speech 

recognition software and applies what it learns to the next speech recognition session. 

The Dictation Module provides the following functions. 

 

• Automatic speech recognition of dictation files downloaded from a device 

• Simultaneous speech recognition during direct recording with a microphone 

• Correction of speech recognition results using a special text editor (Speech Recognition Editor) 

• Request transcriptionist to correct results of speech recognition 

• Feedback of speech recognition result corrections to the speech recognition engine for improved 
speech recognition accuracy 

 

Getting Ready for Speech Recognition 

Settings to Share Adaptations 

Performing Real-time Speech Recognition 

Performing Background Speech Recognition 

Correcting Speech Recognition Results (Corrected by Speech Recognition Editor) 

Correcting Speech Recognition Results(Corrected by Transcriptionist) 

Correction Feedback 

 

3.13.1 Getting Ready for Speech Recognition 

 

The Dictation Module itself does not have speech recognition functions built-in. Supported speech 

recognition software must be installed separately. 

 

Installing Speech Recognition Software 

First, install supported speech recognition software. Refer to the installation guide that comes with your 

speech recognition software for information about how to install it. 

 

ODMS R7 supports Nuance Dragon Recognition Software. 
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Enabling Speech Recognition Functions 

In order to use speech recognition with the Dictation Module, the [Workflow] – Speech Recognition on the 

Option Settings dialog box must be used to configure speech recognition settings. 

 Procedure 

1. On the menu bar, select [Tools] – [Options] to display the Option Settings dialog 

box. 

2. Select the [Workflow] tab, which will cause [Speech Recognition] – [General] to 

appear in the tree view. 

3. Select the “Enable Speech Recognition” check box. 

 This will enable use of speech recognition functions with the Dictation Module. A screen for 
speech recognition is displayed in the tree view. 

4. Select "Do adaptation" to apply corrections to speech recognition to a Dragon user 

profile. 

 The Adaptation function is enabled in the Dictation Module. 

 

 

• The transcriptionist must enable the “Do adaptation” option also to share speech 
recognition results and corrections in the adaptation folders with other transcriptions  

Refer to Help for the Transcription Module for details. 
 

 

Dragon User Profiles 

With Dragon, there is a separate profile file (referred to here as a “Dragon user profile”) that records 

personal settings for each speech recognition user. Set one fixed Dragon user profile for use when 

performing speech recognition with the Dictation Module. Other users can also share a Dragon user profile 

by using the roaming setting. 

For details about Dragon user profile options, refer to “Speech recognition – Dragon ”. 

 Procedure 

1. On the menu bar, select [Tools] – [Options] to display the Option Settings dialog 

box. 

2. Select the [Workflow] tab, which will cause [Speech Recognition] – [Dragon] to 

appear in the tree view. 

 This will access the Dragon engine and obtain Dragon user profile information kept by the 

Dragon engine. 

3. Select the “User Profile Location” setting. 

• If you are not sharing the Dragon user profile with another user, select “Use Local Profile”. 
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• If you are sharing the Dragon user profile with another user, select “Use Dragon Roaming”. 
 

 

• The “User Profile Location” setting links with Dragon engine settings. Because of 

this, even if you do not click [OK] or [Apply] on the Option Settings dialog box, 
when the selection destination is moved the setup for Dictation Module is checked 
and reflected by the Dragon Engine. 

4. If you selected “Use Dragon Roaming” in step 3, the Roaming User Wizard for the 

user profile will appear on the display. After configuring the roaming destination 

shared location in accordance with the Wizard, select the Dragon user profile to be 

managed in the shared location from the Dragon user profiles present on the local 

PC. 

 This will copy the Dragon user profile created on the local PC to the specified shared location. 

Now whenever the Dragon engine accesses the Dragon user profile, settings will be changed as 
if the shared location was referenced and not the local PC. 

 

 

• If the Roaming User Wizard is canceled part way through, the “User Profile 
Location” setting is also canceled and the “Use Local Profile” is re-enabled. 

6. Use the [Add] button from “Profile Map” to configure the Dragon user profile to be 

used when implementing speech recognition. The user profiles present at the 

location whose setting were configured in steps 4 and 5 are automatically displayed 

in and can be selected from the [Dragon Profile] list. 

 

• Speech recognition cannot be implemented unless a user profile is selected in the 
[Dragon Profile] box. 

• When a user profile is selected, the options of the profile are displayed 
automatically, so configure in accordance with how speech recognition is actually 
being used. For details about the meaning of each option, refer to “Speech 
recognition – Dragon ”. Configuring settings appropriately will improve speech 
recognition efficiency. 

7. Specify the Author ID, and click [OK] on the Profile Map dialog box. 

8. On the Option Settings dialog box, and click [OK]. 

 This will check the Dragon user profile to be used by the Dictation Module. It also will enable 
start of speech recognition. 
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3.13.2 Settings to Share Adaptations 

These settings allow corrections to speech recognition to be shared by the Dictation Module (author side) 

and Transcription Module (transcriptionist side) and are required to use the author's Dragon user profile to 

do adaptations. 

These settings are not particularly needed to do speech recognition, to correct results of speech recognition, 

or to do adaptation with just the Dictation Module. 

 

Set either a shared folder, e-mail, or FTP as shown below to share the results and corrections to speech 

recognition with the Dictation Module and Transcription Module. 

 

 Shared Folder Setup Procedure 

1. Set up a shared folder on a network that both the author and transcriptionist can see 

and confirm that both of them can access it. 

2. Click on the [Folder Design] tab in option settings and select it as the adaptation 

folder 

3. The author specifies a shared address for the path of the attributes. 

 The shared address appears for the path. If an error occurs, check the address of the path and 

the access rights. 

 The transcriptionist specifies the same shared address as the author set in Auto Routing Rule 
of [Folder Design] - [Adaptation] in Option Settings. 

 E-mail/FTP Setup Procedure 

1. Select E-mail/FTP from Option settings and register the required profiles as the 

addresses of authors and transcriptionists. 

 

• For information about E-mail and FTP profile settings, refer to the following. 
=> [E-mail / FTP ] - E-mail 
=> [E-mail / FTP ] - FTP 
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3.13.3 Performing Real-time Speech Recognition 
 

Real-time speech recognition is a function that lets you use a special speech recognition editor screen 

(Speech Recognition Editor) to perform speech recognition while recording dictation, and perform real-time 

monitoring of speech recognition results. When there is a mistake in the speech recognition results, you can 

use the Speech Recognition Editor to correct the text. 

 

To improve the real-time speech recognition rate, you need to train the Dragon user profile using the same 

microphone device that you will use for actual real-time speech recognition. 

 

Instruction Comment and Verbal Comment cannot be recorded with real-time speech 
recognition. Also, index marks cannot be added. 

 

 Procedure 

1. Configure real-time speech recognition options. 

 For details, refer to “Speech recognition – Real-time Speech Recognition”. 

2. Connect the microphone device that you will use for real-time speech recognition to 

the PC. 

 
• With real-time speech recognition, the microphone device, used when the Dragon 

user profile being used was trained, is automatically selected and used. 

3. On the toolbar, click . 

Alternatively, click [Do Real-time Speech Recognition] on the [Speech Recognition] 

menu. 

 This will open the Speech Recognition Editor. 

4. On the Speech Recognition Editor toolbar, click the “Record”( ) button. 

 “Recording...” will appear in the status bar to indicate that dictation recording and speech 
recognition has started. 

 

 

• You can stop and restart recording, playback, and perform other operations using 
the toolbar's playback control buttons. 

• If you are using Olympus RecMic or an Olympus recorder as the microphone 

device, you can also stop and start recording, playback, and perform other 
operations using button operations on the RecMic device or recorder. 

•  When performing RecMic device or recorder button operations, you can configure 
option settings for each model and [PC Link] – [Programmable Buttons] – [Speech 
Recognition] settings are enabled. For details, refer to the explanations for 
configuring the settings of each device. 

• The [User Settings] – [Keyboard] – [Speech Recognition] settings of the Option 

Settings dialog box are valid on the Speech Recognition Editor. For details, refer to 
“Keyboard”. 

• Voice commands are supported for inserting line breaks and spaces verbally when 
recording dictation. For details about voice commands, refer to the Dragon user 

documentation. 
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5. After dictation recording is complete, click the “Record” ( ) again or click the 

“Stop” ( ) button. 

 This will exit dictation recording and speech recognition. 
 

 

There may be some time lag between dictation recording and speech recognition 
result output. Because of this, it may take some time before speech recognition 
stops entirely after the Stop button is pressed. 

6. Correct the speech recognition result as required. 

For information about how to make corrections, refer to “Correcting Speech Recognition 

Results” 

7. Exit real-time speech recognition. 

Perform the menu operations below to perform the operation you want on a recorded 

dictation file. 

 

Menu Button Description 

[File] – [Send for Correction]  

Select this item to quit dictation recording 
and request speech recognition result 
correction by another user. The status of 
the dictation file becomes 
SpeechRecognition.Finished, and the 

recorded dictation file is output as a .WAV 

format file. You must specify the storage 
destination folder of the file. 

[File] – [Finished]  

Select this item to quit dictation recording 
and speech recognition. The status of the 
dictation file becomes 

Transcription.Finished, and add-on dictation 
recording and speech recognition result 
correction are disabled. 
You must specify the file output destination 
folder and the file format for document 
export. 

[File] – [Pending]  

Select this item when performing additional 
dictation recording later. The status of the 
dictation file becomes 
SpeechRecognition.Pending, and the 

dictation file is stored in the Recording 
Folder as a .dra format file. You can use Edit 

Dictation ( ) to perform add-on recording 
and speech recognition. 
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3.13.4 Performing Background Speech Recognition 
 

Background speech recognition lets you queue recorded dictation files and sequentially perform speech 

recognition on them. Background speech recognition can be performed in parallel with other Dictation 

Module processes. This means speech recognition can be performed at the same time other dictation and 

transcription tasks are being performed. 

 

To improve the background speech recognition rate, you need to train the Dragon user profile using the 

same recorder that you will use for actual dictation recording. For details, refer to the Dragon user 

documentation. 

 

The following procedure explains the operational procedure using dictation file download as an example. 

 Procedure 

1. Configure background speech recognition option settings so dictation files are 

automatically added to the speech recognition queue when files are downloaded. 

 For details, refer to “Speech recognition – Background Speech Recognition”. 

 

 

• In order to register files automatically in the speech recognition queue when files 
are downloaded or imported, you need to enable the “Start recognition queue 
automatically when new files are added to the queue” option. 

• If the speech recognition setting is off for a recorder that can be specified to run 
speech recognition, its data will not be added to the speech recognition queue 
when downloaded even if this option is enabled. 

• Even when this option is disabled, a file can be added to the speech recognition 
queue using drag and drop after the file is downloaded. 

2. Click the Queue folder for speech recognition in the tree view of the Main window of 

Dictation Module to display the speech recognition queue. 

3. Connect the recorder used to record the dictation file to the PC and download the 

dictation file. 

4. At the same time the files are downloaded, all downloaded dictation files are 

registered to the Speech Recognition Waiting List. 

 

• You can skip speech recognition processing by un-selecting the check box after a 
dictation file is registered to the speech recognition waiting list. 

5. On the menu bar, select [Speech Recognition] – [Start Recognition Queue]. Speech 

recognition of the dictation files in the speech recognition queue is performed in the 

sequence they appear in the speech recognition queue. 

 A progress bar appears on the display to show the progress of the speech recognition process. 
When a speech recognition process is complete, the dictation file is moved to the Finished 
folder of speech recognition, so you can keep track of the speech recognition process results. 

 

 

• If you enabled the “Start recognition queue automatically when new files are 

added to the queue” option in step 1, the speech recognition process is started 
automatically when a file is added to the speech recognition queue, even if you do 
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not select [Start Recognition Queue]. 
• You can stop an ongoing speech recognition process by selecting [Speech 

Recognition] - [Stop Recognition Queue]. 
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3.13.5 Correcting Speech Recognition Results 
 

You can use the Speech Recognition Editor to correct the speech recognition results of a dictation file that 

has been processed with real-time speech recognition or background speech recognition. 

Text can be corrected using the Speech Recognition Editor while playing back the recorded dictation in the 

editor. When playing back the recorded dictation, the range of text that corresponds to the location being 

played can be highlighted, so corrections can be made to match the speech recognition result and the 

location being played. 

Operation of the Speech Recognition Editor depends on the status of the dictation file. The following are the 

speech recognition correction operation procedures for each type of file status condition. 

 

Incomplete Speech Recognition 

This section explains the procedure when a new dictation file is being recorded with real-time speech 

recognition or when performing add-on recording and speech recognition of a file whose status is 

SpeechRecognition.pending. 

In this case the speech recognition process must be performed with the Speech Recognition Editor, so the 

Dragon engine should be started up and linked for operation. Contents edited in the Speech Recognition 

Editor are also discerned by the Dragon ending, and synchronization is necessary. Because of this, the 

Dragon editing function is used to correct text before speech recognition is complete. 

 

If you find an error within speech recognition result text, select the range of error text and then select 

“Show Correction Dialog” ( ) or “Show Spell Dialog” ( ). This will make it possible to use text 

correction functions provided by Dragon to update text data on screen while maintaining consistency with 

Dragon internal data. 

 

Of course, you can use keyboard operations to input text strings and delete text with the Speech 

Recognition Editor, the same as with standard text editor operations. Note, however, that deleting text using 

keyboard operations will also delete the corresponding dictation data. This is an unavoidable functional 

limitation of Dragon. It is recommended that “Show Correction Dialog” or “Show Spell Dialog” be used 

whenever possible to edit text. 

 

 

• For the menu configuration when handling a dictation file for which speech recognition is 
incomplete, refer to “Menu List (Speech Recognition Editor/Real-time Speech 
Recognition)”. 

• When corrections to speech recognition results are finished, the file is moved to the 
adaptation folder.  

For details refer to Correction Feedback after the data is moved to the Adaptation folder. 

 

Speech Recognition Complete Files 

Further add-on recording and/or speech recognition cannot be performed on a file that has been processed 

with background speech recognition, or on a file that has been finished or sent for correction with real-time 

speech recognition. Because of this, the Speech Recognition Editor starts up alone without linking with 
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Dragon. 

 

As with a file for which speech recognition is incomplete, the recorded dictation can be played back with the 

Speech Recognition Editor with the position of the text being played back highlighted on the screen. When 

correcting text, correct speech recognition results directly using keyboard operations. Using keyboard 

operations to delete text when speech recognition is complete will delete the dictation data that corresponds 

to the deleted text data, but the dictation data will not be deleted when text is deleted after speech 

recognition is complete. 

However, since there is no linking with Dragon, use of the “Spell Dialog” and other editing functions 

provided by Dragon s not supported. 

 

 

• For the menu configuration when handling a dictation file for which speech recognition is 

complete, refer to “Menu List (Speech Recognition Editor/Text Correction)”. 
• When corrections to speech recognition results are finished, the file is moved to the 

adaptation folder.  
For details refer to Correction Feedback after the data is moved to the Adaptation folder. 
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3.13.6 Correcting Speech Recognition Results(Corrected by 

Transcriptionist) 
 

The author sends speech recognition results from real-time speech recognition and background speech 

recognition to the transcriptionist and the transcriptionist corrects it and feeds it back to the author, then 

the author adapts it and updates the Dragon profile. 

The exchange for these corrections is done via the Adaptation folder of the Dictation Module and the 

Transcription Module. 

You must set either a shared folder, e-mail, or FTP as shown below to share corrections to speech 

recognition results. 

 

■ Speech Recognition Results Sending Procedure 

1. The dictation files and speech recognition results files are stored in the Adaptation 

folder. 

 After they are stored, they are sent using the same method as normal dictation files. 

 

Items Description 

For Shared Folder The speech recognition results files are transferred via the 
path of the shared folder. 
 

For e-mail The speech recognition results files are transferred to the 

OutBox¥E-mail folder. 

 

For FTP The speech recognition results files are transferred to the 
OutBox¥FTP folder. 
 

 

 

The corrections to the speech recognition results stored in the OutBoxes are sent 

according to the transmission method stipulated for either e-mail or ftp. 
The standard sending procedure is used for sending. Refer to the following to change 

the settings for sending and receiving. 
=> [E-mail / FTP] - Send / Receive 

 

2. The transcriptionist manually edits the speech recognition results and sends the 

corrected file to the author. 

 The corrections are stored in the author's Adaptation folder. 
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3.13.7 Correction Feedback 
 

The corrections to the speech recognition results that are stored in the Adaptation folder are applied to the 

Dragon dictionary. The Dictation Module supports two-step adaptation. 

 

• Vocabulary Adaptation 

Vocabulary adaptation learns the sentence structures of the author, terms that are not known by 

the Dragon engine, etc. 

Vocabulary adaptation processing can be completed within a relatively short time. 

• Acoustic Adaptation 

Acoustic adaptation analyzes and allows learning of acoustic characteristics such as the noise level 

of the input sound, microphone characteristics, author voice characteristics, etc. 

Acoustic adaptation processing takes a relatively longer time than vocabulary adaptation. 

 

Configuring option settings to execute adaptation will cause dictation files to be added to an adaptation 

queue when speech recognition and text correction is complete. This applies to both background speech 

recognition and real-time speech recognition (when [Finished] is executed). 

 

The Dictation Module must execute the two types of adaptation in the sequence above. Acoustic adaptation 

cannot be performed on a dictation file unless vocabulary adaptation has been performed. 

 

The following procedure explains execution of adaptation following background speech recognition. 

 Procedure 

1. In the Adaptation folder, select a file on which to run adaptation, right click it and 

select [Add to Adaptation Waiting List]. 

 The selected file is registered to the adaptation waiting list. 

 

• If Auto Queuing to Waiting List of the Adaption folder is enabled, dictation files will 
be added to the adaption waiting list automatically after text revisions. 

 

2. When corrections for all the dictation files are finished, select [Speech Recognition] - 

[Adapt All Files] from the menu. 

 First perform vocabulary adaption and then acoustic adaptation on all of the dictation files in 
the adaptation queue. If any dictation file already has had vocabulary adaptation performed, 

perform acoustic adaptation only for that file.  
A progress bar will appear above the adaptation queue to indicate the progress of the process. 

 

 

• To perform vocabulary adaptation only, perform [Do Vocabulary Adaptation]. 
This will perform vocabulary adaptation only on the dictation file selected in the 

adaptation queue. 
• To perform acoustic adaptation only, perform [Do Acoustic Adaptation]. This 

will perform acoustic adaptation only on the dictation file selected in the 
adaptation queue. 

3. If the Dragon engine encounters an unknown term during vocabulary adaptation, a 

term registration dialog box will appear when vocabulary adaptation of all target files 



 85/231 

is complete. 

 Select the check boxes next to the terms you want the Dragon engine to learn. 

 

 

 

 [Written] shows the output when the term specified by [Spoken] is encountered during speech 
recognition. For example, when “mister” is specified for [Spoken] and “Mr.” for [Written], “Mr.” 
will be output in the speech recognition results when the word “mister” is spoken. To edit 

[Spoken] and [Written] entries, click Edit on the term registration dialog box and then use the 
term editing dialog box that appears for editing. 

 

 

• The same as when [Do Vocabulary Adaptation] is performed, if a term that is 
unknown to Dragon is encountered during vocabulary adaptation, a term 
registration dialog box will appear when vocabulary adaptation of all target files is 
complete. 

 

4. Following vocabulary adaptation, perform acoustic adaptation on all of the target files. 

 A progress bar will appear above the adaptation queue to indicate the progress of the process. 
Files are deleted from the adaptation queue as both vocabulary adaptation and acoustic 
adaptation are complete. A file will remain in the adaptation queue whenever either type of 
adaptation fails for some reason. 
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4 Managing Files and Folders 
 

Folders in the Dictation Tree View and the Device Tree View can be edited for each application. 

 

The following functions are available. 

 

Editing a Folder in the Dictation Tray 

Editing the Properties of Audio and Document Files 

Backing Up a Downloaded Dictation File 

Encrypting and Decrypting a Dictation File 

Sorting Dictation Files 

Sharing a Dictation File with Transcriptionists 

Automatically Deleting Transcribed Dictation Files 

Searching for Dictation Files and Document Files 
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4.1 Editing a Folder in the Dictation Tray 
 

To edit a folder in the Dictation Tray, follow the procedures below. 

 

 

Up to 20 one-byte characters can be used for a folder name (note that for a folder in 
a recorder, the maximum character count is 8). The following one-byte characters are 

unavailable: ¥ / : * ? " < > | 

 

Creating a Folder 

Mounting a Folder 

Removing a Folder 

Renaming a Folder 

 

4.1.1 Creating a Folder 

 

To create a folder, perform the following steps. Folders can also be created with the [New] button in the 

Folder Design dialog box. 

 Procedure 

1. Right-click a folder in the Dictation Tree View and click [New Folder] on the context 

menu. 

Or select  in the Dictation Tree View. 

Or select [New Folder] from the [Folder] menu. 

 The Create a New Folder dialog box will appear. 

2. Type in a folder name and click [OK]. 

 A sub folder will be created in the selected folder. 

 

4.1.2 Mounting a Folder 

 

This function adds a specified external folder path, as a custom folder, to the Dictation Tree View. 

One can also be added with [Add] in the Folder Design dialog box. 

 Procedure 

1. Right-click the Dictation Tray in the Dictation Tree View and select [Add Folder] from 

the context menu. 

Or click  in the Dictation Tree View. 

Or select [Add Folder] from the [Folder] menu. 

 The Browse for Folder dialog box will appear. 
 

2. Select a folder name and click [OK]. 
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 The path to the specified folder will be registered as a folder in the Dictation Tray.  

It can be managed with Dictation Module just like an actual folder. 

 

4.1.3 Removing a Folder 

 

To remove a folder previously created with [Add Folder], perform the following steps: 

 Procedure 

1. Right-click a folder in the Dictation Tree View and select [Remove Folder] from the 

context menu. 

Or select  from the Dictation Tree View. 

Or select [Remove Folder] from the [Folder] menu. 

 The selected folder will be removed. 

 

 

Only user-added folders can be removed. Only the path to the registered folder is 
removed and the folder itself, including its dictation files, are not deleted. 

 

4.1.4 Renaming a Folder 

 

This function renames a folder. 

 

 

Folders whose context menus do not display [Rename] cannot be renamed. 

 

 Procedure 

1. Right-click a folder in the Dictation Tree View and select [Rename] from the context 

menu. 

Or select  from the Dictation Tree View. 

Or select [Rename Folder] from the [Folder] menu. 

 The folder name field will become editable. 

2. Type in a folder name and press [Enter]. 

 The folder name will be modified. 

 

 

• Up to 20 one-byte characters can be used for a folder name (note that for a folder 
in a recorder, the maximum character count is 8). The following one-byte 

characters are unavailable: ¥ / : * ? " < > | 
• The method for renaming a device folder depends on the model.  

=> Configuring a Device of a Selected Model => [Device] 
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4.2 Editing the Properties of Audio and Document Files 
 

Dictation files and document files contain various types of information as their properties. To edit the 

properties of a file, the following methods are available. 

 

Editing in the Properties View 

In-line Editing 

Editing with the Job Data Dialog Box 

 

4.2.1 Editing in the Properties View 

 

To view the properties of a file, perform the following steps. 

 

 

The items displayed in gray cannot be edited. 

 

 Procedure 

1. Select a folder in the Dictation Tree View or Device Tree View. 

 Files in the folder will be listed in the Content List View. 

2. Select a file in the Content List View. 

 The properties of the selected file will be displayed in the Properties View. 

3. Modify the properties as needed. 

Items displayed in black can be edited. Click the edit box and select from the list or 

enter content. 

 Entered content will be reflected immediately. 

 

4.2.2 In-line Editing 

 

This function can edit the properties of a dictation file directly in the Content List View. 

 Procedure 

1. Click  o change to .  

Or select [In-line Edit] from the [View] menu to change to . 

2. Right click the dictation file in the Content List View then select [Edit Item] from the 

context menu. 
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Or select a dictation file and click the cell to be modified. 

 In editable items, text can be entered or a selectable Pull Down menu will appear. 

3. Edit the properties as needed. 

 Input data will be immediately reflected in the system. 

 

4.2.3 Editing with the Job Data Dialog Box 

 

This function can edit the job data (Author, Worktype ID, Option Items, and Comments) of a selected 

dictation file. 

 Procedure 

1. Right click a dictation file in the Content List View and select [Edit job Data] from 

the context menu. 

Or click  on the toolbar. 

Or select [Edit Job Data] from the [File] menu. 

 The Edit Job Data dialog box will appear. 

2. Edit the properties as needed. 

3. Click [OK]. 

 

Baltech Transponder  

Baltech Transponder Reader PAD allows use of its sensor inputs as text entries in the Edit Job Data dialog 

box. 

 Procedure 

1. Connect Baltech Transponder to a USB port on the PC. 

2. Select a dictation file in the Content List View and click  on the toolbar. 

Or select [Edit Job Data] from the [File] menu. 

 The Edit Job Data dialog box will appear. 

3. Select [Transponder is used] from the Options menu. 

 The Transponder Reader PAD will become available. 

4. Specify the target text entry box with the mouse. 

 

 

If Baltech Transponder Reader PAD is disconnected and then reconnected, configure 

[Use Transponder] on the Options menu in step 3 again. 
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4.3 Backing Up a Downloaded Dictation File 
 

A dictation file can be backed up with either one of two methods: by automatic backup with 

backup configuration, or by manual export to external media. 

 

Backing Up Automatically 

This method allows for automatic backup of dictation files with pre-configuration. 

 Procedure 

1. Click  on the Dictation Tree View. 

Or select [Options] from the [Tool] menu. 

 The Folder Settings dialog box or the Folder Design dialog box in the Option Settings will 
appear. 

2. Enable Backup under Actions in the Folder Properties box. 

 With this setting, each time a file is updated, its backup file will be created and stored in the 
Backup folder. 

 

 

Files in the Backup folder can be deleted after a certain length of time. To achieve 

this, set the Purge attribute of the Backup folder.  
=> [Folder Design] - Action - Purge 

 

Backing Up Manually 

With operations such as copying, exporting, and dragging and dropping, a file can be manually backed up. 
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4.4 Encrypting and Decrypting a Dictation File 
 

Encryption ensures that important files are securely maintained. 

Encryption is applied per file or per folder. 

An encrypted file can only be played once the correct password has been entered. 

 

 

About Dictation File Encryption 

• Encryption of dictation files other than DSS Pro files uses the same Olympus 
proprietary format as that of ODMS R6/DSS Player Pro R5. They cannot be 
decrypted using another company's software, etc. 

• With DSS Pro, encryption is performed in accordance with DSS Pro specifications. 
They can be decrypted using another company's software if it supports DSS Pro 
format. In the case of Olympus software, DSS Pro format is supported by DSS 

Player Pro R5 and higher only. 

 

With the Encryption attribute set to [Yes] for a folder, files in that folder are 
automatically encrypted with the password set under Attribute. With a password not 
configured under Attribute, the Encryption Password dialog box will appear when a 
file is dropped into the folder.  
=> [Folder Design] - Attributes - Encryption/Password 

 

Encrypting per File 

Encrypting per Folder 

Decrypting a File 

 

4.4.1 Encrypting per File 

 

To encrypt a single file, follow the procedure below. 

Encrypting "filename.dss" changes its extension, turning the file name into "filename.$dss". Encrypting a 

DSS Pro file does not affect its extension. 

 Procedure 

1. Right-click an unencrypted dictation file in the Content List View and click [Encrypt] 

on the context menu. 

Or click  on the standard toolbar. 

Or select [Encrypt] from the [File] menu. 

 The Encryption Password dialog box will appear. 

2. Type in a password in the Password and Confirm Password fields using 4 to 16 

alphanumeric characters.  

In the case of a DSS Pro format file, encryption format settings can also be 

configured. 

 

⚫ In the case of DSS Pro format, encryption format settings can be configured. Files 
are encrypted using a 128-bit encryption key in Standard mode, and a 256-bit 
encryption key in High mode. 

⚫ The password is the same in Standard mode and High mode. An encryption key, 
suitable for the specified encryption mode, is generated from the password, with a 
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key length that is in accordance with the encryption mode set within the program. 

3. Click the [OK] button. 

 The file will be encrypted. Clicking [Cancel] cancels the encryption. 
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4.4.2 Encrypting per Folder 

 

With a folder configured for encryption, files in the folder are automatically encrypted with the password set 

for the folder. An encrypted file is displayed with the Encryption icon ( ) in the Encrypted column in the 

Content List View. 

Encrypting "filename.dss" changes its extension, turning the file name into "filename.$dss". Encrypting a 

DSS Pro file does not affect its extension. 

 

 

When created under an encrypted folder, a subfolder automatically inherits the 
encryption setting from the parent folder. 

 

 Procedure 

1. Click  on the Dictation Tree View. 

Or select [Options] from the [Tool] menu. 

 The Folder Design dialog box will appear. 

2. Enable the Encryption attribute in the Folder Properties dialog box. 

3. Click  next to “Password” in the Folder Properties dialog box. 

 The Encryption Password dialog box will appear. 

4. Type in a password in the Password and Confirm Password fields using 4 to 16 

alphanumeric characters.  

In the case of a DSS Pro format file, encryption format settings can also be 

configured. 

 

⚫ Encryption format settings are used for auto encryption of DSS Pro format files. 
There is no difference in the encryption format when auto encrypting non-DSS Pro 
format files. 

⚫ Files are encrypted using a 128-bit encryption key in Standard mode, and a 256-

bit encryption key in High mode. 

⚫ The password is the same in Standard mode and High mode. An encryption key, 
suitable for the specified encryption mode, is generated from the password, with a 

key length that is in accordance with the encryption mode set within the program. 

5. Click [OK]. 

 The folder will be encrypted. If there are any files already located in the folder, a message will 
appear asking the user whether or not to encrypt those files. Clicking [Yes] will encrypt all of 
the files currently located in the folder. 

 

For subsequent operations, files will be encrypted as soon as they are stored in the 

folder. 
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4.4.3 Decrypting a File 

 

To decrypt an encrypted file, perform the following steps: 

 

 Procedure 

1. Right-click an encrypted Dictation File in the Dictation Tree View and select 

[Decrypt] from the context menu. 

Or select the Dictation File and click  on the standard toolbar. 

Or select the dictation file and select [Decrypt] from the [File] menu. 

 The Decryption Password dialog box will appear.  

If the password used when the file was encrypted has already been registered, the Decryption 
Password dialog box will not appear and decryption will start immediately.  

2. Type in the password used for encryption and click [OK]. 

 The file will be decrypted and can then be played. 

 

⚫ The DSS Pro file encryption mode (Standard or High) is automatically determined 
by the Dictation Module for each file, and then the appropriate encryption process 
is performed. 

⚫ The password is the same in Standard mode and High mode. An encryption key, 
suitable for the specified encryption mode, is generated from the password, with a 
key length that is in accordance with the encryption mode set within the program. 
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4.5 Sorting Dictation Files 
 

When dictation files are downloaded from a recorder, they can be sorted and routed to particular download 

destinations based on their Author ID or Worktype ID. Or dictation files from all of the folders on a device, 

regardless of the file properties, can be downloaded and collected into a single folder on a PC. Settings need 

to be pre-configured to sort downloaded files. 

 

With the following settings configured, dictation files are sorted by Author ID/Worktype ID into their 

specified folders when they are downloaded from the device. 

 

Configuring Automatic Sorting of Downloaded Files 

Registering the Author List to the Recorder 

Registering the Worktype ID to the Recorder 

 

4.5.1 Configuring Automatic Sorting of Downloaded Files 

 

This section describes how to define the rules on sorting downloaded or imported dictation files into 

different folders. 

The procedure you need to perform depends on auto sorting conditions. 

 Procedure A 

Use the following procedure to configure settings to download the file from the folders on a recorder and 

collect them into a single folder. 

1. Select [Option] from the [Tool] menu. 

 The Option Settings dialog box will appear. 

2. Click the Workflow tab. 

 The Option Settings Workflow dialog box will appear. 

3. On the menu tree, click [Advanced Download]. 

 The auto sort settings information screen will appear in the right frame. 

4. Select the [Download all dictations to..] check box. 

This enables the auto sort function. 

5. Select [Specific folder]. 

 This enables the  button. 

6. Click the  button and then use the Select Folder dialog box that appears to 

specify the folder you want to use as the download destination to collect the files. 
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 Procedure B 

Use the following procedure to configure settings when to route files to download destination folders 

based on their Author ID or Worktype ID. 

1. Select [Option] from the [Tool] menu. 

 The Option Settings dialog box will appear. 

2. Click the Workflow tab. 

 The Option Settings Workflow dialog box will appear. 

3. On the menu tree, click [Advanced Download]. 

 The auto sort settings information screen will appear in the right frame. 

4. Select the [Download all dictations to..] check box. 

 This enables the auto sort function. 

5. Select [Routing according to the following conditions]. 

 This enables the routing condition list. 

6. Click [Add]. 

 The Rule Settings dialog box will appear. 

7. In the Rule Settings dialog box, specify the Author ID/Worktype ID and the 

destination folder name, and then click [OK]. 

 

⚫ When Author ID and Worktype ID are both specified, only dictation files that match 
both criteria are routed to the specified folder. 

⚫ When either Author ID or Worktype ID is specified, the non-specified condition is 
interpreted as “unconditional”, which is interpreted as everything matching. In this 
case, routing is performed in accordance with the specified condition only. 

8. You can use the  buttons to change the application sequence of the routing 

conditions. Matching is performed proceeding through conditions from the top of the 

list. 

9. After all of the routing conditions are configured the way you want, click [OK]. 

Clicking the [Apply] button will apply the configured rules. 

 

⚫ You can modify an existing rule by selecting it in the routing list and then clicking 
the [Modify] button. An existing rule can be deleted by clicking the [Remove] 
button. 

 

4.5.2 Registering the Author List to the Recorder 

 

The author list can be registered to the recorder. 
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If required Authors are not registered, register them in the Workflow dialog box.  
=> [Workflow] - Author 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open.  

The Device Tree View will display the model of the recorder and file information. 
 

 

When connecting or disconnecting the device while the Main window is open, device 
information will be updated in the Device Tree View. 

3. Click  in the Device Tree View. 

Or select [Device Settings] from the [Device] menu. 

 The Device Settings dialog box will appear. 

4. Select [Author List] from the menu tree. 

 The right frame will show the Author IDs registered with [Workflow] – [Author] on the Option 
Settings dialog box. 

 

  

5. Check Author IDs to be registered to the recorder, and then click [Apply]. 

If you want to prompt for Author selection on the recorder whenever power is turned on, 

select the “Prompt for author ID at Power-on” check box. 

 The “Author IDs” and “Priority Level” will be transferred to the device. 

 

4.5.3 Registering the Worktype ID to the Recorder 
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The work ID list can be registered to the recorder. 

 

 
If the required Worktype is not registered, use the Workflow dialog box to register it.  
=> [Workflow] - Worktype 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open.  

The Device Tree View will display the model of the recorder and file information. 
 

 

When connecting or disconnecting the device while the Main window is open, device 
information will be updated in the Device Tree View. 

3. Click  in the Device Tree View. 

Or select [Device Settings] from the [Device] menu. 

 The Device Settings dialog box will appear. 

4. On the menu tree, click Worktype List. 

 The right frame will show the Worktype IDs registered with [Workflow] – [Worktype] on the 
Option Settings dialog box. 

 

  

5. Select the check box next to the ID of the recorder you want to register and then 

click the [Apply] button. 

If you want to prompt for selection of the Worktype ID on the recorder whenever 

recording is performed, select the “Prompt for Worktype ID at Power-on” check box. 

 The Worktype ID is transferred to the connected device. 
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4.6 Sharing a Dictation File with Transcriptionists 
 

A shared folder allows for file sharing with Transcriptionists. 

This section illustrates how to create a new custom folder and configure it for sharing. It explains the 

procedure for sharing dictation files by placing them into the folder. The shared folder is configured with 

access permission for both Transcriptionists and Authors. 

 

 

File sharing requires configurations on both Dictation Module and Transcription 

Module. 

 

 Procedure 

1. Create a shared network folder which can be accessed by Transcriptionists and 

Authors. 

2. Right-click the [Dictation Tray] in the Dictation Tree View and select [Add Folder] 

from the context menu. 

 The Browse for Folder dialog box will appear. 

3. Specify the folder created in step 1 and click [OK]. 

 A new custom folder will be created. 

4. Verify sharing for the folder created in step 1 to 3 is enabled. 

Both Transcriptionists and Authors should be able to access the shared folder. 

5. Drag and drop a dictation file to be shared into the folder created above. 

 Both Transcriptionists and Authors will be able to access the same Dictation File. 
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4.7 Automatically Deleting Transcribed Dictation Files 
 

With this function enabled, transcribed dictation files are automatically deleted. 

This function can automatically carry out a clean-up and purge of transcribed dictation files per folder after 

a specified length of time. 

 

The following procedure describes how to move a dictation file to the Recycle Box with the Cleaning setting 

after one month of storage in the Transcription Finished folder, and to eventually delete it permanently after 

two weeks of storage in the Recycle Box. 

 

 Procedure 

1. Select [Option] from the [Tool] menu. 

2. Click the Finished folder in the Folder tree in the Folder Design dialog box. 

3. Select the “Clean” and click . 

 The Cleaning Settings dialog box will appear. 

4. Check “Enable Cleaning”, select “1 Month(s)” for the interval, select “Move To 

Recycle Box” for the option setting, and then click [OK]. 

5. Click the Recycle Box folder. 

6. Select the “Purge” and click . 

 The Purge Settings dialog box will appear. 

7. Check “Enable Purge”, select “2 week(s)”, and then click [OK]. 
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4.8 Searching for Dictation Files and Document Files 
This function lets you locate a file in the content list view. There are the following two methods to search for 

files. 

 

Simple File Name Search 

Column Item Search 

 

4.8.1 Simple File Name Search 

You can easily search for a file name by using the following procedure. 

 Procedure 

1. Open the dictation or document list view. 

2. Use the keyboard to type the file name, of the file you want to find, from the 

beginning in order. 

 The files are searched using the text as you type it in incrementally, files that match the 
search conditions are selected. 

 

4.8.2 Column Item Search 

You can easily search for file names and columns of files by using the following procedure. 

 Procedure 

1. Press [Ctrl] + [F] on the keyboard. 

 The Search dialog box will appear. 

2. Type the text string, and select the column and search method, then press the 

[Next] button. 

 The list view is updated, and the focus moves to the files that match the search conditions. 

 

You can change the column being searched in Search Column. 

You can select whether to search for a target that starts with the text string or one that 

contains it. 

The [Next] button searches forward and the [Previous] button searches backward. 
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You can customize the short cut key used for searching columns in the User Setting 
dialog box 

=> [User Setting] - Keyboard 
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5 Customizing Dictation Module 
 

This chapter describes how to make the module easier to use by modifying the window appearance and key 

assignments. 

 

The following functions are available. 

 

Customizing the Work Area 

Customizing the Content List View 

Assigning Hot Keys 
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5.1 Customizing the Work Area 
 

The work area of the Main window consists of the four parts listed in the following table. These views, 

except the Content List View, can be shown or hidden as needed. 

 

Name Hidden Default 

Dictation Tree View Yes Shown 

Device Tree View Yes Shown 

Content List View Always shown Always shown 

Information View Yes Hidden 

Properties View Yes Hidden 
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5.2 Customizing the Content List View 
 

The display of files in the Content List View can be customized in various ways. 

The following methods are available. 

 

Interchanging Displayed Columns 

Sorting Displayed Files 

Changing the Columns Displayed in the Content List View 

Filtering Displayed Files 

 

5.2.1 Interchanging Displayed Columns 

 

To change the order of displayed columns, perform the following steps: 

 Procedure 

1. Select a column name, and then drag and drop it. 

 The order of the displayed columns will change. 

 

 
Changing the Columns Displayed in the Content List View. 

 

 

5.2.2 Sorting Displayed Files 

 

To change the order of displayed files, perform the following steps: 

 Procedure 

1. Select [Sort by] from the [View] menu. 

 Files will be sorted from the selected column in ascending order. If the current sorting option is 

selected again, it will alternate between ascending and descending order. 
 

5.2.3 Changing the Columns Displayed in the Content List View 

 

To show or hide the columns in the Content List View, perform the following steps: 

 

 

The file name and priority cannot be hidden. 

 

 Procedure A 

1. Right-click on one of columns in the Content List View. 
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 The list of column headers will be displayed as a context menu. 

2. Click a column to show or hide it. 

 

 Procedure B 

1. Select [Columns to Display] from the [View] menu. 

 The Columns to Display dialog box will appear. 

 

   

2. Select the Folder type. 

3. Use [>>] and [<<] to move the columns. 

The columns placed in the [Columns to Display] box are displayed in the Content List 

View. 

To change the order of displayed columns, use [Up] and [Down]. 

Clicking [Reset] returns the displayed columns to the default setting. 

4. Click [OK]. 

 The window will close and the display of the Content List View will be updated. 

 

 
• Displayed Property List (Dictation File List View)  

• Displayed Property List (Document List View)  
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5.2.4 Filtering Displayed Files 

 

The filtering function for column headers can filter columns to display. 

 

 

• Displayed Property List (Dictation File List View)  
• Displayed Property List (Document List View)  

 

 Procedure 

1. Click  in the Content List View. 

Or select [Filter On/Off] from the [View] menu. 

 The filtering function will be enabled, and  will be displayed for each column header. When 

a filtering condition has been set for a column, the button for the column turns to . 

  

2. Click  and select a condition from the list box. 

Selecting “All” disables the filter for the current column. 

For the columns whose date and time, number, or length can be specified, the Filters 

Option dialog box will appear when [Option] is pressed. Configure their conditions based 

on the instructions provided. 

 Only files that meet the configured conditions will be displayed in the Content List View. 
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5.3 Assigning Hot Keys 
 

The User Settings dialog box allows for verification and modification of key assignments for commands. 

Key assignments are configured in the User Settings dialog box. 

=> [User Setting] - Keyboard 

 

The functional scope of an assigned key depends on the Hot key settings, which are configured with [Hot 

key On/Off] on the [Tool] menu. 

With Hot key set to “Off”, the commands are executed only when the window is active. 

With Hot key set to “On”, the commands are executed regardless of whether or not the window is active. 

Commands assigned to keys are operational even if another window is open on the display on top of the 

Dictation Module screen. 

 

 
For information on default key assignments for each function, refer to Default Key 

Assignments. 
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6 Configuring with the Device Connected 
 

This chapter describes how to control the functions provided by the device via Dictation Module. 

 

Switching the Device Mode 

Using the Device as a USB Speaker / Microphone 

Transferring the Date and Time 
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6.1 Switching the Device Mode 
 

Dictation Module automatically switches the recorder to Composite mode when the Direct Recording window 

opens. When returning to the Main window after a recording has been completed, the recorder will 

automatically switch back to Storage mode. Storage and Composite modes can also be switched manually. 

To manually switch the device mode, perform the following steps: 

 Procedure 

1. Right-click a device and select [Change Device Mode] from the context menu. 

Or select the device and click . 

 The mode of selected device will be changed. 
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6.2 Using the Device as a USB Speaker / Microphone 
 

A recorder connected to a PC as a USB audio device can be used as a microphone or speaker. 

 

 

USB speaker and USB microphone capabilities cannot be used simultaneously. 

 
For support for each device model, refer to Functional Support of Recorders. 

 

Using a Recorder as a USB Microphone 

A supported recorder can be used as a microphone when making a recording with Dictation Module. 

 Procedure 

1. Connect a recorder to the PC. 

 The Main window will automatically open.  

Displaying the Direct Recording window automatically enables use as a USB microphone. 

 

Using a Recorder as a USB Speaker 

A supported recorder can be used as a speaker when playing sound. When specified as a speaker, a digital 

voice recorder will be used as a speaker by other software on the PC as well. 

 Procedure 

1. Connect a recorder to the PC. 

 The Main window will automatically open. 

2. Switch the recorder to Composite mode by selecting [Change Device Mode] from the 

[Device] menu. 

3. Select [Select Speaker] - [Olympus Device Speaker] from the [Tool] menu. 

 The USB-connected recorder can now be used as a speaker. 

 

 

If several devices are connected, click [Change Device Mode] on the [Device] menu 
to display the Device Select dialog box. Select the device and click [OK]. 
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6.3 Transferring the Date and Time 
 

To transfer date and time data from the PC to a recorder, perform the following steps: 

 Procedure 

1. Right-click the device and select [Synchronize Date/Time] from the context menu. 

Or click  on the toolbar. 

 Date and time data will be transferred to the recorder. 

 

 

• Transferring can be performed when the device mode is Storage mode, but not 
when it is Audio mode. 
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7 Configuring and Customizing the Device 
 

With device configuration, the settings of each device can be obtained, configured, read, and saved. 

The configurable setting items of a device are displayed in categorized tree form. Clicking an item in the 

tree switches the window to display the corresponding settings. 

 

Configuring for a Connected Device 

Configuring for a Selected Device Model 
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7.1 Configuring for a Connected Device 
 

To configure the settings of a connected device, perform the following steps: 

 Procedure 

1. Right-click a device in the Device Tree View and select [Device Settings] from the 

context menu. 

Or click  in the Device Tree View. 

 The Device Settings dialog box will appear. 

2. Edit the settings as needed. 

For details on the configuration, refer to "Device". 

[Load] : Clicking this button loads the settings of the connected device. 

[Update] : Clicking this button updates the settings of the connected device. 

[Reset] : Clicking this button returns the settings of the connected device to 

the default settings. 

[Set Job Number]: The job number can be set in the range of 0 to 9999. 

 

 

Only job numbers that are larger than the current number can be set. All the files in 
a device must be deleted before a smaller job number can be set. 

 

3. Click [OK]. 

 The settings will be saved and the window will close. 
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7.2 Configuring for a Selected Device Model 
 

The following procedure shows how to configure the settings for a selected device model, regardless of 

whether or not the device is connected: 

 Procedure 

1. Select [Option] from the [Tool] menu. 

2. Click the Device tab. 

 The Device dialog box will appear. It will display the same information as the Device Setting 
dialog box. 

3. Use the drop-down list in the upper left to select the model name of the device you 

want to configure. 

4. Configure option settings as required. 

For details on the configuration, refer to "Device". Connecting the model you selected in 

step 3 to the PC will enable updating of the settings of the connected device using the 

buttons listed below. 

[Load] : Clicking this button loads the settings of the connected device. 

[Update] : Clicking this button updates the settings of the connected device. 

[Reset] : Clicking this button returns the settings of the connected device to 

the default settings. 

[Set Job Number]: The job number can be set in the range of 0 to 9999. 

 

 

Only job numbers that are larger than the current number can be set. All the files in 

a device must be deleted before a smaller job number can be set. 

 

5. Click [OK]. 

 The settings will be saved and the window will close. 
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8 Option Settings on Operating Conditions 
 

This chapter describes how to configure the operating conditions of Dictation Module. 

 

When ODMS R7 is operated as a Workgroup system, the System Configuration Program manages the users 

on a per-Workgroup basis. The items with the lock icon  listed in the table below are managed by the 

System Configuration Program, prohibiting Authors from modifying them. 

To modify these items, contact the Administrator. 

 

Category Functions 

Folder Design Designs the folders used by an Author or Transcriptionist 

Workflow Configures the workflows performed by an Author or 
Transcriptionist 

User Settings Configures items related to usability 

E-mail / FTP  Configures email or FTP for users 

Device Configures the devices used by an Author or Transcriptionist 
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8.1 Folder Design 
 

This category is provided to customize the folders for storage of audio and document files. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 Procedure 

1. Select [Options] from the [Tool] menu. 

2. Click [Folder Design]. 

 The Folder Design dialog box will appear.  

3. Select a folder to be configured from the folder tree on the left, and configure its 

settings in the Folder Properties box on the right. 

[OK]: Secures the settings 

[Cancel]: Exits without modifying the settings 

[Apply]: Reflects changes to the configuration file 

 

 
For information on applications and functions of the Dictation Tray and 
Document Tray, refer to How Folders Work. 

 

Folder Properties 

Attributes 

Actions 

 

8.1.1 Folder Properties 

 

The Folder Properties box displays the properties of a folder selected from the folder tree. 

Properties are configured for each folder. 

Configurable properties vary depending on the folder type. 

 

Attributes  

Enabled  

Name  

Synchronize Folder Name  

Path  

Encryption  

Password  

Ownership  

Document Type  

Actions  

Auto Download  

Format Conversion  
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Send via E-mail  

Send via E-mail (Alternate Profile)  

Send via FTP  

Send via FTP (Alternate Profile) 

Backup  

Clean  

Purge  

 

 

How to configure the properties 
 The properties can be configured with either one of the following two 

methods: By clicking [+], or by clicking  to display a dialog box 
where they can be configured. Both ways allow for configuration of 

the properties. 

 

8.1.2 Attributes 

 

The following folder attributes can be configured. 

 

Enabled  

Name  

Synchronize Folder Name  

Path  

Encryption  

Password  

Ownership  

Document Type  

 

Enabled 

This attribute sets whether or not to display the folder in the folder tree. 

This setting works with the ON/OFF setting of the checkbox in the folder tree. 

With this attribute set to False (Hidden), the folder is not displayed in the application's folder tree, and files 

cannot be manipulated (downloaded, imported, moved, or copied) with the folder. 

 

Name 

This attribute sets the folder name. 

It can be entered by clicking on the cell. 

 

Synchronize Folder Name 

When this is enabled, the Name attribute will automatically change to the same name of the folder specified 
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through the Path attribute. 
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Path 

This attribute sets the folder path. It can be configured using the Browse for Folder dialog box, which is 

displayed by clicking . 

 

Encryption  

With the Encryption attribute set to “Yes”, files in the folder are encrypted. Moving the folder does not affect 

the Encryption attribute. 

 

Password 

If the Encryption attribute is enabled, the encryption password for files stored in the folder needs to be 

specified. 

The password is set or modified in the Encryption Password dialog box, which is displayed by clicking . 

It can be specified using 4 to 16 one-byte alphanumeric characters. 

DSSPro Encryption Format configures the strength of security settings for encryption of files recorded with 

the DSS Pro format. “High” can implement a more secure encryption. 

 

⚫ Files are encrypted using a 128-bit encryption key in Standard mode, and a 256-bit 
encryption key in High mode. 

⚫ The password is the same in Standard mode and High mode. An encryption key, 
suitable for the specified encryption mode, is generated from the password, with a key 
length that is in accordance with the encryption mode set within the program. 

 

Ownership 

With the Ownership attribute set to “Yes”, a dictation file is not moved to the Transcription Module Finished 

folder even after it has been transcribed. 

The Ownership attribute can be set for the Download tray and custom folders. Their subfolders will also 

have the same Ownership attribute. 

 

Ownership Auto Collection Transcription Finished Dictation files 

Yes Yes Moved to the Finished folder in Dictation 
Module (set as a rule) 

No Not moved 

No Yes Moved to the Finished folder in Transcription 
Module (set as a rule) 

No Not moved 

 

 
For the fundamentals of the Ownership attribute, refer to Ownership 
Attribute. 

 

Document Type 

This is an attribute configured for the Document Tray. It sets the supported types (extensions) of document 
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files. 

The extensions of document files are registered in the Supported Document Type dialog box, which is 

displayed by clicking . 

Up to 100 extensions can be configured. 

8.1.3 Actions 

 

The following folder actions can be configured. 

 

Auto Download 

Format Conversion  

Send via E-mail  

Send via E-mail (Alternate Profile)  

Send via FTP 

Send via FTP (Alternate Profile)  

Backup  

Clean  

Purge  

Background Speech Recognition  

 

Auto Download 

This option sets whether or not to automatically download dictation files from the recorder. 

When this option is set to "Yes", dictation files are automatically downloaded from various storage media 

detected in the device. When they have been downloaded successfully, a completion message is temporarily 

displayed. 

 

Format Conversion 

This option sets automatic conversion of files stored in the folder. 

 

By clicking [+], format conversion can be configured. 

Enabled : Enables or disables auto format conversion 

Target Format : Selects the file format 

Format Attributes : Selects the audio format 

Original Dictation : Deletes the original file after conversion 

These settings can also be configured in the Convert Dictation Settings dialog box, which is displayed by 

clicking . 
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Send via E-mail  

This option sets whether or not to automatically send the folder files via E-mail. 

 

By clicking [+], automatic transmission via E-mail can be configured. 

Auto Send : Enables or disables automatic transmission via E-mail 

Profile : Selects a profile for automatic transmission 

TO : The destination of an E-mail 

CC : Additional destinations disclosed to the recipients 

BCC : Additional destinations not disclosed to the recipients 

Subject : The title of an E-mail 

Message : The main message of an E-mail 

Confirmation dialog box : Shows or hides the confirmation dialog box when an E-mail is 

automatically sent 

 

These settings can also be configured in the Set E-mail Destinations dialog box, which is displayed by 

clicking . 

• With multiple E-mail profiles configured, the Select E-mail Profile dialog box will appear. 

• With no E-mail profiles configured, the confirmation dialog box will appear, allowing the creation of a 
new E-mail profile. => [E-mail / FTP ] 

 

Send via E-mail (Alternate Profile) 

Setting the “Auto Send” attribute to “Yes” enables the alternate setting for “Auto Send via E-mail”. 

This profile is used for sending an email when it cannot be sent with the “Auto Send via E-mail” profile. 

If it cannot be sent with either "Auto Send via E-mail" or "Auto Send via E-mail (Alternate)", a warning 

message will appear, allowing the user to decide which profile to use. 

 

Send via FTP  

This option sets whether or not to automatically send the folder files via FTP. 

 

By clicking [+], automatic transmission via FTP can be configured. 

Auto Send : Enables or disables automatic transmission via FTP 

Profile : The profile used for automatic transmission 

Confirmation dialog box : Shows or hides the confirmation dialog box when a file is automatically 

sent 

 

These settings can also be configured in the Set FTP Destinations dialog box, which is displayed by clicking 

. 

With no FTP profiles configured, the confirmation dialog box will appear, allowing the creation of a new FTP 
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profile.  

=> [E-mail / FTP ] 

 

Send via FTP (Alternate Profile) 

Setting the “Auto Send” attribute to “Yes” enables the alternate setting for “Auto Send via FTP”. 

This profile is used to try sending a file via FTP when it cannot be sent with the “Auto Send via FTP” profile. 

If it cannot be sent with either "Auto Send via FTP" or "Auto Send via FTP (Alternate)", a warning message 

will appear, allowing the user to decide which profile to use. 

 

Backup 

When “Backup” is enabled, the files in the folder are backed up to the Backup folder. 

 

Clean 

This option sets the retention period for the files in the folder. 

The settings include whether or not to move the files to the Recycle Box, and whether or not to delete them 

permanently once the retention period has expired. 

Retention Period : Sets the length of time until file cleaning occurs after the files have been 

moved to the Finished/Sent Items folder 

Value : 1-99 

Unit : Month(s)/Week(s)/Day(s) 

 

By clicking [+] , the cleaning function can be configured. 

Enabled : Enables or disables the cleaning function 

Aging period  : The minimum age of files to which cleaning is applied (Default: 1 month) 

Option : The conditions for deleting cleaned files 

 

These settings can also be configured in the Cleaning Settings dialog box, which is displayed by clicking . 

 

Purge 

This option is configured for the Backup folder or Recycle Box. When Purge is enabled, the files in the folder 

will be automatically deleted (purged) after the retention period has expired. 

 

By clicking [+], the purge function can be configured. 

Enabled : Enables or disables the purge function 

Target : The minimum age of files to which purging is applied (Default: 1 month) 
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Value : 1-99 

Unit : Month(s)/Week(s)/Day(s) 

These settings can also be configured in the Purge Settings dialog box, which is displayed by clicking . 

 

Background Speech Recognition 

This option sets the execution rule for background speech recognition. 

 

By clicking [+], the purge function can be configured. 

Auto queue: Enables/disables auto queuing 

Target: Condition of the files to be automatically queued. 

 (Default: Files after downloading, importing and direct recording) 

Use a rule: Enables/disables the rule settings (specification of author ID and worktype ID). 

These settings can also be configured in the Background Speech Recognition dialog box, which is displayed 

by clicking . 
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8.2 Workflow 
 

The ODMS R7 provides a Workflow, a configured series of operations when downloading and editing a 

dictation file. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 Procedure 

1. Select [Options] from the [Tool] menu. 

2. Click [Workflow]. 

 The Workflow dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK]: Secures the settings 

[Cancel]: Exits without modifying the settings 

[Apply]: Reflects changes to the configuration file 

 

General 

Download 

Advanced Download 

Import 

Author 

Worktype 

Direct Recording 

Hands Free Recording 

Speech recognition - General 

Speech recognition – Real-time Speech Recognition 

Speech recognition – Background Speech Recognition 

Speech recognition – Text Correction 

Speech recognition – Template 

Speech recognition – Dragon 

Receive 

Notification 

Auto collection 

Logging 

 

8.2.1 General 

 

This category configures the general settings for a workflow. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 



 127/231 

Delete Option  

Device Synchronization  

Filename Resolution 

Refresh interval  

 

 

Delete Option 

This option selects how to handle a dictation file when it has been deleted using [Delete] on the [Edit] menu 

or the [Ctrl+D] shortcut keys. 

• When “Move to Recycle Box” is selected, deleted files are moved to the Recycle Box. 

• When “Delete completely” is selected, deleted files are permanently deleted. 

 

 

• With “Move to Recycle Box” selected for “Delete Option”, pressing [Shift]+[Delete] 
executes “Delete completely”. 

• With “Delete completely” selected for “Delete Option”, pressing [Shift]+[Delete] executes 
“Move to Recycle Box”. 

• This option can only affect dictation files. Deleting a document file always executes 
"Delete Completely," resulting in permanent deletion. 

 

Device Synchronization 

This option sets whether or not to automatically synchronize the DVR (recorder) clock setting with the time 

on the PC when the DVR is connected to the PC. 

When “Do not display dialog” is enabled, the DVR clock will synchronize with the PC time settings without 

displaying a confirmation dialog. 

 

Filename Resolution 

This option sets whether or not to rename a dictation file when it is downloaded, imported, or dragged and 

dropped. 

• When “Automatic rename” is selected, the file is automatically renamed if there is a file with the same 

name in the destination folder. 

• When “Prompt user for Action” is selected, after receiving a message, the user can select overwriting 
or renaming of the file if there is a file with the same name in the destination folder. 

 

Refresh interval 

This option configures refreshing of the current folder. 

When “Refresh folders automatically every” is enabled, the file information displayed in the Content List 

View is periodically refreshed. The refresh interval is configured with "Refresh interval" (1-999 minutes). 
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8.2.2 Download 

 

This category configures operations when a dictation file is downloaded. 

For a downloaded file, the message displayed, file naming rule, and deletion criteria can be configured. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Automatic Download  

Job Data Settings  

Rename  

Delete  

 

Automatic Download 

The automatic download option enables the PC to automatically receive audio data from the device after 

detecting it. 

The following settings can be configured only for automatic-download-enabled folders. 

Do not display the Main window 

When this option is enabled, detection of a device auto starts the Dictation Module without 

displaying the Main window, performs auto download only, and then exits the Dictation Module. 

Prompt for selecting the file to be downloaded 

When “Prompt for selecting the file to download” is enabled, the dialog box for selecting the files 

to download appears when they are downloaded. Only the files you have selected will be 

downloaded. 

Download destination when DS-9500 is connected via USB 

When “Download files to the Wi-Fi transfer destination set in the DS-9500” is enabled, the files will 

be downloaded to the Wi-Fi transfer destination set in the DS-9500. If transfer is not possible, an 

error message will be displayed and the files will not be downloaded. 

 

Job Data Settings 

If “Prompt for data every time a file is downloaded” is enabled, the Edit Job Data dialog box is displayed 

when downloading files. 

You can confirm the following settings as you download. 

• File name, Author ID, Worktype ID, Option Item, Comment  

• Attributes: High Priority, Priority Level, File Locked 

 

Rename 

When “Rename downloaded files with the set format” is enabled, a downloaded file is renamed according to 
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a naming rule. 

The naming rule can be configured in the Format Options dialog box, which is displayed by clicking 

[Format]. 

The items to be included in a file name, with a separator between them, can be defined. 

 

Delete  

This option sets how to delete a dictation file in the device after it has been downloaded. 

When “After downloading file(s), delete the original file(s)” is enabled, the original file is deleted after the 

file has been downloaded. 

• When “Display confirmation dialog” is enabled, a confirmation dialog box appears before the file can 
be deleted. 

• When “Delete locked file(s)” is enabled, even locked files are deleted after importing. 
 



 130/231 

8.2.3 Advanced Download 
 

Advanced download configures settings to route dictation files as they are downloaded to specific folders. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Advanced Download  

Routing Rule Table  

 

Advanced download 

Downloads dictation files to specific folders or folders assigned the Author ID and Worktype ID. 

 

• [Download folder A-G] menus will be disabled when the option is enabled. Use 
[Download All] when downloading the files. 

• Auto download settings work in accordance with the [Auto Download] settings of the 
Download Tray. The [Auto Download] settings of individual folders (such as Folder A, 
etc.) are not displayed and are disabled. 

 

When the “Download all dictations to...” option is enabled, select the download method. 

• When “Specific folder” is selected, all dictation files in the device are downloaded into the specified 
folder. 

• When the “Routing according to the following conditions” option is selected, files are routed to each 
folder in accordance with routing rules. 

Routing Rule Table 

The routing rule table configures auto routing rules used when downloading and importing dictation files. 

Setting up storage destination folders in accordance with Author ID/Workforce ID combinations 

automatically routes dictation files to folders that conform to conditions during download and import. 

Routing rule table conditions are applied only when the “Routing according to the following conditions” 

option is selected. 

 

A maximum of 100 rules can be registered at any time. 

• To add a rule, click the [Add] button, and then make settings in the displayed Rule Settings dialog 
box. 

• To modify a rule, select it in the list and then click the [Modify] button. Modify rules on the Rule 
Settings dialog box. 

• To delete a rule, select it in the list and then click the [Remove] button. 
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8.2.4 Import 

 

This category configures operations when a dictation file is imported. 

The message to display and the file naming rule when the file is imported can be configured. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Job Data Settings  

Rename  

Delete  

 

Job Data Settings 

When “Prompt for data every time a file is imported” is enabled, the Edit Job Data dialog box appears when 

a file is imported. 

Files can be imported after their Worktypes and Option Items are each verified and configured. 

 

Rename 

When “Rename imported files with the set format” is enabled, an imported file is renamed according to a 

naming rule. 

The naming rule can be configured in the Format Options dialog box, which is displayed by clicking 

[Format]. 

The items to be included in a file name, with a separator between them, can be defined. 

 

Delete 

This option sets how to delete a dictation file after it has been imported. 

When “After importing file(s), delete the original file(s)” is enabled, the original file is deleted after the file 

has been imported. 

• When “Display confirmation dialog” is enabled, a confirmation dialog box appears before the file can 
be deleted. 

• When “Delete locked file(s)” is enabled, even locked files are deleted. 
 

8.2.5 Author 

 

This category configures Authors. 

Author ID and Priority Level registered here can be selected when creating a new dictation File with a 

function such as direct recording. 

 

Up to 10 Authors can be registered. 

• To add an Author, register it in the Author Property dialog box, which is displayed by clicking [Add]. 
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• To modify an Author, select the Author ID and click [Modify]. Then, make changes to the Author in the 

Author Property dialog box. 

• To delete an Author, select the Author ID and click [Remove]. 

• To change the order of Authors, select an Author ID and use the [Up] and [Down] buttons. 

 

 

• An Author ID can be specified using up to 16 characters. 
• The Priority Level can be configured in the range of 0 to 15. 

 

8.2.6 Worktype 

 

Multiple registered Worktype Lists can be transferred to the recorder. 

When recording a dictation file with direct recording or a recorder, selecting a Worktype ID enables 

information such as option items to be automatically recorded in the file. 

 

Up to 20 Worktype Lists can be registered. 

• To add a Worktype List, configure it in the Worktype Property dialog box, which is displayed by 
clicking [Add]. 

• To modify a Worktype List, select an Author ID and click [Modify]. Then, make changes to the 
Worktype List in the Worktype Property dialog box. 

• To delete a Worktype List, select an Author ID and click [Remove]. 

• To change the order of Worktype Lists, select an Author ID and use the [Up] and [Down] buttons. 

 

Set the captions for column titles in the file list of Dictation Module in Option Item Labels when option items 

are displayed. Up to 10 option items can be set for each Worktype ID, and they are numbered in order that 

they are registered as option items 1 to 10. Captions are set for the various option items 1 to 10 with 

Option Item Labels. If a caption is not set, option item 1 to 10 is displayed as is.  

Also, the captions set here are also used as the default value when an option item is added to Worktype ID. 

 

8.2.7 Direct Recording 

 

Direct recording parameters are configured here. 

These options are enabled for Direct Recording with an Olympus direct recording device. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Basic Settings 

Prompt Option  

Button function  

Start option  

[New] button operation  

Voice comments  

VCVA  
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Basic Settings  

Recording Format 

This option sets the recording format for Direct Recording. 

The recording format can be selected in the Recording Format Setting dialog box, which is 

displayed by clicking [Format]. 

File Name Format 

This option defines the file naming rule for a new recording. 

The naming rule can be configured in the Format Options dialog box, which is displayed by clicking 

[Format]. The items to be included in a file name, with a separator between them, can be defined. 

(Default: First 4 characters of Author ID + Job No.) 

Destination folder 

This option specifies the default saving folder, which is displayed by clicking [Finished] in the Direct 

Recording window after performing Direct Recording. 

Clicking the [Browse] button displays a Modify Destination Folder dialog box, which can be used to 

select a storage folder. 

 

Prompt Option  

When “Prompt for job data when direct recording is started” is enabled, the Edit Job Data dialog box 

appears when Direct Recording is performed, which enables the user to verify and modify data, such as 

Worktype ID and Option Items, before starting recording. 

When “Prompt for confirmation when direct recording is finished” is enabled, the Dictation Finished dialog 

box appears when a dictation has been finished. (Default: enabled) 

 

Button function 

When ”Change the slide switch REV position to REW” is enabled, the [REV] button function for direct 

recording is changed to [REW]. 

When “Recording while REC button is continuously pressed” is selected, recording is done while the [REC] 

button is pressed but stops when the [REC] button is released. If it is not selected, recording toggles on and 

off each time the [REC] button is pressed. This option is only enabled when an Olympus device which has 

the [REC] button is used as the recording microphone. 

Start Option 

This option configures operations when a direct recording device is used. 

When this option is enabled, the Direct Recording window, instead of the Main window, is opened when 

Dictation Module is running while RecMic is connected. Exiting the Direct Recording window displays the 

Main window. 
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[New] button operation 

This option selects the type of window that is displayed when the [New] button of a direct recording device 

is pressed. 

• When [Direct Recording Window] is selected, the Direct Recording Window is displayed. 

• When [Speech Recognition Editor] is selected, the Speech Recognition Editor is displayed. 
 

Voice comments 

When “Verbal comment” is enabled, a verbal comment can be recorded. (Default: enabled) 

With “Instruction comment” is enabled, the Instruction Comment mode switch button appears for direct 

recording so that an instruction comment can be recorded. (Default: enabled) 

 

VCVA  

VCVA (Variable Control Voice Actuator) can be turned OFF by setting the slider to Min. 

Moving the slider toward Max lowers the sound detection level. 

• When “Activate VCVA” is enabled, the VCVA level adjustment is applied. 

• The VCVA level can be adjusted to 10 different levels from 0 to 9. 
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8.2.8 Hands Free Recording 
 

If an Olympus foot switch is connected to the PC, pedal operations can be used to perform dictation 

recording while the Direct Recording window is displayed, without doing button operations on the Direct 

Recording Window, microphone device, etc. 

 

Items Functions Default 

Pedal Operation Select the operation mode for the foot 
switch. 

Continuous Press 

Model Selects a sample image for a foot switch 
on the option dialog. 

RS31 

 

The following table shows functions that can be assigned to each pedal. 

 

Pedal Operation Command Functions 

Continuous Press REV/PLAY Rewind (Review) is performed while the pedal is 

pressed. 

REC/STOP Recording is performed while the pedal is pressed. 
 

NEW Pressing the pedal creates a new dictation file. 

DISABLE Disables pedal operation. 

CUE/PLAY Fast forward (Cue) is performed while the pedal is 
pressed. 

INSERT/STOP Insert recording is performed at the indicator 
position while the pedal is depressed. 

STOP Pressing the pedal stops playback. 

EOF/BOF Pressing the pedal moves the indicator to the end 
of the file. 

INDEX Pressing the pedal inserts an index mark at the 
indicator position. 

PRIORITY Pressing the pedal switches the status of the 
dictation file being recorded to Priority. (High<-
>Normal) 

Short Press REW/STOP Pressing the pedal starts rewind. Pressing the 
pedal again stops rewind. 

PLAY/STOP Pressing the pedal starts playback from the 
indicator position. Pressing the pedal again stops 
playback. 

REC/STOP Pressing the pedal starts recording. Pressing the 
pedal again stops recording. 

NEW Pressing the pedal creates a new dictation file. 

DISABLE Disables pedal operation. No operation is 
performed when the pedal is pressed. 

FF/STOP Pressing the pedal starts fast forward. Pressing 
the pedal again stops rewind. 

INSERT/STOP Pressing the pedal starts insert recording from the 
indicator position. 

EOF/BOF Pressing the pedal moves the indicator to the end 

of the file. 

INDEX Pressing the pedal inserts an index mark at the 
indicator position. 

PRIORITY Pressing the pedal switches the status of the 
dictation file being recorded to Priority. (High<-
>Normal) 
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8.2.9 Speech Recognition - General 

 

These are settings for configuring application general options that are applied when using speech 

recognition with the Dictation Module. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Enable Speech Recognition 

Enables and disables speech recognition with the Dictation Module. 

When the “Enable Speech Recognition features” check box is selected, all speech recognition functions are 

enabled. When the check box is not selected, speech recognition functions are not displayed on the 

Dictation Module screen and no speech recognition functions are available for use. 

 

Adaptation 

With adaptation, the speech recognition software learns user corrections to the document generated by the 

speech recognition process, which improves future speech recognition. 

When the “Do adaptation” check box is selected, the file on which speech recognition is being performed is 

automatically added to the adaptation list when its status becomes Transcription.Finished. Or, it is added 

automatically to the Adaptation folder when a file of corrected speech recognition results is received via e-

mail or FTP. 

 



 137/231 

8.2.10 Speech recognition – Real-time Speech Recognition 

 

These are settings for configuring options used for real-time speech recognition with the Dictation Module. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Basic Settings 

These are rules for generation of dictation files when running real-time speech recognition. 

File Name Format 

These are rules for naming files when performing real-time speech recognition. 

To configure a naming rule, click the [Format] button, and then configure settings on the Format 

Options dialog box that appears. You can specify items included in file names and the item 

delimiter character. 

Destination Folder 

This option specifies the default storage destination folder that is displayed when real-time speech 

recognition is complete. 

Clicking the [Browse] button displays a Modify Destination Folder dialog box, which can be used to 

select a storage folder. 

 

Prompt Option 

If “Prompt for job data when direct recording is started” is enabled, the Edit Job Data dialog box is displayed 

when real-time speech recognition starts. 

 

Speech Recognition Editor 

Selecting the “Change Speech Recognition Editor border during recording” check box draws a border of the 

specified color around the Speech Recognition Editor text area while speech recognition is being performed. 

• You can select colors for Speech Recognition and for Sleep from the drop-down list. 

• By clicking [Custom], the color can be customized and added as a new color to the drop-down list. 
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8.2.11 Speech recognition – Background Speech Recognition 

 

These are settings for configuring options used when background speech recognition is executed with the 

Dictation Module. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Queuing Control 

Completing a dictation file download operation, an import operation, or a direct record operation while “Add 

to recognition queue after downloading, importing and direct recording” is enabled will cause the dictation 

file to be automatically added to the speech recognition queue. 

While “Start recognition queue automatically when new files are added the queue” is enabled, background 

speech recognition starts automatically whenever a file is added to the speech recognition queue. If “Start 

recognition queue automatically when new files are added the queue” is disabled, background speech 

recognition does not start until the user executes the [Start Recognition Queue] command. 

 

Others 

Performing background speech recognition while “Use Noise Cancellation” is enabled will perform speech 

recognition with noise cancellation being performed on the recorded data. This reduces any noise introduced 

during recording and enables an improved speech recognition rate. 
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8.2.12 Speech recognition – Text Correction 

 

These are settings for configuring options used when correcting text generated by speech recognition with 

the dictation module. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Focusing 

Enabling “Highlight words during the playback of voice file” will highlight (by reversing its background color) 

the text that corresponds to the current playback location during dictation playback. 

 

Finishing 

Enabling “Prompt for confirmation when text correcting is finished” will display a dialog box for confirming 

the dictation file output destination and other settings whenever real-time speech recognition or speech 

recognition result correction is complete. 

This setting is applied only when [Finished] is executed from the Speech Recognition Editor for real-time 

speech recognition processing or correction following speech recognition. Settings to be used after recording 

with the Direct Recording Window are configured on the Direct Recording screen. 

 

Enabling “Export documentation” will convert the text of a speech recognition results to a specified file 

format and output it when [Finished] is executed from the Speech Recognition Editor. 

• Use [Output Format] to specify the output file format. 

• [Output Format] specifies the output destination folder for the converted document files. 

When “Prompt for confirmation when text correcting is finished” is enabled, export/do not export, output 

settings, and other settings can be configured on the confirmation dialog box. [Output Format] and other 

settings are used as initial values when the confirmation dialog box is displayed. 

When “Prompt for confirmation when text correcting is finished” is not checked, export is performed 

automatically using specified conditions. 

 

Field Replacement 

With ODMS, you can insert fields bracketed by the [...] delimiters in template files being used while speech 

recognition is running according to the Add Fields dialog box. 

 If “Automatically Replace Field” is enabled, the various fields can be replaced, while editing the speech 

recognition results, with information controlled by ODMS. 
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8.2.13 Speech recognition – Template 

 

These are template file settings that are used during execution of speech recognition. A template file is a 

document pattern file that embeds, by default, formats that are always used by the user, such as a name 

input box. The speech recognition results of both real-time speech recognition and background speech 

recognition can be output to a template file. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

 

• Only Rich Text Format files are supported. Only Rich Text Format files can be specified 
as a template file. 

• If you want to add headers or footers, edit the data in Microsoft Word or some other 
application, and then save the data in a rich text format (.rtf). 

• Using the Windows-1252 code page as the template file is recommended. A warning 

message appears if any other code page is specified as the template. 

 

Templates 

Enabling “Use document templates in Speech Recognition” will automatically open a Rich Text Format file in 

the Speech Recognition Editor text area in accordance with the rules configured by the template whenever 

real-time speech recognition is started. Performing background speech recognition will cause the specified 

template file to be output for the transcribe result. 

A maximum of 100 rules can be registered at any time. 

• Rules are created for Author ID and Worktype ID combinations. 

• When rules are created without specifying either of the IDs, the non-specified condition is 
interpreted as “unconditional”, which is interpreted as everything matching. For example, if 
“OLYMPUS” is specified for the Author ID and nothing is specified for the Worktype ID, any 
“OLYMPUS” Author ID is judged to be a match, regardless of the Worktype ID. 

• To add a rule, click the [Add] button, and then make settings in the displayed Template Association 
dialog box. 

• To modify a rule, select a template in the list and then click the [Modify] button. Modify rules on the 
Template Association dialog box. 

• To delete a rule, select a template in the list and then click the [Remove] button. 

 

Inserting field in templates 

Normally, speech recognition result text is output from the beginning of the Rich Text Format file. When 

using a template file, however, there may be cases when you want to include the author name, speech 

recognition date, or other information also. For these cases, use WordPad, the standard Windows rich text 

editor in advance to add the necessary fields, such as dictation file header information or date information, 

so that when Speech Recognition Editor or Text Collection Window starts or stops, this function replaces the 

fields with the actual information. 

To add a field, open a template in WordPad, select [Speech Recognition] - [Add Fields to Template] menu, 

and add the fields you require to the template from the Add Fields dialog box. 
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Speech Recognition Result Starting Position 

The start position for speech recognition is normally output from the top of the rich text file. But, if you 

want to output speech recognition results from an arbitrary position described in the data, such as the 

author's name or the date speech recognition was done, insert a [VR_START_POSITION] field in the 

template file from Add Fields dialog box. Then when speech recognition is performed, speech recognition 

results are output starting from the position where [VR_START_POSITION] is located. The 

[VR_START_POSITION] tag itself is automatically deleted when speech recognition results are output. It 

does not remain as part of the speech recognition result. 

 

• [VR_START_POSITION] is valid for both real-time speech recognition and background 

speech recognition. In the case of real-time speech recognition, the cursor is moved to 
the [VR_START_POSITION] location when the Speech Recognition Editor is started up. 

 

 

 

Templates and Adaptation 

With adaptation, the Dragon speech recognition engine learns by comparing speech recognized dictation 

data with the text data. 

In the case of speech recognition using a template file, the applicable audio is not in the part in the 

template where data is first inserted. When performing adaptation, any part of the template that does not 

contain audio is not used for adaptation. 

When speech recognition is performed, the Transcription Module automatically determines whether a 

template was used, and excludes anything in the text area at the beginning of the template from the 

adaptation process. In the example presented above, “AUTHOR NAME” and any other terms that are 

included before the [VR_START_POSITION] tag, as well as the date and other information in the template 

text area are not part of the adaptation process, and so they are not learned by the speech recognition 

engine. 

In order to use the adaptation function to teach particular terms to the speech recognition engine, the 

actual author must say the terms and they must be learned for speech recognition. Terms also can be 

learned directly by the speech recognition engine using functions such as Dragon Train Word. 
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8.2.14 Speech recognition – Dragon  

 

These are settings for configuring Dragon. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Dragon User Profile 

With Dragon speech recognition, user profiles (files that record personal settings, speech recognition results 

and other information) are created to perform speech recognition. The speech recognition rate is improved 

by reflecting the speech recognition results in the profiles. 

User profiles can be placed locally or also on the network for sharing with multiple users (Group edition 

only). This setting specifies the management method for Dragon user profiles. 

 

User Profile Location 

Dragon has two methods that can be used for managing Dragon user profiles. Though selection of the 

method is a Dragon setting, the setting also can be configured from the Dictation Module. 

Use Local Profile 

Use of “Use Local Profile” is possible when a user performs speech recognition on their own 

PC.When “Use Local Profile” is selected, Dragon user profiles can be managed on the local PC 

where Dragon is installed. 

This method can be used only with Dragon user profiles that are present on the local PC when 

speech recognition is performed. 

Use Dragon Roaming 

Use of roaming profile function is possible when a user shares the Dragon user profile with a 

transcriptionist. 

When “Use Dragon Roaming” is selected, Dragon user profiles can be shared by specifying the 

shared folder on the network specified in the [Roaming Folder Path] box. 

Speech recognition can also be performed in an off-line environment by using the cache function. 

 

● Use the following procedure to set the Roaming Profile settings and cache function settings 

in Dragon. 

Step 1: Enable Roaming User Profile from Dragon Settings - Administrative Settings - 

[Roaming] tab. 

Step 2: Specify local paths for the roaming directories and local directory (for cache). 
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Profile Map 

Specifies all Author Dragon user profiles that can possibly perform speech recognition with Dictation Module. 

When executing background speech recognition, the Dragon user profile used by each author must be 

switched. Because of this, Dragon profile and microphone device to be used during speech recognition are 

associated, keying on the Author ID recorded to a dictation file. 

 

• To add a profile and Author ID matching condition, click the [Add] button, and then configure settings 

on the Profile Map dialog box that appears. 

• To modify Profile and Author ID matching conditions, select the condition you want to modify on the 

Profile Map, and then click the [Modify] button to display the Profile Map dialog box. 

• To delete Profile and Author ID matching conditions, select the condition you want to delete on the 

Profile Map, and then click the [Remove] button. 

 

Dragon Profile 

When using speech recognition functions, the Dragon user profile specified by [Dragon Profile] is 

automatically opened in the background and used during speech recognition. On the drop-down 

list, select Dragon user profile name of the author who is recording the dictation. 

With Dictation Module, you can specify multiple Dragon user profiles by combining specified Author 

IDs. 

 

 

• The drop-down list shows the names of all user profiles present in the location 
selected with [User Profile Location]. 

Vocabulary 

Vocabulary shows the user dialect, terminology, and other information (“U.S. English - General”, 

etc.) that was registered when a Dragon user profile was created by Dragon. 

Dictation Source : Real-time 

This feature is used to select the microphone device to be used when performing real-time speech 

recognition. 

The Dragon user profile selected by [Dragon Profile] will display an alert button next to “Train 

Profile” if training has not been performed for the selected microphone device. To improve the 

speech recognition rate, you need to train the Dragon user profile using the same microphone that 

you will use for actual real-time speech recognition. If you use the microphone that actually will be 

used for recording to perform training, the noise characteristics and other characteristics of the 

microphone device will be remembered by the Dragon user profile, which can improve the speech 

recognition rate. 

Dictation Source : Background 

This setting is used to select the recorder or microphone devices for recording a file to be 



 144/231 

submitted for background speech recognition. When using a microphone device that is different 

from the one used for real-time speech recognition, register a real-time speech recognition device 

and a background speech recognition device, using Dragon, for the user specified by the [Dragon 

Profile] box. 

Author ID 

Select if a Dragon user profile is specified for each author when using a speech recognition type of 

function. Normally the author ID is not specified, the [Dragon Profile] specified for the Dragon user 

profile to be used. When multiple authors are performing speech recognition with the Dictation 

Module on the same PC and as the same (Dictation Module) user, the Dragon user profile 

corresponding to this Author ID specification is set. 

 

 

• The selected Author ID can be specified from the author IDs registered in Option 
settings [Workflow] - [Author]. 

=> [Workflow] - Author 

 

Dragon User Command  

You can create voice commands by using [Create New Command]. 

Also, by registering ODMS user commands (up to 10 commands) by using [Assign User 

Command], you can assign the following operations to hot keys or buttons. 

• In Option Settings [User Settings]-[Keyboard], you can assign user commands in the Dragon 
User Command category to any short-cut keys. 

• In Option Settings select RecMic for [Device], and use the RecMic device button settings to 
assign the user command to any button. 

• In Option Settings select Voice Recorder for [Device], and use the PC Link button settings to 
assign the user command to function buttons [F1] to [F3]. 

 

 

• The voice commands are registered to the User Profile of Dragon. 
 

  

Dragon Engine Configuration 

Enabling “Always restart Dragon Engine” will force the Dragon speech recognition engine to restart 

whenever the Dictation Module is started up. Restart is not performed if the speech recognition engine is 

not running when the Dictation Module is started up. 

Also, clicking the [Restart Now] button will immediately restart the speech recognition engine. 

 

When “Enable to run Dictation Module and Dragon on same CPU core” is enabled, Dictation Module and the 

Dragon speech recognition engine are controlled to work simultaneously on the same CPU core. 
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8.2.15 Receive 

 

This category configures operations when files are automatically received. 

It can configure profiles, document file types, receipt notifications, and dictation file expirations. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Receive  

Overdue transcription  

 

Receive  

• When [E-mail] is enabled, files can be received via email. 

=> E-mail 

• When [FTP] is enabled, files can be received via FTP. 

=> FTP 

Multiple FTP sites can be registered. They are added to the list after registration. 

When this is enabled, files can be downloaded from the specified FTP. 

• Only files of the file formats whose check box are selected under “Select the extension of document 
file to receive” are received by E-mail/FTP. 

• Clicking “Add/Remove support document type” will display the Folder Design dialog box. The 

Supported Document Type dialog box that appears when the  button displayed in the “Document 
Type” field of the [Document Tray] is pressed can be used to add and delete supported document 

types. 
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Overdue transcription  

With this option is enabled, a transcription expiration date can be set to a dictation file sent via email or 

FTP. If the file is not sent back before its expiration, it is marked with a different color. 

The length of time before expiration can be set in the range of 1 to 999 hours. 
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8.2.16 Notification 

 

This setting opens a Notification Window (pop-up) when a file is added to a folder and when mail arrives via 

e-mail/FTP. 

 

Enable notification for finishing transcription every 

Author ID  

Notification high priority dictations only  

Pop up Notification  

Sound Notification  

Support background notification when Dictation Module is not running 

 

Enable notification for finishing transcription every 

If you enable this item, the user is notified by a sound and pop-up window at the specified interval when 

transcription is finished or speech recognition is finished. (Default: 10 minutes) 

 

Author ID  

Users are notified if the selected Author ID file is added to the folder. 

You can add author IDs from Option settings [Workflow] - Author. 

 

Notification on high priority dictation only 

Notification is made only for dictation files that are set as “High” priority. 

 

Pop up Notification 

Pop-up window notification is made only for dictation files. 

When this option is enabled, clicking [Customize] button displays the Configure Notification dialog box, 

where the user can configure the display time and the information to be displayed in the pop-up window. 

 

Sound Notification 

Set the notification sound. 

 button: Plays the notification sound file. 

 button: Stops playback of the notification sound file. 

 button: Sets the name of the notification sound file. (Default: notify.wav) 
 

Support background notification when Dictation Module is not running 

Notification of the arrival of a new file is made even when Dictation Module has not been started. 
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8.2.17 Auto Collection 

 

This function moves the dictation files with Transcription Finished status into a specified folder in the 

Download tray or into a custom folder. Using this option in combination with the Ownership attribute, the 

folder for saving the dictation files can be changed. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Activate Automatic Collection Function 

When this option is enabled, the dictation files with Transcription Finished status are moved to a specified 

folder. 

Either of the following two methods is available: 

• Moving the files to the Finished folder 

• Moving the files to Author ID-specific folders according to a pre-defined rule 

 

To define the rule, perform the following tasks: 

• To add a rule, configure it in the Rule Settings dialog box, which is displayed by clicking [Add]. 

• To modify a rule, select it and click [Modify]. Then, make changes to the rule in the Rule Settings 
dialog box. 

• To delete a rule, select it and click [Remove]. 

 

The Ownership attribute can be set for the Download tray and custom folders. Their subfolders will also 

have the same Ownership attribute. 

 

Using this attribute in combination with Auto Collection, the dictation files with Transcription Finished status 

can be automatically moved to the Finished folder. 

 

Ownership Auto Collection Transcription Finished Dictation Files 

Yes Yes Moved to the Finished folder in Dictation 
Module (set as a rule) 

No Not moved 

No Yes Moved to the Finished folder in Transcription 

Module (set as a rule) 

No Not moved 
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8.2.18 Logging 
 

Set the profile for log file output. 

For items marked with  (icon for locking), only the administrator can change the settings. 
 

User Operations 

 

Items Functions Default 

Specify whether or not to 

output user actions to a 
log file 

Enable this item when outputting a log 

file in which user operations have been 
recorded. 

Disabled 

Location From the list, select a location to which 
a log file is to be output, or enter it 

directly. 

 

File Name Set a log file name. 
The format of a file name will be (prefix) 
computer name_yyyy-mm(suffix). Only 
the (prefix) and (suffix) portions can be 
changed. 
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8.3 User Settings 
 

This category provides user-customized settings for using Dictation Module. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 Procedure 

1. Select [Options] from the [Tool] menu. 

2. Click [User Settings]. 

 The User Settings dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK]: Secures the settings 

[Cancel]: Exits without modifying the settings 

[Apply]: Reflects changes to the configuration file 

 

General 

Keyboard 

Playback Control 

 

8.3.1 General 

 

Language Selection 

This option selects the language displayed by the application. 

If the setting has been modified, it comes into effect only after the application has been restarted. 

 

8.3.2 Keyboard 

 

Specific functions can be assigned to the keys on the keyboard. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Category 

Selecting a category from the category list displays the command/key assignment list in the selected 

category. 

 

New Key 

• To add a key assignment, select a command with no key assigned, specify a key in the New Key box 
using the keyboard, and click [Assign]. [Alt], [Shift], and [Ctrl] can be combined with any other key. 
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• To modify a key assignment, select a command to be modified, specify another key in the New Key 

box using the keyboard, and click [Assign]. 

• To delete a key assignment, select a command with a key assigned, and click [Remove]. 

• To return key assignments to the default settings, click [Reset All]. 

 
For information on default key assignments, refer to Default Key 
Assignments. 

 

Current Key 

If the key entered under “New Key” has already been assigned, the currently assigned command will be 

displayed. 

 

 
For information on default key assignments, refer to Default Key 

Assignments. 

 

8.3.3 Playback Control 

 

This category configures the settings for audio playback. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Control Indicators 

Auto-backspace 

Position 

Winding speed 

 

Control Indicators 

This option manages control display switching as follows: 

• Shows/Hides the Speed control 

• Shows/Hides the Noise Cancel control 

• Shows/Hides the Tone control 

• Shows/Hides the Level Meter control 

 

Auto-backspace 

Set the speed for Auto-backspace. 0.0 to 5.0 seconds (0.1 second step) 

 

Position 

When “Always on top” is enabled, the application window is always displayed on the foreground. 
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• This option is applied only to the Playback Control window, the Direct Recording 
window, and the Speech Recognition Editor. 

• The Main window may not be displayed in the foreground. 

 

Winding speed 

The feed amounts of CUE/REVIEW and FF/REW can be configured in four levels. 

The horizontal axis represents the length of time that has elapsed since starting (3 seconds minimum, 60 

seconds maximum). 

The vertical axis represents the scaling factor relative to the standard playback speed (1.5x minimum, 50x 

maximum). 

Click any one of the four levels and adjust the scaling factor to the desired level. 

Note that it cannot be adjusted to levels less or equal to the scaling factor at the previous level. 

To make an adjustment, select the box displayed for each level. 

• Elapsed time can be adjusted using  and . 

• The playback scaling factor can be adjusted using  and . 

Support playback audio during cue/review 

A typical CUE operation thins out audio data for playback. With this option enabled, however, when 

1.5x or 2.0x is selected, the Speed control is used to provide continuous playback without thinning 

out sound data. 
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8.3.4 Recording Bar 

 

This category configures various settings for direct recording bar. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Display mode  

Recording Bar Position  

Button customization  

 

Display mode 

This option switches the initial mode for a transcription. Select whether to use Recording bar or Standard 

view (Direct Recording window). 

 

Recording Bar Position 

When "Always on top of Playback control/Recording bar" is enabled, the direct recording bar or Direct 

Recording window is displayed as the foreground window. 

 

 

This setting is not applied to the Playback Control bar in the Main window. 

 

Button customization 

This option configures the buttons to be displayed on the Transcribe bar. 

• To add a button, select the button from [Non Display Button] (left), and then click the [Add->] 

button. 

• To make a button invisible, select the button from [Display Button] (right), and then click the [<-

Remove] button. 

• To return the button display settings to the default settings, click [Reset]. 

• To change the order of displayed buttons, select a button to be moved and use the [Up] or [Down] 

button. 

 

 

Customization of the displayed buttons is enabled only when bar display. 
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8.4 E-mail / FTP  
 

This category configures the E-mail and FTP profiles. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 Procedure 

1. Select [Options] from the [Tool] menu. 

2. Click [E-mail / FTP]. 

 The E-mail / FTP dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK]: Secures the settings 

[Cancel]: Exits without modifying the settings 

[Apply]: Reflects changes to the configuration file 

 

E-mail 

FTP 

Send / Receive 

Proxy 
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8.4.1 E-mail 

 

This category can register and modify E-mail profiles. Up to 100 profiles can be registered. 

The following transmission/reception protocols including Web mail are supported. 

• Internet E-mail (POP3/SMTP) 

• IMAP 

• Microsoft Outlook 

• Lotus Notes 

• Outlook.com 

• Outlook Web App for Office 365 

• Gmail 

• Yahoo! Mail 

Selecting an E-mail Profile 

If some profiles have already been registered, select a profile for email transmission and reception from the 

Default Profile drop-down list. 

 

Registering an E-mail Profile 

To register a new E-mail profile, perform the following steps: 

 Procedure 

1. Click [Add]. 

The E-Mail Settings (Select) dialog box will appear. 

2. Select an email transmission/reception protocol and click [Next]. 

 If "Microsoft Outlook" is selected, you can select the inbox if there are multiple inboxes. 
Otherwise, the setting dialog box for the selected email profile will appear. 

 

3. Configure settings. 

 Advanced settings, such as port settings and SSL, can be configured only when using Internet 
email (POP3/SMTP) and IMAP protocols. To configure these settings, click [Advanced settings]. 

4. When configuration has been completed, click [Finish]. 

 

For more information on email settings, contact your service provider or system 
administrator. 

 

Modifying a Profile 

To modify an E-mail profile, select it and click [Modify]. Then, make changes to the profile in the dialog box. 

The displayed dialog box will vary depending on the selected E-mail profile. 
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Deleting a Profile 

To delete a profile, select it from the Default Profile drop-down list and click [Remove]. 

 

Attachment 

With this option enabled, the upper limit for the total size of files attached to an email can be configured. If 

the limit is exceeded, a separate email will be created to accommodate the excess. The upper limit can be 

set in increments of 1 MB in the range of 1 to 100 MB. 

 

8.4.2 FTP 

 

This category configures an FTP profile. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

FTP Profile 

Registered FTP profiles are listed. Up to 100 FTP profiles can be registered. 

With multiple FTP profiles registered, files can be sent to and received from multiple registered FTP sites via 

FTP. 

• To add an FTP profile, configure it in the FTP Settings dialog box, which is displayed by clicking 
[Add]. 

• To modify an FTP profile, select it and click [Modify]. Then, make changes to the profile in the FTP 
Settings dialog box. 

• To delete an FTP profile, select it and click [Remove]. 
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8.4.3 Send / Receive 

 

This category configures the transmission and reception settings of email and FTP. 

Files are sent and received via email or FTP typically when [Send and Receive] is clicked on the module. 

They can also be automatically sent and received at regular intervals. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Send interval 

 When “Automatically send files via E-mail/FTP” is enabled, dictation files can be transferred automatically. 

• When “Send files in the Outbox immediately” is enabled, dictation files moved to the Outbox are 

sent immediately. 

• When “Send files in the Outbox every” is enabled, dictation files moved to the Outbox are sent 
automatically at the specified interval (Default: 10 minutes). 

 

Receive Interval 

When “Automatically receive files via E-mail / FTP” is enabled, files sent via E-mail or FTP can be received at 

the specified interval. (Default: 10 minutes) 

 

Management File 

When sending a file via E-mail/FTP, specifies whether or not a management file is attached. A management 

file is a system file used when sending a dictation file or document file with ODMS R6 or ODMS R7 to share 

dictation file or document file related information, transcription date and time information, and other 

information with the sender/receiver. 

• When “Send management file with the file” is selected, a dictation file, a management file, and 
instruction comment file (if present) are all sent together. Select this option when the addressee is an 
ODMS R6 user or ODMS R7 user. 

• When “Do not send management file with the file” selected, only a dictation file and instruction 
comment file (if present) are sent. Their management file is not sent. Select this option when the 

addressee is not an ODMS R6 user or ODMS R7 user. 

 

8.4.4 Proxy 

 

This category configures a proxy. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

• When “Use Internet Explorer's settings” is selected, the module accesses the same proxy server as 
the one used by Internet Explorer. 

• When “Don't use the proxy server” is selected, no proxy server is configured. 

• When “Use this proxy server” is selected, the module accesses a proxy server with a specified address 

and port number. 

 



 158/231 

8.5 Device 
 

The device configuration allows for obtaining, configuring, initializing, and saving the settings of each 

device. 

Using [Set job Number], the job number can be set in the range of 0 to 9999 (Dictation Module only). 

The configurable setting items of a device are displayed in categorized tree form. Clicking an item in the 

tree switches the window to display the corresponding settings. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

• To return the device settings to default, click [Reset]. Note that in a window without [Reset], the 

settings cannot be returned to default. 

• To upload the device settings, click [Update]. 

 

 

• Lock/unlock settings are configured by the System Configuration Program. 
• The Device Configuration Program also can be used to assign direct lock settings to 

the device. 

 

• The setting items and values (ranges) of devices vary depending on the device model. 

For details, refer to the reference manual for each device. 
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8.5.1 Devices with Device Configuration Support 

 

Devices that can be configured via Dictation Module are listed below. 

This section describes the configuration of DS-7000/5500/3500, DS-9500/DS-9000, RM-4000P/RM-

4010P/RM-4015P/RM-4100S/RM-4110S, and DR-2300/2200/2100/1200. 

 

 
The setting items and values (ranges) of devices vary depending on the 
device model. For details, refer to the reference manual for each 
device. 

 

DS-9500 

DS-9000 

DS-7000 

DS-5500 

DS-3500 

RM-4000/4000P/4010P/4015P/4100S/4110S 

DR-2300/2200/2100/1200 

 

 

 

8.5.2 DS-7000/5500/3500 Device Configuration 

 

This section explains DS-7000/5500/3500 setting items and functions. 

 

Standalone 

Common Settings  

 General  

 Recording  

 Display  

Administrative Settings  

 General  

 Display  

 Device Security  

 Author List  

 Worktype List 

 Device Folders  

 Recording 

 Programmable Buttons  

 Hands Free  

PC Link 

Programmable Buttons  
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Standalone Common Settings 

General 

Items Functions Default 

Beep Sound Sets beep ON/OFF. ON 

Power Save Sets power saving time. 10 min. 

USB Class Selects composite mode or storage mode as the USB 
connection mode. 

Composite 

DS-7000/3500: 
Card Select 
 

DS-5500: 
Memory Select 
 

Switches the card being accessed. SD 

Disable SD Card Slot 
Selecting this check box disables SD Card Slot 
operation so that operation is only with the internal 
memory. 

None 

Cue/Review 

Settings(Sound) 

Selects whether or not to play sound while fast-

forwarding or rewinding during play back. 

OFF 

Cue/Review 
Settings(Speed) 

Sets the Cue/Review speed. Move the indicator to the 
left or right to decrease or increase the speed 
respectively. 

3 

Recording 

Items Functions Default 

Recording Mode Sets the recording mode. QP 

Microphone Sensitivity Sets microphone sensitivity. Dictation 

VCVA Mode Sets VCVA mode (voice-activated recording) ON/OFF. OFF 

Display 

Items Functions Default 

Backlight – 
Lighting Time 

Specifies the backlight illumination time when the 
device is operated. Only supported by DS-7000/3500. 
Not supported by DS-5500. 

10 Seconds 

Backlight – 

Dim light time 

Specifies the dim backlight time after the “Lighting 

Time” elapses. 
When the dim light mode is entered while “Always ON” 
is selected, the backlight will remain lit in the dim light 
mode until the next device operation. 
Only supported by DS-7000/3500. Not supported by 
DS-5500. 

Always ON 

Brightness Specifies backlight brightness. 
A larger value indicates a higher level of backlight 
brightness. 
Only supported by DS-7000/3500. Not supported by 
DS-5500. 

2 

Backlight Turns the backlight on or off. 
Only supported by DS-5500. Not supported by DS-
7000/3500. 

Backlight 

LED Mode Sets LED ON/OFF. ON 

Contrast Adjusts the contrast. (12 levels) 
Only supported by DS-5500. Not supported by DS-
7000/3500. 

6 

Date Format Specifies the date display format. M.D.Y 

If synchronizing the recorder time with that of the PC, 
enable “Use PC Settings”. 

Not 
synchronize
d with the 
PC 

Clock Format Sets whether time display is 12-hour display or 24-
hour display. 

12h 

Language Sets the device display language. English 
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Standalone-Administrative Settings 

General 

Items Functions Default 

Accessibility Disable Erase button 
Allows you to disable the device [ERASE] button. 
When this is set, erasing files will be no longer 
possible. 

Disabled 

Disable Menu button 
Allows you to disable the device [MENU] button. 
When this is set, displaying the menu screen will be 
no longer possible. 

Disabled 

Disable Rewind button 
Allows you to disable the device [Rewind] ( ) 

button. When this is set, rewinding by button 
operation will be no longer possible. 

Disabled 

Splash Message Configures settings for the splash messages 
displayed when the device is turned on. 
If you enter text with “Custom” enabled, the 
entered text will appear when the power is switched 
On. Up to 32 characters can be entered. Both capital 

and lower-case letters are recognized. 

Time of day 
greeting 

Slide Switch Guide When [ON] is selected, the slider switch button is 
positioned on the right side of the LCD. 
* DS-7000/5500 only 

OFF 

Main Button Guide When [ON] is selected, the main button allocation is 
displayed on the right side of the LCD. 
* DS-3500 only 

OFF 

Alarm Error 
Sounds a beep when an error occurs. 

ON 

Pre-end 
Sounds a beep when the remaining recordable time 
reaches certain values. The beep sounds when the 

remaining recordable time is 60, 30, and 10 
seconds. 

ON 

Notification 
After password validation is successful, a beep 

sounds if remaining battery power is low or to notify 
the user of certain other important operations or 
events. 

ON 

Button Operation 
Sounds a beep when there is a device button 

operation. 

OFF 

Recording Start/Stop 
Sounds a beep whenever recording is started or 

stopped. 

OFF 
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Display 

Items Functions Default 

Upper Area Sets the contents displayed in the top information 
display area. 

Hidden 

Middle Area Sets the contents displayed in the middle 
information display area. 
Only supported by DS-7000/3500. Not supported by 
DS-5500. 

Hidden 

Lower Area Sets the contents displayed in the lower information 

display area. 

Hidden 

LED Color Sets the display color of LED. 

Overwrite REC  
You can select off, red, blue, green, orange, or 
yellow. 

Insert REC  
You can select off, red, blue, green, orange, or 
yellow. 

Play  
You can select off, red, blue, green, orange, or 
yellow. 
 
This item is only supported by DS-5500. 

Overwrite 
REC: Red 
Insert REC: 
Blue 

Play: Green 

Device Security 

Items Functions Default 

PIN code To enable the Security, click the [PIN Code change] 
button then enter the PIN code. 

 

Device Lock Enable Device Lock function to prevent 

unauthorized access to the device 
This option can be enabled only when a PIN code 
setting is configured. When it is enabled, the 
following two items can be set. 

Disabled 

Prompt for device PIN code to authenticate 

user 
Select the device lock timing from [At power-on] or 
[At power-on and wake-up from stand-by]. 

At power-on 

Limit the maximum number of device access 

attempts to 
Allows you to specify how many unsuccessful 
consecutive PIN code authentication attempts are 
allowed before the device locks up. 

Five times 

Author List 

Items Functions Default 

Author List Shows the Author List configured by Workflow. 
Enabled Authors are registered in the device’s 
Author List. 
Disabled Authors are removed from the device’s 
Author List. 

[Set as Default] 
Clicking [Set as Default] configures the Author 
selected from the Author List as the default Author. 

[Author of Workflow] 
Links to the Workflow-Author setting. 
=> Registering the Author List to the Recorder 
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Author Selection Prompt for Author ID at Power-on  
With this option enabled, the Author List is displayed 
when a recording is started using the recorder. 
(However, if only one Author has been registered, 
the list is not displayed.) 

 

Worktype List 

Items Functions Default 

Worktype List Shows the Worktype List configured by Workflow. 

Enabled Worktypes are registered in the device’s 
Worktype. 
Disabled Worktypes are removed from the device’s 
Worktype. 

[Set as Default] 
Clicking [Set as Default] configures the Worktype 

selected with the Worktype List as the default 
Worktype. 

[Worktype of Workflow] 
Links to the Workflow-Worktype setting. 

 

Worktype Selection Prompt for Worktype ID on new recordings. 
With this enabled, Worktype List is shown when 
new recording is performed so that you can select 
Worktype to be set in a dictation file. Worktype List 
is not shown when only one item has been 
registered. 

Disabled 

Device Folders 

After you select a folder in the Folder Tree, you can configure its folder properties. 

Items Functions Default 

Folder Property(General) Enabled 
Sets the number of folders to enable on the device. 

Folders A to 
E, enabled 
Folders F 
and G, 
disabled 

Folder Name 
Allows you to set up to 16 single-byte alphanumeric 
English characters for a folder name. 

Folders A to 
G 

Worktype 
Allows you to specify the Worktype to set for 
dictation files recorded to each folder.Specifying a 
Worktype here always uses the Worktype specified 
for the folder without displaying the Worktype List, 

even if “Prompt for Worktype ID on new 
recordings.” is enabled for “Worktype selection” on 
the [Worktype] screen. 

 

Folder Property(Security) 
 

Auto Lock 
Specifies whether dictation files recorded to the 

folder should be locked. 

No 

Encryption 
Sets whether to encrypt the dictation files recorded 
to the folder. This setting can be configured when 

the folder is enabled, and “DSS Pro” is selected for 
the “DSS Format” setting on the [Administrative 
Setting] - [Recording] screen. “DSS Classic” 
encryption is not supported. 

Selections Description 

No Do not encrypt. 

Standard Encrypt using a 128-bit key. 

High Encrypt using a 256-bit key. 
 

No 
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Password 
Specifies the password to be used for encryption. 

Click the  button in the setting field, and use the 
displayed Encryption Password dialog box to make 

the setting. Enter a password in the [New 
password] and [Confirm password] fields using 4 to 
16 one-byte alphanumeric characters. 
The password is the same as the password for the 
[Encryption] Standard mode and High mode. An 
encryption key, suitable for the specified encryption 
mode, is generated from the password, with a key 

length that is in accordance with the encryption 
mode set within the program. 

 

Folder Property(Action) Speech Recognition 
Specifies the initial value of ON/OFF for Background 

VR during recording. If it is ON, recorded dictation 

files in this folder are automatically added to the 
Speech Recognition Waiting List when downloaded 
to ODMS. 
Only supported by DS-7000/3500. Not supported 
by DS-5500. 

Yes 

 

 

DS-7000/5500/3500 Folder Settings 
 There are two memory areas; the DS-7000/3500 have SD and Micro SD 

memories and the DS-5500 has SD memory and internal memory. The 
device menu can be used to specify which memory is being recorded to. 
Both have the same folder structure with “DSS_FLDA” to “DSS_FLDG” 

folders. These settings are applied to both memory areas. 

Recording 

Items Functions Default 

DSS Format Selects the DSS recording format. 

The default recording format for DSS Classic is DSS. 
The default recording format for DSS Pro is DS2. 
When DSS Classic mode is switched from “DSS Pro”, 
the following items are checked: 

• If the recording format is set to QP, it is changed to 
SP, and QP is prevented from being selected. => 
“Standalone” – “Common Settings” – “Recording” 

• The Encryption attribute is set to “NO” and is 
prevented from being modified.  
=> “Standalone” – “Administrative Settings” – 
“Folder” 

DSS Pro 

Record Function Sets the recording operation. Overwrite 

File download Sets the target (file) to download automatically 
when connected by USB. 

All Files 

Programmable Buttons 

Items Functions Default 

New and Slide Switch 

Functions 

Selects Type A, Type B, or Type C as the functions 

assigned to each position of the slide switch and the 
buttons above the slide switch. 
* DS-7000/DS-5500 only 

Type A 

Main Button Functions Selects either Type A or Type B as the function 
assigned to the main switch button. 

* DS-3500 only 

Type A 

Programmable Buttons Customizes the functions that are assigned to the 
function buttons [F1], [F2], and [F3] on the device. 

 

Rec Mode Selects whether or not the REC button must be held 
down to record. 
* DS-3500 only 

Disabled 
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The following table shows functions that can be assigned to function buttons F1 to F3. 

 

■DS-7000 

Mode F1 F2 F3 

NEW Mode Folder Folder Folder 

Priority Priority Priority 

Information Information Information 

Rec Mode Rec Mode Rec Mode 

Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 

VCVA VCVA VCVA 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Disable Disable Disable 

STOP Mode Folder Folder Folder 

Priority Priority Priority 

Information Information Information 

Pending Pending Pending 

Lock Lock Lock 

Insert Insert Insert 

Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 

VCVA VCVA VCVA 

New New New 

File Copy File Copy File Copy 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Index Index Index 

Speech 
Recognition 

Speech 
Recognition 

Speech Recognition 

Disable Disable Disable 

REC Mode Verbal Verbal Verbal 

Disable Disable Disable 

Index Index Index 

PLAY Mode Insert Insert Insert 

Speed Speed Speed 

Index Index Index 

Pending Pending Pending 

Priority Priority Priority 

Lock Lock Lock 

Speech 
Recognition 

Speech 
Recognition 

Speech Recognition 

Disable Disable Disable 

 

 

■DS-5500 

Mode F1 F2 F3 

NEW Mode Folder Folder Folder 

Priority Priority Priority 

Information Information Information 

Rec Mode Rec Mode Rec Mode 

Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 

VCVA VCVA VCVA 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Disable Disable Disable 

STOP Mode Folder Folder Folder 

Priority Priority Priority 

Information Information Information 

Pending Pending Pending 
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Lock Lock Lock 

Insert Insert Insert 

Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 

VCVA VCVA VCVA 

New New New 

File Copy File Copy File Copy 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Index Index Index 

Disable Disable Disable 

REC Mode Verbal Verbal Verbal 

Disable Disable Disable 

Display Display Display 

Index Index Index 

PLAY Mode Insert Insert Insert 

Speed Speed Speed 

Index Index Index 

Pending Pending Pending 

Priority Priority Priority 

Lock Lock Lock 

Disable Disable Disable 

 

■DS-3500 

Mode F1 F2 F3 

NEW Mode Folder Folder Folder 

Priority Priority Priority 

Information Information Information 

Rec Mode Rec Mode Rec Mode 

Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 

VCVA VCVA VCVA 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Disable Disable Disable 

STOP Mode Folder Folder Folder 

Priority Priority Priority 

Information Information Information 

Pending Pending Pending 

Lock Lock Lock 

Insert Insert Insert 

Mic. Sensitivity Mic. Sensitivity Mic. Sensitivity 

VCVA VCVA VCVA 

New New New 

File Copy File Copy File Copy 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Index Index Index 

Speech Recognition Speech Recognition Speech Recognition 

Disable Disable Disable 

REC Mode Verbal Verbal Verbal 

Disable Disable Disable 

Index Index Index 

PLAY Mode Insert Insert Insert 

Speed Speed Speed 

Index Index Index 

Pending Pending Pending 

Priority Priority Priority 

Lock Lock Lock 

Speech Recognition Speech Recognition Speech Recognition 

Disable Disable Disable 
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Hands Free 

Connecting a foot pedal to the cradle of the recorder enables hands-free operations. 

 

Items Functions Default 

Operation Settings Sets hands free operations. Dictation 

Foot Pedal Settings Selects foot pedal press methods and the functions 
to be assigned to foot pedals. 

 

 

The following table shows functions that can be assigned to each pedal. 

• Continuous Press 

Function Name Description 

REV/PLAY Rewind (Review) is performed while the pedal is pressed. 
Releasing the pedal performs playback from the indicator 

position. 

REC/STOP Recording is performed while the pedal is pressed. Releasing the 
pedal stops recording. 

NEW Pressing the pedal creates a new dictation file. 

DISABLE Disables pedal operation. No operation is performed when the 
pedal is pressed. 

CUE/PLAY Fast forward (Cue) is performed while the pedal is pressed. 
Releasing the pedal performs playback from the indicator 
position. 

INSERT/STOP Insert recording is performed at the indicator position while the 
pedal is pressed. Releasing the pedal stops insert recording. 

STOP Pressing the pedal stops playback. 

EOF/BOF Pressing the pedal moves the indicator to the end of the file. If 
the indicator is already at the end of the file, pressing the pedal 

moves it to the beginning of the file. 

INDEX Pressing the pedal inserts an index mark at the indicator position. 

PRIORITY Pressing the pedal switches the priority of the dictation file being 
recorded. (High<->Normal) 

 

• Short Press 

Function Name Description 

REW Pressing the pedal performs rewind. 

PLAY/STOP Pressing the pedal starts playback from the indicator position. 
Pressing the pedal again stops playback. 

REC/STOP Pressing the pedal starts recording. Pressing the pedal again 
stops recording. 

NEW Pressing the pedal creates a new dictation file. 

DISABLE Disables pedal operation. No operation is performed when the 

pedal is pressed. 

FF Pressing the pedal performs fast forward. 

INSERT/STOP Pressing the pedal starts insert recording from the indicator 
position. Pressing the pedal again during insert recording stops 
insert recording. 

EOF/BOF Pressing the pedal moves the indicator to the end of the file. If 
the indicator is already at the end of the file, pressing the pedal 
moves it to the beginning of the file. 

INDEX Pressing the pedal inserts an index mark at the indicator position. 

PRIORITY Pressing the pedal switches the priority of the dictation file being 
recorded. (High<->Normal) 
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PC Link 

Programmable Buttons 

Specifies the operations performed when the function buttons ([F1], [F2], [F3]) of the device 

connected to the PC are pressed. 

 

Items Functions 

Main Window Specifies the operation while the Dictation Module Main window is 

active. 

Direct Recording Window Specifies the operation while the Direct Recording window is active. 

Speech Recognition Specifies the operation while the Speech Recognition Editor is 

active. 
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8.5.3 DS-9500/9000 Device Configuration 

 

This section describes the DS-9500/9000 device setting items and their functions. 

 

Standalone 

Common Settings  

 General  

 Recording  

 Display  

 Recipient E-mail  

Administrative Settings  

 General  

 Display  

 Device Security  

 Author List  

 Worktype List 

 Device Folders  

 Recording 

 Programmable Buttons  

Hands Free  

 Wireless Network 

 Wireless Download 

 E-mail Profile 

 

PC Link 

Programmable Buttons  

 

Standalone Common Settings 

General 

Items Functions Default 

Beep Sound Selects the volume of the beep sound. Volume 1 

Power Save Selects power saving time. 10 min. 

USB Class Selects Composite or Storage mode as the USB 
connection mode 

Composite 

Memory Select Switches the memory being accessed. Built-in 
Memory 

Disable SD Card Slot 
Selecting this check box disables SD Card Slot 

operation so it is no longer recognized from the PC. 

None 

Cue/Review 
Settings(Sound) 

Selects whether or not to play sound while fast-
forwarding or rewinding during play back. 

OFF 

Cue/Review 

Settings(Speed) 

Sets the Cue/Review speed. Move the indicator to the 

left or right to decrease or increase the speed 
respectively. 

3 
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Review Skip Sets the interval for reverse skipping with Review 
Skip. 

3 seconds 

 

Recording 

Items Functions Default 

Microphone Mode Sets the microphone mode. Dictation 1 

Recording Mode Sets the recording mode. DSS – QP 

Microphone Sensitivity Sets Microphone Sensitivity Middle 

VCVA Mode Sets VCVA mode (voice-activated recording) ON/OFF. OFF 
 

Display 

Items Functions Default 

Backlight – 

Lighting Time 

Specifies the backlight illumination time when the 

device is operated. 

10 Seconds 

Backlight – 
Dim light time 

Specifies the dim backlight time after the “Lighting 
Time” elapses. 

When the dim light mode is entered while “Always ON” 
is selected, the backlight will remain lit in the dim light 
mode until the next device operation. 
 

Always ON 

Backlight – 

Brightness 

Specifies backlight brightness. 

A larger value indicates a higher level of backlight 
brightness. 
 

2 

LED Mode Sets LED ON/OFF. ON 

Date Format Specifies the date display format. M.D.Y 

If synchronizing the recorder time with that of the PC, 
enable “Use PC Settings”. 

Not 
synchronize

d with the 

PC 

Clock Format Sets whether time display is 12-hour display or 24-
hour display. 

12h 

Language Sets the device display language. English 
 

Recipient E-mail 

Configures the address and other settings for when e-mail is sent by the recorder. (DS-9500 only) 

Items Functions Default 

Author ID You can register a sender e-mail profile and send 
destination addresses for each Author ID. This selects 
the Author ID for which to register them. 

 

Default Profile Selects the default e-mail profile to use when sending 
e-mail. 

The e-mail address selected here needs to be 
registered separately. 
=> “Standalone” – “Administrative Settings” – “E-mail 
Profile” 

 

Delivery Address Up to 10 delivery e-mail addresses can be registered 

for each Author ID. 
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Standalone-Administrative Settings 

General 

Items Functions Default 

Accessibility Disable Erase button 
Allows you to disable the device [ERASE] button. 
When this is set, erasing files will be no longer 
possible. 

Disabled 

Disable Menu button 
Allows you to disable the device [MENU] button. 
When this is set, displaying the menu screen will be 
no longer possible. 

Disabled 

Disable Rewind button 
Allows you to disable the device [Rewind] (|◀◀) 

button. When this is set, rewinding by button 
operation will be no longer possible. 

Disabled 

Splash Message Configures settings for the splash messages 
displayed when the device is turned on. 
If you enter text with “Custom” enabled, the 
entered text will appear when the power is switched 
On. Up to 32 characters can be entered. Both capital 

and lower-case letters are recognized. 

Time of day 
greeting 

Alarm Error 
Sounds a beep when an error occurs. 

ON 

Pre-end 
Sounds a beep when remaining recordable time runs 
low. An alarm sounds when remaining recordable 
time reaches 60 seconds, 30 seconds, and 10 

seconds. 

ON 

Notification 
After password validation is successful, a beep 
sounds if remaining battery power is low or to notify 
the user of certain other important operations or 

events. 

ON 

Button Operation 
Sounds a beep whenever a device button operation 
is performed. 

OFF 

Recording Start/Stop 
Sounds a beep whenever recording is started or 
stopped. 

OFF 

 

Display 

Items Functions Default 

Information Area  
in Rec Mode 

Selects the content to display in the upper and 
lower sections of the information display area. 

Hidden 

File Information  
in List View 

Selects the content to display in the file list. 
 
* DS-9500 only 

Date&Time 
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LED Color Sets the display color of LED.  

Overwrite REC  
You can select off, red, blue, green, orange, or 
yellow. 

Insert REC  
You can select off, red, blue, green, orange, or 

yellow. 

Play  
You can select off, red, blue, green, orange, or 
yellow. 

Overwrite 
REC: Red 

Insert REC: 
Blue 
Play: Green 
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Device Security 

Items Functions Default 

PIN code To enable the Security, click the [PIN Code 
change] button then enter the PIN code. 

 

Device Lock Enable Device Lock function to prevent 

unauthorized access to the device 
This option can be enabled only when a PIN code 
setting is configured. When it is enabled, the 
following two items can be set. 

Disabled 

Prompt for device PIN code to 

authenticate user 
Select the device lock timing from [At power-on] 

or [At power-on and wake-up from stand-by]. 

At power-on 

Limit the maximum number of device 

access attempts to 
Allows you to specify how many unsuccessful 

consecutive PIN code authentication attempts 
are allowed before the device locks up. 

Five times 

 

Author List 

Items Functions Default 

Author List Shows the Author List configured by Workflow. 
Enabled Authors are registered in the device’s 
Author List. 
Disabled Authors are removed from the device’s 
Author List. 

[Set as Default] 
Clicking [Set as Default] configures the Author 
selected from the Author List as the default 
Author. 

[Author of Workflow] 
Links to the Workflow-Author setting. 
=> Registering the Author List to the Recorder 

 

Author Selection Prompt for author ID at Power-on  
With this option enabled, the Author List is 

displayed when a recorder starts up. (However, 
if only one Author has been registered, the list is 
not displayed.) 

Disabled 

Filter dictations by Author ID 

With this option enabled, only the dictation 

files of the selected Author ID are displayed 

on the recorder. 

Disabled 
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Worktype List 

Items Functions Default 

Worktype List Shows the Worktype List configured by 
Workflow. 
Enabled Worktypes are registered in the device’s 
Worktype. 

Disabled Worktypes are removed from the 
device’s Worktype. 

[Set as Default] 
Clicking [Set as Default] configures the 
Worktype selected with the Worktype List as the 
default Worktype. 

[Worktype of Workflow] 
Links to the Workflow-Worktype setting. 

 

Worktype Selection Prompt for Worktype ID on new 

recordings. 
With this enabled, Worktype List is shown when 
new recording is performed so that you can 
select Worktype to be set in a dictation file. 
Worktype List is not shown when only one item 
has been registered. 

Disabled 

 

Device Folders 

After you select a folder in the Folder Tree, you can configure its folder properties. 

Items Functions Default 

Folder Property(General) Enabled 
Sets the number of folders to enable on the device. 

Folders A to 
E, enabled 

Folders F 
and G, 
disabled 

Folder Name 
Allows you to set up to 16 single-byte alphanumeric 
English characters for a folder name. 

Folders A to 
G 

Worktype 
Allows you to specify the Worktype to set for 
dictation files recorded to each folder. 
Specifying a Worktype here always uses the 
Worktype specified for the folder without displaying 
the Worktype List, even if “Prompt for Worktype ID 
on new recordings.” is enabled for “Worktype 

selection” on the [Worktype] screen. 

 

Folder Property(Security) 
 

Auto Lock 
Specifies whether dictation files recorded to the 
folder should be locked. 

No 

Encryption 
Sets whether to encrypt the dictation files recorded 
to the folder. This setting can be configured when 
the folder is enabled, and “DSS Pro” is selected for 
the “DSS Format” setting on the [Administrative 

Setting] - [Recording] screen. “DSS Classic” 
encryption is not supported by the device. 

Selections Description 

No Do not encrypt. 

Standard Encrypt using a 128-bit key. 

High Encrypt using a 256-bit key. 
 

No 
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Password 
Specifies the password to be used for encryption. 

Click the  button in the setting field, and use the 
displayed Encryption Password dialog box to make 

the setting. Enter a password in the [New 
password] and [Confirm password] fields using 4 to 
16 one-byte alphanumeric characters. 
The password is the same as the password for the 
[Encryption] Standard mode and High mode. An 
encryption key, suitable for the specified encryption 
mode, is generated from the password, with a key 

length that is in accordance with the encryption 
mode set within the program. 

 

Folder Property(Action) Speech Recognition 
Specifies the initial value of ON/OFF for Background 

VR during recording. If it is ON, recorded dictation 

files in this folder are automatically added to the 
Speech Recognition Waiting List when downloaded 
to ODMS. 

Yes 

 

 

DS-9500/9000 Folder Settings 

 The DS-9500 and 9000 have two memory areas: SD memory and internal 
memory. You can set which one to record to in the device menu. Both have 
the same folder structure with “DSS_FLDA” to “DSS_FLDG” folders. These 
settings are applied to both memory areas. 

 

Recording 

Items Functions Default 

DSS Format Selects the DSS recording format. 
The default recording format for DSS Classic is 

DSS. 
The default recording format for DSS Pro is DS2. 
When DSS Classic mode is switched from “DSS 
Pro”, the following items are checked: 

• If the recording format is set to QP, it is changed 
to SP, and QP is prevented from being selected. 
=> “Standalone” – “Common Settings” – 

“Recording”  
• The Encryption attribute is set to “NO” and is 

prevented from being modified.  
=> “Standalone” – “Administrative Settings” – 
“Folder” 

DSS Pro 

Record Function Sets the recording operation. Overwrite 

File download Sets the target (file) to download automatically 
when connected by USB. 

All Files 

 

Programmable Buttons 

Items Functions Default 

New and Slide Switch 
Functions 

Selects Type A, Type B, or Type C as the functions 
assigned to each position of the slide switch and the 

buttons above the slide switch. 
* DS-7000/DS-5500 only 

Type A 

Programmable Buttons Customizes the functions that are assigned to the 
function buttons [F1], [F2], and [F3] on the device. 

 

 

The following table shows functions that can be assigned to function buttons F1 to F3. 

■ DS-9500 
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Mode F1 F2 F3 

NEW Mode List List List 

Priority Priority Priority 

Information Information Information 

Mic Mode Mic Mode Mic Mode 

Rec Mode Rec Mode Rec Mode 

Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 

VCVA VCVA VCVA 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Disable Disable Disable 

STOP Mode List List List 

Priority Priority Priority 

Send Send Send 

Information Information Information 

Pending Pending Pending 

Lock Lock Lock 

Insert Insert Insert 

Mic Mode Mic Mode Mic Mode 

Mic. Sensitivity Mic. Sensitivity Mic. Sensitivity 

VCVA VCVA VCVA 

New New New 

File Copy File Copy File Copy 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Index Index Index 

Speech Recognition Speech Recognition Speech Recognition 

Disable Disable Disable 

List Mode List List List 

Filter Filter Filter 

Send Send Send 

Priority Priority Priority 

Information Information Information 

Pending Pending Pending 

Lock Lock Lock 

File Copy File Copy File Copy 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Speech Recognition Speech Recognition Speech Recognition 

Disable Disable Disable 

REC Mode Verbal Verbal Verbal 

Disable Disable Disable 

Index Index Index 

PLAY Mode Insert Insert Insert 

Speed Speed Speed 

Index Index Index 

Pending Pending Pending 

Priority Priority Priority 

Lock Lock Lock 

Speech Recognition Speech Recognition Speech Recognition 

Disable Disable Disable 

 

■ DS-9000 

Mode F1 F2 F3 

NEW Mode Folder Folder Folder 

Priority Priority Priority 

Information Information Information 

Mic Mode Mic Mode Mic Mode 

Rec Mode Rec Mode Rec Mode 
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Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 

VCVA VCVA VCVA 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Disable Disable Disable 

STOP Mode Folder Folder Folder 

Priority Priority Priority 

Information Information Information 

Pending Pending Pending 

Lock Lock Lock 

Insert Insert Insert 

Mic Mode Mic Mode Mic Mode 

Mic. Sensitivity Mic. Sensitivity Mic. Sensitivity 

VCVA VCVA VCVA 

New New New 

File Copy File Copy File Copy 

Folder Copy Folder Copy Folder Copy 

All Copy All Copy All Copy 

Index Index Index 

Speech Recognition Speech Recognition Speech Recognition 

Disable Disable Disable 

REC Mode Verbal Verbal Verbal 

Disable Disable Disable 

Index Index Index 

PLAY Mode Insert Insert Insert 

Speed Speed Speed 

Index Index Index 

Pending Pending Pending 

Priority Priority Priority 

Lock Lock Lock 

Speech Recognition Speech Recognition Speech Recognition 

Disable Disable Disable 
 
 

Hands Free 

Connecting a foot pedal to the cradle of the recorder enables hands-free operations. 

 

Items Functions Default 

Operation Settings Sets hands free operations. Dictation 

Microphone Mode  Enables/disables the function to 
automatically switch to the microphone 
mode for hands free. 

Disabled 

Foot Pedal Settings Selects foot pedal press methods and the 

functions to be assigned to foot pedals. 

 

 

The following table shows functions that can be assigned to each pedal. 

• Continuous Press 

Function Name Description 

REV/PLAY Rewind (Review) is performed while the pedal is pressed. 
Releasing the pedal performs playback from the indicator 
position. 

REC/STOP Recording is performed while the pedal is pressed. Releasing the 

pedal stops recording. 

NEW Pressing the pedal creates a new dictation file. 

DISABLE Disables pedal operation. No operation is performed when the 

pedal is pressed. 

CUE/PLAY Fast forward (Cue) is performed while the pedal is pressed. 
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Releasing the pedal performs playback from the indicator 
position. 

INSERT/STOP Insert recording is performed at the indicator position while the 
pedal is pressed. Releasing the pedal stops insert recording. 

STOP Pressing the pedal stops playback. 

EOF/BOF Pressing the pedal moves the indicator to the end of the file. If 
the indicator is already at the end of the file, pressing the pedal 

moves it to the beginning of the file. 

INDEX Pressing the pedal inserts an index mark at the indicator position. 

PRIORITY Pressing the pedal switches the priority of the dictation file being 
recorded. (High<->Normal) 

 

• Short Press 

Function Name Description 

REW Pressing the pedal performs rewind. 

PLAY/STOP Pressing the pedal starts playback from the indicator position. 
Pressing the pedal again stops playback. 

REC/STOP Pressing the pedal starts recording. Pressing the pedal again 
stops recording. 

NEW Pressing the pedal creates a new dictation file. 

DISABLE Disables pedal operation. No operation is performed when the 
pedal is pressed. 

FF Pressing the pedal performs fast forward. 

INSERT/STOP Pressing the pedal starts insert recording from the indicator 
position. Pressing the pedal again during insert recording stops 
insert recording. 

EOF/BOF Pressing the pedal moves the indicator to the end of the file. If 

the indicator is already at the end of the file, pressing the pedal 
moves it to the beginning of the file. 

INDEX Pressing the pedal inserts an index mark at the indicator position. 

PRIORITY Pressing the pedal switches the priority of the dictation file being 

recorded. (High<->Normal) 
 

Wireless Network 

Configures various settings for a wireless network. (DS-9500 only) 

Items Functions Default 

Wi-Fi Turns Wi-Fi on or off. OFF 

Quick Send If this option is enabled, the current file is sent 
at the timing when the [New] button is 
pressed. 

Disabled 

Network List Up to 10 wireless network profiles can be 
registered. 

Set the network name and security key for 
each wireless network. 

 

Wireless Download 

Configures the settings to transfer dictation files to a folder via the wireless network. (DS-9500 

only) 

Items Functions Default 

Wireless Download Enable wireless download to folder 
Enables/disables the wireless download 
function. 

Disabled 
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Address / Port 
Sets the address (computer name) and port 
number of the computer running Wireless 
Communication Service. 
 
If you click [Use Wireless Downloader], the 
address and port number for using Wireless 
Downloader are entered automatically. 

 

Download Path Sets the download destination for dictation 
files for each folder of the recorder. 

 

Clock Synchronization When this option is enabled, the clock of the 

recorder is synchronized with the time of the 
computer running Wireless Communication 
Service (WCS) when communicating with the 
recorder and WCS. 

Enabled 

Delete Sets whether or not to delete dictation files 

after they have been downloaded via the 
network. 
If you set dictation files to be deleted, you can 
set whether to delete them immediately after 
downloading or after a specified time has 
elapsed after transcription completes. 

OFF 

Rename If this option is enabled, files are renamed 
according to a naming rule when downloaded. 
The naming rule can be set in the dialog box 
displayed by clicking [Format]. 

Disabled 

WAV Conversion If this option is enabled, files are converted 
from DSS Pro format to WAV format when 
downloaded. 

Disabled 

 

 

Wireless Downloader 

 If settings entered automatically by using the [Use Wireless Downloader] button 
are uploaded to the device, Wireless Downloader starts automatically. Wireless 
Downloader displays an icon in the notification area and runs in the background. 

Backing Up Dictation Files 
 Dictation files transferred via Wireless Downloader can be backed up for every 

date by specifying any folder. They can also be managed as the backup files of DM 
if you specify the backup folder of ODMS. This can be set in the menu settings of 
the icon in the notification area. 

Associating with the Wireless Communication Service 
If the PC on which WCS is installed is on the network, specify the Address/Port of the 
PC and connect the DS-9500 (Ver. 1.13 or later) to DM/TM via USB to download the 
dictation files to the specified folders. The dictation status will then be manageable in 
the same way as during Wi-Fi transfer. 

 

E-mail Profile 

Configures various settings for e-mail of the recorder. (DS-9500 only) 

Items Functions Default 

E-mail Profile List Up to 10 profiles for sending e-mail from the 
recorder can be registered. 
This option sets the user information, server 
information, and other settings for each e-mail 
profile. It also assigns the Author ID of the 
author that will use that profile to the e-mail 
profile. 

 

Mail Template Registers the subject and message of the e-
mail that will be sent as a template. 
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Delete Sets whether or not to delete dictation files 
after they have been sent by e-mail. 

If you set dictation files to be deleted, you can 
set whether to delete them immediately after 
sending or after a specified time has elapsed 
after sending. 

OFF 

 

PC Link 

Programmable Buttons 

Specifies the operations performed when the function buttons ([F1], [F2], [F3]) of the device 

connected to the PC are pressed. 

 

Items Functions 

Main Window Specifies the operation while the Dictation Module Main window is 
active. 

Direct Recording Window Specifies the operation while the Direct Recording window is active. 

Speech Recognition Specifies the operation while the Speech Recognition Editor is 
active. 
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8.5.4 DR-2300/2200/2100/1200 Device Configuration 

 
 This section describes the device setting items and their functions for DR-2300/2200/2100/1200 

RecMics (digital microphone devices for dictation). 

Customize 

Application Control 

 
 

Customize 

The [Button] column in the Button list displays the actual buttons on RecMic, and the [Function] column 

lists functions assigned to the buttons. 

Clicking the Function column for a button opens a pull-down menu, which lists functions that can be 

assigned to the button. Select a function to assign to the button from the list. The DR-2100 does not have a 

track ball so the “Enable Trackball” setting cannot be configured. 

User ID 

This option configures the user ID. 

Enable Beep Sound 

Checking this option enables a beep sound. You also can adjust the volume level of the beep 

sound. 

Enable Button Click Suppression 

Selecting the check box of this item suppresses the RecMic device button click sound so it is less 

susceptible to pick up by the RecMic device microphone. 

Enable Trackball 

Selecting the check box of this item enables trackball operations. You also can adjust trackball 

sensitivity (movement amount). 

Enable ClickLock 

Checking this option locks the left button in the pressed position after you press it. You also can 

set the length of time that it is locked. 

 

Application Control  

Assign functions to be performed when RecMic buttons are clicked while recording voice with Direct 

Recording Window or doing Real-time Speech Recognition with Speech Recognition Editor. 

 

Assigned function settings are applied both to the Direct Recording Window and the Speech Recognition 

Editor. 

In the Speech Recognition Editor, the commands appear on the tool bar if the assigned function is a voice 

command. 
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Some functions, such as Insert Index Mark, are only for Direct Recording Window. 
Some functions, such as Send for Correction are only for Speech Recognition Editor. 

If the currently active window does not support the assigned function, that function is 
not executed on that window. 

 

In addition to RecMic buttons, functions can also be assigned to combinations that involve the PC keyboard 

[Shift] and [Ctrl] key. To execute a function assigned to a key combination, hold the [Shift] or [Ctrl] key on 

the PC keyboard as you press the applicable RecMic button. 

 

Application Control settings can be saved in a file, so the same settings can be imported by other users. 

This means that the same settings can be setup in multiple user environments, which improves work 

efficiency. 

 

[Import] 
Imports key function assignments from a file. Click the [Import] button 

and then specify the file you want to import. 

[Export] 
Exports key function assignments to a file. Click the [Export] button and 
then specify the output destination and file name. 

 

Command DR VR Description 

<Empty>   No command is assigned. 

Launch Dictation Module   Starts up Dictation Module. 

Cancel / Exit Y Y 
Stops recording and returns to the Main Window. 
The Dictation Module is disabled while the Main Window is 

displayed. 

Record Verbal Comment Y  
While this button is pressed, verbal comment recording is 

performed from the position of the record indicator cursor. 

Switch between High and 

Normal Priority 
Y Y 

Changes the priority setting of the dictation file being 

recorded. 

(High<->Normal) 

Switch between Conference 

and Dictation 
Y  

Changes the recording sensitivity. 

Switch between Insert and 

Overwrite mode 
Y  

Changes the recording mode. 
(Insert <-> Overwrite) 

Pending Dictation Y Y 

In case of DR, saves the dictation file currently being 

recorded and assigns it Recording Pending status, and closes 
the Direct Recording Window. 

In case of VR, performs the same operation as the “Pending” 

menu item Speech Recognition Editor. 

Finish Dictation Y Y 

In case of DR, saves the dictation file currently being 

recorded and assigns it Recording Finished status, and closes 

the Direct Recording Window. 

In case of VR, performs the same operation as the “Finished” 

menu item Speech Recognition Editor. 

Delete Instruction Comment Y  Deletes the instruction comment of the recording file. 

Undo Y Y Undoes the last operation. 

Redo Y Y Redoes the last undone operation. 

Volume Up Y Y Increases playback volume. 

Volume Down Y Y Decreases playback volume. 

Dictation/Instruction 

Comment mode 
Y  

Toggles between the Instruction Comment record and 
playback modes. 

Insert Index Mark Y  
Inserts an Index Mark at the playback indicator cursor 

position. 

Delete Index Mark Y  
Deletes the Index Mark at the playback indicator cursor 

position. 

Send For Correction  Y 
Performs the same operation as the [Send for Correction] 

menu item of the Speech Recognition Editor. 

Show Correction Dialog  Y 
Performs the same operation as the [Show Correction Dialog] 

menu item of the Speech Recognition Editor. 
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Show Spell Dialog  Y 
Performs the same operation as the [Show Spell Dialog] 

menu item of the Speech Recognition Editor. 

Train Word  Y 
Performs the same operation as the [Train Word] menu item 
of the Speech Recognition Editor. 

Add New Word  Y 
Performs the same operation as the [Add New Word] menu 

item of the Speech Recognition Editor. 

Start Dragon Audio Setup 

Wizard 
 Y 

Performs the same operation as the [Start Dragon Audio 
Setup Wizard] menu item of the Speech Recognition Editor. 

Copy to Clipboard Y Y 
Performs the same operation as the [Copy to Clipboard] 

menu item of the Speech Recognition Editor. 

• In the case of DR, the box displays commands that are enabled during recording with the Direct 
Recording Window. 

• In the case of VR, the box displays commands that are enabled when performing speech recognition 
with Real-time Speech Recognition. 
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8.5.5 RM-4000P/4010P/4015P/4100S/4110S Device Configuration 

 
 This section describes the device setting items and their functions for RM-

4000P/4010P/4015P/4100S/4110S RecMics (digital microphone devices for dictation). 

Customize 

General 

Recording scene mode  

Motion Control  

Application Control 

 

General 

The [Button] column in the Button list displays the actual buttons on RecMic, and the [Function] column 

lists functions assigned to the buttons. 

Clicking the Function column for a button opens a pull-down menu, which lists functions that can be 

assigned to the button. Select a function to assign to the button from the list. 

User ID 

This option configures the user ID. 

Enable Button Click Suppression 

Selecting the check box of this item suppresses the RecMic device button click sound so it is less 

susceptible to pick up by the RecMic device microphone. 

Enable Beep Sound 

Checking this option enables a beep sound. You also can adjust the volume level of the beep 

sound. 

Enable Trackball 

Selecting the check box of this item enables trackball operations. You also can adjust trackball 

sensitivity (movement amount). This setting cannot be configured for a model that does not have 

a trackball. 

Enable ClickLock 

Checking this option locks the left button in the pressed position after you press it. You also can 

set the length of time that it is locked. 

 

Recording scene mode 

Current settings 

Select one item from this list to use the recording scene mode that matches your environment. The 

directionality and noise reduction level controlled by each recording scene mode are displayed. 

 

The Directionality, Noise cancellation, and Automatic Gain Control options cannot 

be changed. 
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Motion control 

Enable automatic mute mode 

Select this check box to use the function to mute automatically using the motion sensor. 

If this option is enabled, the microphone is muted automatically when the RecMic is placed on a desk. 

 

Enable hands-free recording mode 

Select this check box to use the hands-free recording mode. 

If this option is enabled, the mode is changed to the hands-free recording mode when the RecMic is 

placed in the stand. 

 

Application Control  

Assign functions to be performed when RecMic buttons are clicked while recording voice with Direct 

Recording Window or doing Real-time Speech Recognition with Speech Recognition Editor. 

 

Assigned function settings are applied both to the Direct Recording Window and the Speech Recognition 

Editor. 

In the Speech Recognition Editor, the commands appear on the tool bar if the assigned function is a voice 

command. 

 

Some functions, such as Insert Index Mark, are only for Direct Recording Window. 

Some functions, such as Send for Correction are only for Speech Recognition Editor. 
If the currently active window does not support the assigned function, that function is 
not executed on that window. 

 

In addition to RecMic buttons, functions can also be assigned to combinations that involve the PC keyboard 

[Shift] and [Ctrl] key. To execute a function assigned to a key combination, hold the [Shift] or [Ctrl] key on 

the PC keyboard as you press the applicable RecMic button. 

 

Application Control settings can be saved in a file, so the same settings can be imported by other users. 

This means that the same settings can be setup in multiple user environments, which improves work 

efficiency. 

 

[Import] 
Imports key function assignments from a file. Click the [Import] button 
and then specify the file you want to import. 

[Export] 
Exports key function assignments to a file. Click the [Export] button and 
then specify the output destination and file name. 

 

Command DR VR Description 

<Empty>   No command is assigned. 

Launch Dictation Module   Starts up Dictation Module. 

Cancel / Exit Y Y 

Stops recording and returns to the Main Window. 

The Dictation Module is disabled while the Main Window is 

displayed. 

Record Verbal Comment Y  
While this button is pressed, verbal comment recording is 
performed from the position of the record indicator cursor. 
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Switch between High and 

Normal Priority 
Y Y 

Changes the priority setting of the dictation file being 

recorded. 

(High<->Normal) 

Switch between Conference 

and Dictation 
Y  

Changes the recording sensitivity. 

Switch between Insert and 

Overwrite mode 
Y  

Changes the recording mode. 
(Insert <-> Overwrite) 

Pending Dictation Y Y 

In case of DR, saves the dictation file currently being 
recorded and assigns it Recording Pending status, and closes 

the Direct Recording Window. 

In case of VR, performs the same operation as the “Pending” 
menu item Speech Recognition Editor. 

Finish Dictation Y Y 

In case of DR, saves the dictation file currently being 

recorded and assigns it Recording Finished status, and closes 

the Direct Recording Window. 
In case of VR, performs the same operation as the “Finished” 

menu item Speech Recognition Editor. 

Delete Instruction Comment Y  Deletes the instruction comment of the recording file. 

Undo Y Y Undoes the last operation. 

Redo Y Y Redoes the last undone operation. 

Volume Up Y Y Increases playback volume. 

Volume Down Y Y Decreases playback volume. 

Dictation/Instruction 

Comment mode 
Y  

Toggles between the Instruction Comment record and 
playback modes. 

Insert Index Mark Y  
Inserts an Index Mark at the playback indicator cursor 
position. 

Delete Index Mark Y  
Deletes the Index Mark at the playback indicator cursor 

position. 

Send For Correction  Y 
Performs the same operation as the [Send for Correction] 
menu item of the Speech Recognition Editor. 

Show Correction Dialog  Y 
Performs the same operation as the [Show Correction Dialog] 

menu item of the Speech Recognition Editor. 

Show Spell Dialog  Y 
Performs the same operation as the [Show Spell Dialog] 
menu item of the Speech Recognition Editor. 

Train Word  Y 
Performs the same operation as the [Train Word] menu item 

of the Speech Recognition Editor. 

Add New Word  Y 
Performs the same operation as the [Add New Word] menu 
item of the Speech Recognition Editor. 

Start Dragon Audio Setup 

Wizard 
 Y 

Performs the same operation as the [Start Dragon Audio 

Setup Wizard] menu item of the Speech Recognition Editor. 

Copy to Clipboard Y Y 
Performs the same operation as the [Copy to Clipboard] 

menu item of the Speech Recognition Editor. 

• In the case of DR, the box displays commands that are enabled during recording with the Direct 
Recording Window. 

• In the case of VR, the box displays commands that are enabled when performing speech recognition 
with Real-time Speech Recognition. 
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9 Wireless Downloader (Standalone mode only) 
 

Wireless Downloader is a resident program for downloading dictation files via Wi-Fi from a DS-9500, and is 

installed automatically when Dictation Module is installed. 

If you set the wireless transfer settings of the DS-9500 in ODMS, Wireless Downloader will be resident in 

the task tray. When dictation files are received from the DS-9500, they will be stored in the target download 

tray (Folder A-G) in the same way as downloading with USB. 

Furthermore, a function is also available for backing up transferred dictation files to any specified folder. 

 

Language Selection 

Select the display language of Olympus Wireless Downloader. 

 

Enable auto-backup 

Automatically back up files to the specified folder. 

 

● If you select “Link with ODMS Backup Folder”, the files downloaded to the backup folder of ODMS 

will be backed up. The purge process of the backup will be in accordance with Folder Design. 

● If you select “Manage folders by date”, the files downloaded for every date will be backed up to 

any specified path. Also, when the date specified as the start point for downloading has elapsed, purging is 

also possible. 

Path:  Backup destination path 

Enable Purge: Enable/disable purging 

Elapsed days: 1 to 365 [days] 
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10 Troubleshooting 
 

This chapter assists in solving problems with Dictation Module. 

 

The Dictation Module Does Not Start Up 

Cannot Perform Direct Recording Window Operations with RecMic 

The System Remains Silent 

DVR Is Not Recognized 

Collecting Information with Log Tool 

Updating 



 189/231 

10.1 The Dictation Module Does Not Start Up 
 

If the Dictation Module does not start up, check for the following items. 

 

Other Olympus software is running 

Some Olympus software does not allow the Dictation Module to be started up while it is running. 

Check that none of the following software applications are running. If any one of the following applications 

is running, exit it and then start up the Dictation Module. 

• Olympus Dictation Management System R7 

Transcription Module 

• Olympus Dictation Management System R6 

Dictation Module / Transcription Module / File Downloader 

• DSS Player Pro R5 

Dictation Module / Transcription Module 

• DSS Player Standard 

Dictation Module / Transcription Module 

• Olympus Sonority 
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10.2 Cannot Perform Direct Recording Window Operations 

with RecMic 
 

If the window does not respond when you perform RecMic button operation while you have an Olympus 

RecMic Series device connected to a PC and running the Direct Recording Window or Speech Recognition 

Window, check for the following items. 

 

Device Configuration Manager is running 

Device Configuration Manager is speech recognition support software that is available for free use by those 

who have purchased an Olympus RecMic Series device. A PC that has Device Configuration Manager 

installed starts up Device Configuration Manager whenever the PC is started up. 

While Device Configuration Manager is running, it manages all button operations of any RecMic device 

connected to the PC. At this time, other applications are unable to detect RecMic device button operations. 

Consequently, Direct Recording Window operations are not performed when RecMic buttons are pressed. 

If you want to use RecMic to perform Direct Recording Window operations, exit Device Configuration 

Manager. 
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10.3 The System Remains Silent 
 

If no sound is produced, verify the following items: 

Recorder Connection 

 Check that the device is connected to your PC and turned ON. 
 

Speakers 

 Check that the speaker volume is turned up to an audible level. 
 

Sound Card 

 Check whether or not your sound card features a manual volume control; if it does, try turning 
up the volume. 

 

Playback Volume 

To check this, perform the following steps: 

 Procedure 

1. Click [Settings] - [Control Panel] on the [Start] menu. 

2. Select [Sounds and Audio Devices] - [Audio], and then click [Volume]. 

3. Check that the volume of [Volume Control] and [Wave] are not set to the minimum 

level and that [Mute] box is not checked. (Play WAV File) 

With Windows, you can adjust the playback volume of each application. If the global system volume is set 

correctly, the Dictation Module specific volume may be turned off. To check this, perform the following 

steps. 

 Procedure 

1. Start up Dictation Module. 

2. On the [Start] menu, click [Settings]-[Control Panel]. 

3. Switch to the category view. Under the [Sound] category, click “Adjust system 

volume”. 

4. The Volume Mixer dialog box that appears shows the currently running applications. 

Check that the Dictation Module volume is set to an appropriate level. 
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When running a Terminal Services environment 

When running the Dictation Module under a Terminal Service environment, the client PC needs to have a 

Terminal Services Client Virtual Driver installed. The Terminal Services Client Virtual Driver supports 

playback under Terminal Services. 

Install a Terminal Services Client Virtual Driver that is the same version as the Dictation Module being used. 

Terminal Service Client Virtual Driver is included with ODMS R7 Workgroup Launcher. 

 

Software Internal Error 

An internal error that occurs when installing the Dictation Module can cause incorrect installation of the 

playback program. This will cause the message “Run OlyCodecFilterSetup.exe.” to appear when the 

Dictation Module is started up. 

If this happens, run OlyCodecFilterSetup.exe, which is located in the Dictation Module installation folder. 

This will perform a repair setup of the playback module, and may enable proper operation of the playback 

program. 

If the same message appears after you run OlyCodecFilterSetup.exe, contact your Olympus Dealer where 

you purchased the product. 
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10.4 DVR Is Not Recognized 
 

If the recorder connected to the PC is not recognized, verify the following items: 

 Procedure 

1. After connecting the recorder to your PC using a USB cable, check that the LCD 

display of the Digital Voice Recorder reads REMOTE. 

2. If REMOTE is not displayed, remove the USB cable from the recorder and check that 

the Stop mode and the hold switch are not enabled. 

3. Reconnect the USB cable to the recorder and check that the LCD display reads 

REMOTE. 

4. If it still does not display REMOTE, try connecting the device to an alternative USB 

port. 
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10.5 Collecting Information with Log Tool 
 

Olympus Dictation Management System R7 provides the ability to trace and log a series of application 

operations. To perform logging, the modules to be logged have to be specified before the application is 

started. When a problem is encountered, it is recommended that the PC operating conditions and the log 

data of the problematic areas be sent to your dealer or distributor. 

 Procedure 

1. Select [Launch Log Tool] in the [Help] menu. 

  

 Log Tool launches in the state with the Trace check boxes of all modules selected. 
 

 

2. Click  next to the Output Path field to specify the log output path. 

3. Click [Start]. 

 The mode becomes log output mode, and output of the logs of the specified items will start at 
the next startup. 

4. Perform a problematic operation with Dictation Module, and then exit the 

application. 

5. Click [STOP]. 
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 The log output settings are canceled. 

6. Click [Copy Profiles] if needed. 

 A settings file will be generated into the folder specified in the [Profile Output Path]. 

7. Click [Send Log Files]. 

 Mail software will start, creating an email with ODMSLog.zip, a compressed log file and 
settings information. 

8. Write the required information in the email and send it to your dealer or distributor. 
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10.6 Updating 
 

When a version newer than the currently installed one is detected, a notification dialog box for upgrading 

will appear. If upgrading is selected, the data is downloaded from the server and then updating of Dictation 

Module begins. 

 

Updating Dictation Module 

To update Dictation Module, perform the following steps: 

 Procedure 

1. Select [Check for Update] from the [Help] menu. 

The Olympus download server will be checked for updates. 

When a version newer than the currently installed one is detected, a confirmation dialog 

box for updating will appear. 

2. Select updating. 

 The data will be downloaded from the server and updating of Dictation Module will begin. 
 

If a proxy server needs to be configured, click Proxy Settings and configure the address and port number of 

the server. 

 

Updating the Connected Device 

To update the connected device, perform the following steps. 

 Procedure 

1. Select [Check for Update] from the [Help] menu. 

The Olympus download server will be checked for updates. 

If there is a newer version of the firmware of the device, a confirmation dialog box for 

upgrading will appear. 

2. Select updating. 

 The data will be downloaded from the server and transferred to the device. When you 
disconnect the USB cable from the device, the update start screen will appear. 

 

If a proxy server needs to be configured, click Proxy Settings and configure the address and port number of 

the server. 
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11 Appendix 
 

Names and Functions of Window Components 

Menu List (Main Window) 

Menu List (Speech Recognition Editor/Real-time Speech Recognition) 

Menu List (Speech Recognition Editor/Text Correction) 

File Property Lists 

Default Key Assignments 
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11.1 Names and Functions of Window Components 
 

This section describes the names and functions of Dictation Module screens. 

 

Main Window 

Playback Control Window 

Direct Recording Window 

Direct Recording Bar 

Speech Recognition Editor 

 

Main Window 

This is the Main window of Dictation Module. It is used to organize and play files. The Direct Recording 

window is launched from the Main window.  

The names and functions of the Main window components are described here. 

 

 

 

 
Title Bar 
Displays the standard Windows title bar. 

 
Menu Bar 

①  

④  

③  
②  

⑤  

⑥  

⑦  

⑨  

⑧  

⑩  
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Displays the menu used with Dictation Module. 

 
Toolbar 
Displays toolbar buttons, which are divided among four groups: Standard, Editing, Mail/FTP, 

Speech Recognition. Displayed buttons vary depending on the settings. Dragging a toolbar 
button with the [Alt] key pressed can change the display order of the buttons. Right-clicking 
the toolbar displays the context menu, which can be used to show or hide the buttons. 

 
Playback Control Bar 
Used to play the dictation File selected in the Content List View. The Playback Control bar 
provides functions and ways of use similar to the Playback Control window. 

 
Dictation Tree View 
Displays various folders storing audio and document files managed by Dictation Module. 

Organization and properties of the folders can be configured based on the user's needs. 
Selecting a folder displays audio and document files in the folder in the Content List View. 

 
Device Tree View 
Displays folders in connected devices and cards. Selecting a folder displays the dictation 

files in the folder in the Content List View. 

 
Content List View 
Lists audio or document files in the folder selected in the Dictation Tree View or Device Tree 
View 

 
Information View 
Displayed by clicking [Restore] in the Content List View. This view displays information on 
content in the Content List View, including the content of a document file and the message 
of a sent email. 

 
Properties View 
Displays the properties of the file or folder that is currently being focused on 

 
Status Bar 
Displays the following information: 

First Area (Operating state display) 
Displays the current operating state. In the halt condition, the number of content items 
listed in the Content List View and the number of selected content items among them are 
displayed. 

Second Area (Icon display) 
Displays the progress of files being automatically sent via email or FTP. Double-clicking this 
area with an icon displayed shows the Status dialog box, where you can see the progress of 
transmission. When an error occurs, an icon appears. By double-clicking the icon, the 
details of the error can be checked. 

Third Area 
Displays Author ID. If no Author ID has been registered, the Windows log-on ID is 
displayed. 
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Playback Control Window 

The names and functions of the Playback Control window components are described here. 

Double-click a DSS or DSS Pro file from Windows Explorer to display this window. This window is specialized 

for playing a file. It is used to perform tasks like writing a document while listening to a recorded file. 

Exiting the window brings the user back to the Main window. 

 

 

 

 
Title Bar 
Displays the name of the file that is currently being played and the name of the folder in 
which the file is stored. 

 
Control Panel 

Play Bar and Position Slider  
Graphically displays which part of the current file is being played The range, from the 
beginning to the currently played position, is represented with blue, and verbal-

commented ranges are represented with light green. 

Index Mark  

Clicking  inserts an index mark at the Position control point. 

Displayed Area Slider  
Indicates the currently displayed range in the dictation file. Dragging the slider shifts the 
displayed range. 
 

 
Control Buttons 

Priority Button  
This mark indicates the priority of the file. A red mark means that the file is assigned high 
priority. 

Audio/Instruction Comment Mode Switching Button  
Switches between audio playback and Instruction Comment playback. In the Instruction 

Comment mode, the icon and the Play bar upper part are displayed in red. 

 

 : Moves to the beginning of a file. 

 : Moves to the previous index mark or to the edge of a verbal comment. 

 : Rewinds a file. Holding the button speeds up rewinding. 

 /  : Starts playback. Pressing this button during playback stops it. 

 : Fast-forwards a file. Holding the button speeds up fast-forwarding. 

 : Moves to the next index mark or to the beginning (or end) of a verbal comment. 

 : Moves to the end of a file. 
 

①  
 ④  

 
⑤  

⑥  ⑦  ⑧  ⑨  ⑩  ⑪  

②  

③  
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Information Button  
Clicking this button displays the property information of the file. The Main window does not 

have this button. 

Option Setting Button  
This allows you to change the option settings. 

 

 Playback Position/Recording Time Length  
Displayed on the immediate right of the Play bar, in the format of HH:MM:SS. The 
playback position of a file is displayed in blue, and the total recording time length is 
displayed in white. 

 
Timescale Control  
Displays the timescale of the Play bar. The time frame can be changed in the range of a 1-

minute width to full scale. Clicking [-] or [+] can change the timescale. 

 

Volume Adjustment Control  
Adjusts output sound volume. 

 

Audio Output Display  
Displays the current state of audio playback. In the case of monoral recording, the L and R 
outputs are displayed at the same height. 
You can set this to be displayed or hidden in Option Settings. 

 Playback Speed Adjustment Control  
The playback speed can be changed from 50% to 200% without changing the voice pitch 
(sound pitch). 
Click [-] or [+], or drag the slider to adjust the playback speed. You can select whether to 
display or hide this in Option Settings. 

 

 Noise Cancellation Control  
The level of the noise cancellation effect can be changed to any of four levels: 0, 1, 2, and 
3. 
Click [-] or [+], or drag the slider to adjust the noise cancellation effect. You can select 
whether to display or hide this in Option Settings. 

 

 Tone Adjustment Control  
Clicking  and  or dragging the slider adjusts the tone in increments of 1% from 100% 
on the B side to 100% on the T side. 
You can select whether to display or hide this in Option Settings. 

 
Status Bar 
Displays the following information: 
First Area: The current operating state (Play, Stop, Fast-forward, Rewind, QUE, REVIEW) 
Second Area: Author ID  

Third Area: Worktype 
Fourth Area: Comment 
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Direct Recording Window 

The names and functions of the Direct Recording Window components are described here. 

The Direct Recording Window is displayed by clicking  or  in the Main window, or by clicking [New 

Dictation] or [Edit Dictation] on the [File] menu. This window is used to create (record) and edit a file with a 

supported device. Exiting the window brings the user back to the Main window. 

 

 

 

 
Title Bar 
Displays the name of the file that is currently being edited and the name of the folder in 
which the file is stored 

 
Toolbar 
Displays the toolbar buttons. 

 
Control Panel 

Play Bar and Position Slider  
Graphically displays which part of the current file is being played The range, from the 
beginning to the currently played position, is represented with blue, and verbal-
commented ranges are represented with light green. 

Index Mark  

Clicking  inserts an index mark at the Position control point. 

Displayed Area Slider  
Indicates the currently displayed range in the dictation file. Dragging the slider shifts the 
displayed range. 

 

 
Control Buttons 

Priority Button  
This mark indicates the priority of the file. A red mark means that the file is assigned high 
priority. 

Audio/Instruction Comment Mode Switching Button  
Switches between audio playback and Instruction Comment playback. In the Instruction 
Comment mode, the icon and the Play bar upper part are displayed in red. 

Microphone Sensitivity / /  
The microphone sensitivity can be changed in accordance with the recording purpose and 
environment. 

Microphone sensitivity can be selected for only an Olympus device connected via USB. 
- High: High sensitivity level. Suitable for recording conferences. 
- Middle: Suitable for dictations. 

- Low: Low sensitivity level. Suitable for recording conversations in noisy environments. 

①  
 

 

 

 

 

 

②  

③  

④  
⑤  

⑥  

⑦  

⑧  ⑨  ⑩  ⑪  ⑫  

⑬  
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Recording Mode /  
This switches between the insert and overwrite recording modes. 

 

 : Recording will begin. 

 : Record a verbal comment only while this button is being pressed. 

 : Moves to the beginning of a file. 

 : Moves to the previous index mark or to the edge of a verbal comment. 

 : Rewinds a file. Holding the button speeds up rewinding. 

 /  : Starts playback. Pressing this button during playback stops it. 

 : Fast-forwards a file. Holding the button speeds up fast-forwarding. 

 : Moves to the next index mark or to the beginning (or end) of a verbal comment. 

 : Moves to the end of a file. 

Bar Display Switch Button  

If you press this button, the Playback Control window switches to the Direct Recording bar. 

Information Button  
Clicking this button displays the property information of the file. The Main window does not 
have this button. 

Option Setting Button  
This allows you to change the option settings. 
 

 
Status Bar 

First Area: The current operating state (Play, Stop, Fast-forward, Rewind, QUE, 
REVIEW) 
Second Area: Author ID  
Third Area: Worktype 
Fourth Area: Comment 

 Playback Position/Recording Time Length  
Displayed on the immediate right of the Play bar, in the format of HH:MM:SS. The 

playback position of a file is displayed in blue, and the total recording time length is 

displayed in white. 

 
Timescale Control  
Displays the timescale of the Play bar. The time frame can be changed in the range of a 
one-minute width to full-scale. Clicking  or  can change the timescale. 

 

Volume Adjustment Control  
Adjusts output sound volume. 

 

 

Audio Output Display  
Displays the current state of audio playback. In the case of monoral recording, the L and R 
outputs are displayed at the same height. 
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You can set this to be displayed or hidden in Option Settings. 

 Playback Speed Adjustment Control  
The playback speed can be changed from 50% to 200% without changing the voice pitch 
(sound pitch). 
Click [-] or [+], or drag the slider to adjust the playback speed. You can select whether to 
display or hide this in Option Settings. 

 

Noise Cancellation Control 
The level of the noise cancellation effect can be changed to any of four levels: 0, 1, 2, and 
3. 
Click [-] or [+], or drag the slider to adjust the noise cancellation effect. You can select 

whether to display or hide this in Option Settings. 

 Tone Adjustment Control  
Clicking  and  or dragging the slider adjusts the tone in increments of 1% from 100% 
on the B side to 100% on the T side. 

You can select whether to display or hide this in Option Settings. 

 
Stops recording and sets whether or not the file status is recording finished. 

 [Finished] 
Ends recording and sets the status to recording finished. Notification that preparation for 
transcription is complete can be sent to the transcriptionist. 

 [Pending] 
Ends recording and sets the status to pending. 
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Direct Recording Bar  

 

 

 

Dragging the corner of the bar resizes the bar from 50% to 200%. 

 Priority Button  
This mark indicates the priority of the file. A red mark means that the file is assigned high 
priority. 

Audio/Instruction Comment Mode Switching Button  
Switches between audio playback and Instruction Comment playback. In the Instruction 

Comment mode, the icon and the Play bar upper part are displayed in red. 

Recording Mode /  
This switches between the insert and overwrite recording modes. 

 

 : Recording will begin. 

 : Record a verbal comment only while this button is being pressed. 

 : Moves to the beginning of a file. 

 : Moves to the previous index mark or to the edge of a verbal comment. 

 : Rewinds a file. Holding the button speeds up rewinding. 

 /  : Starts playback. Pressing this button during playback stops it. 

 : Fast-forwards a file. Holding the button speeds up fast-forwarding. 

 : Moves to the next index mark or to the beginning (or end) of a verbal comment. 

 : Moves to the end of a file. 
 

 Playback Position/Recording Time Length  
The current playback position is displayed in the format of HH:MM:SS. 

 
Play Bar and Position Slider  
Graphically displays which part of the current file is being played The range, from the 
beginning to the currently played position, is represented with blue, and verbal-
commented ranges are represented with light green. 

Index Mark  
Indicates an index-marked position. 

 

 
Option Buttons 

Volume Control Button  
Pressing this button displays the slider to allow you to adjust the volume with the mouse. 

Speed Control Button  
Pressing this button displays the slider to allow you to adjust the playback speed with the 
mouse. 

Tone Control Button  

①  ②  

④  ③  ⑤  

⑥  
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Pressing this button displays the slider to allow you to adjust the tone with the mouse. 

Select Microphone   
 Selects the speaker supplied with a PC or the one provided by a connected Olympus digital 
voice recorder. 

Channel Separation Control Button  
Each press of this button switches to left, right, stereo, or mono. 

Edit Index Mark Button  
Inserts an index mark at a place that is not marked and deletes the mark at a place with a 
mark. 

Show/Hide Properties Button  
Each press of this button shows or hides the properties of the file. 

Extended Display Switching Button  
Switches to the Direct Recording window. 

 

 
Close Button  
Closes the Direct Recording bar. 

 Option Button Switching  
Shows or hides the Option button. 
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Speech Recognition Editor 

This is the screen that appears for text editing when performing real-time speech recognition or after doing 

speech recognition with Dictation Module. 

In the case of a dictation file that has been transcribed without using speech recognition, the application 

associated with the file format of the text file is started up.  

 

 

 

 
Title Bar 
Shows the folder name and file name currently being recorded or played back. 

 
Menu Bar 
Displays menus of various commands used for speech recognition and text correction. 
Command availability depends on the status of the file. 
For information about the functions of each menu, refer to “Menu List (Speech Recognition 

Editor/Real-time Speech Recognition)” or “Menu List (Speech Recognition Editor/Text 
Correction)”. 

 
Toolbar 
Displays buttons that execute various commands used for speech recognition and text 
correction. 
A large variety of different commands including dictation record, playback, stop and other 

commands, and font operation and other text editing commands. 
Command availability depends on the status of the file. 
For information about the functions of each button, refer to “Menu List (Speech Recognition 
Editor/Real-time Speech Recognition)” or “Menu List (Speech Recognition Editor/Text 
Correction)”. 

 
Text Display Area 
This area show text that is output by speech recognition. 
When using real-time speech recognition, text is output in sequence from passages for 

which Dragon speech recognition processing is complete. 
When editing speech recognition results, text editing can be performed while operating the 
toolbar playback controls to playback the dictation. When performing real-time speech 

①  

②  

③  

④  

⑤  



 208/231 

recognition, use of both manual input and Dragon editing functions is supported. For text 
editing after speech recognition is complete, only manual text editing is available. 

When playing back dictation, the text that corresponds to the current playback location is 
highlighted in order to give you an idea of the location of the text that is playing back. 

 
Status Bar 
The left area of the status bar shows the dictation playback/recording status, and other 
information. 
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11.2 Menu List (Main Screen) 
 

This section describes the menus provided by Dictation Module. 

 

[File] Menu 

[Folder] Menu 

[Edit] Menu 

[View] Menu 

[Play] Menu 

[Tool] Menu 

[Device] Menu 

[Speech Recognition] Menu 

[Help] Menu 

 

11.2.1 [File] Menu 

 

Command Name Button Functions 

New Dictation 
 

Opens the Direct Recording window and creates a new 
dictation File 

Edit Dictation 
 

Displays a selected dictation File in the Direct Recording 

window, allowing file editing 

Convert Dictation 
 

Converts a dictation file into a specified file format 

Import Dictation 
 

Imports an external dictation File not managed by Dictation 

Module so that Dictation Module can manage it 

Export Dictation 
 

Converts a selected dictation File into external media 

Split 
 

Splits a selected file at a specified position into two files 

Join 
 

Joins multiple files into a single file 

Encrypt 
 

Encrypts a selected file 

Decrypt 
 

Decrypts a selected encrypted file 

Open Document 
 

Opens a selected document file. When running this operation 
with a dictation file specified, the linked document file will 

also open. 

Associate with Document 
 

Associates a selected dictation File with a specified external 
document file. The associated document file will be copied to 
My Documents and managed with the link. 

Remove Association with 
Document  

Dissociates a dictation file from its linked document file 

Edit Job Data 
 

Edits the job data of a selected dictation File. Job data refers 
to several editable settings: Author ID, Worktype ID, Option 
Items, and Comments. 

Change Status 
 

Changes the status of a selected dictation File 

Exit Ctrl+W Exits Dictation Module 
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11.2.2 [Folder] Menu 

 

Command Name Button Functions 

New Folder 
 

A subfolder will be created in a highlighted folder in the 
Download tray. 

Add Folder 
 

Opens the Select Folder dialog box to create a shortcut path 

to a specified folder at the same level as Download Tray. 

Remove Folder 
 

Deletes the subfolder created with [New Folder] and 
removes the folder created with [Add Folder]. 

Rename Folder 
 

Renames a selected folder. 
The folders in the Download tray and custom folders are 
shortcut folders maintained internally by ODMS. When 
renaming is applied to these folders, only the shortcuts are 
renamed, not their actual folders. Subfolders are real folders 
and can be renamed. 

Folder Settings 
 

Starts the Folder Design dialog box, with which you can 

configure the attributes of a folder 

 

11.2.3 [Edit] Menu 

 

Command Name Button Functions 

Cut 

 

Copies a selected dictation File to the clipboard Pasting the 

dictation File after cutting it moves the file to the specified 
folder. 

Copy 
 

Copies a selected dictation File to the clipboard 

Paste 
 

Moves or copies the dictation File, which was copied to the 
clipboard with the Cut or Copy command, into a specified 

folder 

Delete 
 

Deletes a selected audio or document file 

Select All - Selects all the files in the Content List View 

Copy to Folder 
 

Copies the dictation File selected in the Content List View to 
a specified folder 

Move to Folder 
 

Moves the dictation File selected in the Content List View to a 
specified folder 
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11.2.4 [View] Menu 

 

Command Name Button Functions 

Folder Navigation - Shows or hides the Dictation Tree View or Device Tree View 

Property Window - Shows or hides the Properties View 

Information Window - Shows or hides the Information View 

Toolbar - 
Toggles the toolbar between show and hide. 
“Customize” can be used to specify the buttons to appear on 
each toolbar. 

Status Bar - Shows or hides the status bar 

Playback Control Bar - Shows or hides the Playback Control bar 

Gridlines - Shows or hides the grid lines in the Information View 

Columns to Display - 
Shows or hides the columns in the Dictation Tree View and 
configures their displayed order 

Sort by - 
Sorts files in alphabetical order by the columns selected in 

the Information View 

Filter On/Off  Enables or disables the filtering function 

In-line Edit  

 

Enables or disables direct editing of the items displayed in 
the Dictation Tree View. Clicking a configurable item in the 
list makes the field editable. 

Refresh 
F5 

 

Refreshes the Dictation Tree View in the Main window. The 
Dictation Tree View refers to cached data for speeding up 
the display. Since refreshing the list causes the cached data 
to be rebuilt, it may take a while to display a large list. 

 



 212/231 

11.2.5 [Play] Menu 

  

Command Name Button Functions 

Play/Stop F9 

 

 

Plays a selected file or the first file on the list in the 

Content List View from the Position control point on the 
Play bar. Clicking this menu during playback stops it. 

Fast Forward F8 

 

Fast-forwards a file. Holding the button speeds up fast-
forwarding. 

Rewind F7 

 

Rewinds a file. Holding the button speeds up rewinding. 

Next Index Mark 

 

Moves the Position control to the next index mark 

Previous Index Mark 

 

Moves the Position control to the previous index mark 

Volume 

 

Adjusts output sound volume. 

Speed 

 
Speeds up or slows down playback 

Tone 

 

Configures the tone, placing an emphasis on the high or 
low pitch areas 

Noise Cancellation 

 

Selects the level of noise cancellation from 0, 1, 2, and 
3. A larger number means a higher effect of noise 
cancellation. 

Insert Index Mark 

 
Inserts an index mark at the Position control point 

Delete Index Mark 

 
Deletes an index mark at the Position control point 

View All Index Mark 

 

Displays the View All Index Mark dialog box 

Next Verbal Comment 

 

The Position control moves to the next index mark or to 
the beginning (or end) of a verbal comment 

Previous Verbal Comment 

 

The Position control moves to the previous index mark 
or to the beginning (or end) of a verbal comment 

Dictation / Instruction 
Comment Mode 

F10 

 

Switches between Dictation File mode and Instruction 
Comment mode if an Instruction Comment has been 
recorded in the currently selected dictation file 

Intro Scan 

 

Sequentially plays only the first five seconds of the files 
selected or displayed in the Content List View 
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11.2.6 [Tool] Menu 

 

Command Name Button Functions 

Select Speaker 

 

 

Selects the speaker supplied with a PC or the one provided by 
a connected digital voice recorder when playing a file 

Send via E-mail 

 

Manually moves a selected dictation File to the email sending 
box. If multiple email profiles have been registered, select a 
profile for transmission with the pop-up menu. 

Send via FTP 

 

Manually sends a selected dictation File via FTP 

Send and Receive 

 

The Send command sends an email in the sending box or a 
file via FTP to the server. When the transmission successfully 
completes, the dictation File will move to Sent Items. The 
Receive command initiates the reception of document files. 

Hotkeys On/Off 

 

 

Enables or disables Hot keys 

Keyboard Settings 
- 

Displays the user-configured keyboard options. It enables the 
user to assign Hot keys to Dictation Module commands, and to 
delete or modify the assignments. 

OLE Settings 

- 

Sets one of the following actions for when a DSS or DSS Pro 
file selected in Content List View is dropped into an application 
that supports the OLE function. 
• Embed the dictation file as part of the document file. 
• Embed only the information of the link to the dictation in the 

document file. 

Options 

 

Displays the Option Settings dialog box for Dictation Module 

Show Setup Wizard 

- 

Displays Setup Wizard. 

Only displayed if Dictation Module is installed in a Standalone 
System. 

 



 214/231 

11.2.7 [Device] Menu 

 

Command Name Button Functions 

Download Folders A-G - Downloads all files in Folders A-G in the device displayed in 
the Device Tree View (recorder, PCMCIA card, or removable 
drive) into the corresponding Folders A-G in the Download tray 
in the Dictation Tree View 

Download Selected Files - Downloads only selected files into the Download tray in the 
Dictation Tree View 

Download All 

 

Downloads all files in the device displayed in the Device Tree 
View into the corresponding Folders A-G in the Download tray. 

Files in the removable drive that have no folder are 
downloaded into Folder A. 

Upload Selected Files 

 

Uploads the files selected in the Dictation Tree View into the 
device displayed in the Device Tree View 

Change Device Mode 

 

Switches device mode of a connected device to Audio mode or 

Storage mode 

Change Storage Media 
 

This command is available only for models that support two 
types of storage media. If the external SD card is selected 

when connected by USB to the PC, the button is displayed on 
the left side of the device. It is impossible to display the 
contents of both media simultaneously. 

Synchronize Date/Time 

 

Synchronizes the date and time of the recorder with those of 
the PC. The device can also be automatically synchronized 

with the PC when connected. 

Device Setting 
 

With this menu, the functions of a connected device can be 
configured via the PC. 

 

11.2.8 [Speech Recognition] Menu 

 

Command Name Button Functions 

Do Real-time Speech 
Recognition  

Starts the Speech Recognition Editor and executes real-time 
speech recognition. 

Add to Recognition Queue 
 

Registers the dictation file that is selected in the content list 
view into the Recognition Queue. 

Start Recognition Queue 
 

Executes background speech recognition. 
Speech recognition of dictation files registered in the speech 
recognition queue is performed in sequence. 

Stop Recognition Queue 
 

Stops ongoing background speech recognition. 

Move to the Top Position - 

Moves the dictation file that is selected in the speech 
recognition queue up in the queue to the position following the 
dictation file on which background speech recognition is 

currently being performed. In the displayed speech recognition 

queue, the file is moved so it is directly under the dictation file 
on which background speech recognition is currently being 
performed. 

Requeue 
 

Re-registers the dictation file that is selected in the speech 
recognition result list into the queue. 

Only a dictation file whose speech recognition has failed for 
some reason can be requeued. A file whose speech recognition 
was successful cannot be requeued. 

Details - 
Shows detailed information about the speech recognition 
result of a dictation file that is selected in the speech 

recognition result list. 

Add to Adaptation Waiting 
List  

Registers the dictation files and text corrections that are 
managed in the adaptation folder in the Adaptation queue. 

Adapt All Files  

Performs adaptation on all of the dictation files registered in 

the adaptation queue. Users can select to do either vocabulary 
adaptation or acoustic adaptation, or both vocabulary 
adaptation and acoustic adaptation. 
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Do Vocabulary Adaptation 
 

Performs vocabulary adaptation only on the dictation file 
selected in the adaptation queue. 

If a selected dictation file has already had vocabulary 
adaptation performed, that file will be ignored. 

Do Acoustic Adaptation 
 

Performs acoustic adaptation only on the dictation file selected 
in the adaptation queue. 
Vocabulary adaptation needs to be performed first before 
performing acoustic adaptation. If a selected dictation file has 
not yet had vocabulary adaptation performed, that file will be 
ignored. 

Remove from the Queue 
 

Deletes the selected dictation file from the speech recognition 
queue or other displayed speech recognition function list. 

Clear the Queue 
 

Deletes all of the files from the speech recognition queue or 
other displayed speech recognition function list. 

Check All Items 
 

Selects ON for all dictation files registered in the speech 
recognition queue. 

Uncheck All Items 
 

Selects OFF for all dictation files registered in the speech 

recognition queue. 

Add Fields to Template 
 

Displays a dialog box for adding a voice field for speech 
recognition. 
 

Speech Recognition 
Settings 

- 
Displays the page that appears when the following operation is 
performed on the Option Settings dialog box: [Workflow] – 
[Speech Recognition] – [General]. 

 

 

11.2.9 [Help] Menu 

 

Command Name Button Functions 

Contents F1 Displays the Help for Dictation Module 

Check for Updates - 
Checks the Olympus download server for the latest Updates 
and downloads them if present 

Device Manual Download 
Site 

- 
Starts up your Web browser and displays the Olympus Website 
that publishes device instruction manuals. 

About Dictation Module - Displays the version information of Dictation Module 
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11.3 Menu List (Speech Recognition Editor/Real-time 

Speech Recognition) 
This section explains the Speech Recognition Editor menu that is displayed during real-time speech 

recognition. 

 

[File] Menu 

[Edit] Menu 

[View] Menu 

[Dictation] Menu 

[Dragon Commands] Menu 

[Voice Information] Menu 

[Help] Menu 

 

11.3.1 [File] Menu 

 

Command Name Button Functions 

Template  Specifies the template file to be used. 

Copy to Clipboard 
 

Copies text files that have text formatting to the clipboard. 
After copying, the text with the text formatting can be pasted 
into MS word or some other application. 

Send for correction 
 

Saves dictation data and the text file and changes the file 

status to SpeechRecognition.Finished. 
Files are handled as: “recording and speech recognition 
complete, text file to be corrected”. Though subsequent add-
on recording to the dictation file is not possible, the text can 

be edited. 
Use this command to request correction and other tasks of the 
typists after author recording is complete. 

Finished 
 

Saves dictation data and the text file and changes the file 
status to Transcription.Finished. 

Files are handled as: “dictation recording and text file editing 
complete”, and subsequent add-on recording and text editing 
is not possible. 

Pending 
 

Saves dictation data and the text file and changes the file 
status to Transcription.Pending. 

Add-on recording and text editing can be restarted later. 

Cancel 
 

Cancels changes and closes the Speech Recognition Editor. 

 

11.3.2 [Edit] Menu 

 

Command Name Button Functions 

Undo 
 

Undoes the last operation. 

Redo 
 

Redoes the last undone operation. 

Cut 
 

Copies the text currently selected in the text display area to 
the clipboard. Executing Cut and then Paste will move the cut 
text to the cursor position. 

Copy 
 

Copies the text currently selected in the text display area to 
the clipboard. 
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Paste 
 

Moves text put on the clipboard with Cut or copies text put on 
the clipboard with Copy to the cursor location. 

Select Next Word 
 

Selects the next word relative to the cursor position in the text 
display area. 

Select Previous Word 
 

Selects the previous word relative to the cursor position in the 
text display area. 

Next Field 
 

Selects the next field word relative to the cursor position in 

the text display area. 

Previous Field 
 

Selects the previous field word relative to the cursor position 
in the text display area. 

Clear Field Delimiters 
 

Deletes all delimiters '[', ']' in the field. 

Capitalize Word 
 

Capitalizes the first letter of each sentence in the text selected 
in the text display area. 

Compound Words 
 

Deletes all the spaces between the selected words. 

 

11.3.3 [View] Menu 

 

Command Name Button Functions 

Toolbar - 
Toggles toolbars between show and hide, specifies the 
buttons displayed in toolbars, etc. 

Status Bar - Toggles the status bar between show and hide. 

 

11.3.4 [Dictation] Menu 

 

Command Name Button Functions 

Record 
 

Starts dictation recording and auto speech recognition using 
Dragon. Speech recognition results are automatically added 
from the cursor position in the text display area. Dictation 

recording is also inserted from the location that corresponds to 
cursor location in the text. 

Mic Sleep/Wake Up 
 

Stops/restarts speech recognition. 
(Voice commands are received even when stopped.) 

Play/Stop  

 

Restarts dictation recording from the cursor position in the 
text display area. Pressing this button again stops playback. 
During playback, the text that corresponds to the playback 
position is highlighted. 

Home 
 

Returns the cursor to the beginning of the text. 

Rewind 
 

Rewinds a file. 

Fast Forward 
 

Fast-forwards a file. 

End 
 

Moves the cursor to the end of the text. 

Volume 
 

Adjusts output volume. 

Modes 
 

Allows you to select Speech Recognition mode in Dragon. 

 

11.3.5 [Dragon Commands] Menu 

 

Command Name Button Functions 

Show Correction Dialog 
 

Displays the Correction dialog box of Dragon. 
Correction suggestions for the text where the cursor is located 
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are displayed and can be selected in the text display area, and 
they can be used to correct the speech recognition results. 

Show Spell Dialog 
 

Displays the Spell dialog box of Dragon. 

Train Word 
 

Displays the Train dialog box of Dragon. 
This is used to teach Dragon particular terms in the author's 
voice (training). This help to improve speech recognition 
accuracy for the trained terms. 

Add New Word 
 

Displays the Add New Word dialog box of Dragon. 

This can be used by Dragon to learn terms it does not know. 

Start Dragon Audio Setup 
Wizard  

Starts Dragon Audio Setup Wizard of Dragon. This allows the 
Dragon engine to learn the characteristics and other 
information about the microphone device to be used for 
speech recognition. 

Create New Command 
 

Displays MyCommands Editor of Dragon. This allows you to 

create and edit user defined voice commands. 

 

11.3.6 [Voice Information] Menu 

 

Command Name Button Functions 

Change Priority 
 
 

Change the priority of the dictation file. 

Show Information Window 
 

Displays detailed information about a dictation file. 

Show Edit Job Data Dialog 
 

Displays the Edit Job Data dialog box. 

 

11.3.7 [Help] Menu 

 

Command Name Button Functions 

Contents  Opens Help. 
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11.4 Menu List (Speech Recognition Editor/Text Correction) 
This section explains the Speech Recognition Editor menu that is displayed during speech recognition. 

After a dictation file transitions to a status that does not allow further add-on recording, the menus change 

to text correction only menus. Menus that can be used vary depending on the status of the dictation file. 

 

[File] Menu 

[Edit] Menu 

[View] Menu 

[Dictation] Menu 

[Voice Information] Menu 

[Help] Menu 

 

11.4.1 [File] Menu 

 

Command Name Button Functions 

Template 
 

Specifies the template file to be used. 

Copy to Clipboard 
 

Copies text files that have text formatting to the clipboard. 
After copying to the clipboard, the text with the text 
formatting can be pasted into MS word or some other 
application. 

Save 
 

Saves a text file. The file status is unchanged. 

Finished 
 

Saves the text file and changes the file status to 
Transcription.Finished. 
Files are handled as: “dictation recording and text file editing 

complete”, and subsequent text editing is not possible. 

Pending 
 

Saves the text file and changes the file status to 
Transcription.Pending. 
Files are handled as: “text editing temporarily interrupted, but 
will be resumed later”, and text editing can be resumed with 

the Speech Recognition Editor. 

Print 
 

Prints text. 

Print Preview 
 

Displays a text print preview. 

Cancel 
 

Cancels changes and closes the Speech Recognition Editor. 

 

11.4.2 [Edit] Menu 

 

Command Name Button Functions 

Undo 
 

Undoes the last operation. 

Redo 
 

Redoes the last undone operation. 

Cut 
 

Copies the text currently selected in the text display area to 
the clipboard. Executing Cut and then Paste will move the cut 

text to the cursor position. 

Copy 
 

Copies the text currently selected in the text display area to 
the clipboard. 
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Paste 
 

Moves text put on the clipboard with Cut or copies text put on 
the clipboard with Copy to the cursor location. 

Find 
 

Displays a text search dialog box, which searches for the text 
string specified in the text display area. 

 

11.4.3 [View] Menu 

 

Command Name Button Functions 

Toolbar - 
Toggles toolbars between show and hide, specifies the 
buttons displayed in toolbars, etc. 

Status Bar - Toggles the status bar between show and hide. 

 

11.4.4 [Dictation] Menu 

 

Command Name Button Functions 

Play/Stop  

 

Playback the dictation file from the cursor position in the text 

display area. Pressing this button again stops playback. 
During playback, the text that corresponds to the playback 
position is highlighted. 

Home 
 

Returns the cursor to the beginning of the text. 

Rewind 
 

Rewinds a file. 

Fast Forward 
 

Fast-forwards a file. 

End 
 

Moves the cursor to the end of the text. 

Volume 
 

Adjusts output volume. 

Speed 
 

Adjusts the dictation playback speed. 

Tone 
 

Configures the tone, placing an emphasis on the high or low 
pitch area. 

 

11.4.5 [Voice Information] Menu 

 

Command Name Button Functions 

Show Information Window 
 

Displays detailed information about a dictation file. 

 

11.4.6 [Help] Menu 

 

Command Name Button Functions 

Contents  Opens Help. 
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11.5 File Property Lists 
 

This section explains the dictation file and document file properties that are displayed in the Content List 

View. 

 

R/W: Read and Write attributes. The items that have the W attribute are user-editable. 

The Filter column indicates whether or not the filter is set. The Option column shows the option setting for 

filtering. 

 

Displayed Property List (Dictation File List View) 

Displayed Property List (Adaptation - Forwarded List View) 

 

Displayed Property List (Dictation File List View) 

 

The following table lists the properties and their descriptions displayed in the Dictation File List View. 

 

Property Description R/W Filter Option 

Priority Level A numeric value representing the 
priority level, ranging from 0 to 15 

R/W Yes Value 

Priority Priority (High/Normal) R/W Yes No 

Speech Recognition Whether or not the dictation file has 

been speech-recognized 

R Yes No 

Instruction Comment Whether or not the dictation File is 
instruction-commented 

R Yes No 

Encrypted Whether or not the dictation file is 
encrypted 

R Yes No 

Locked Whether or not the dictation file is 
locked 

R Yes No 

File Name The name of the dictation file R/W No --- 

Author The Author name R/W Yes No 

Worktype The Worktype name R/W Yes No 

Created The date and time of when the dictation 
File was started 

R Yes Date 

Completed The date and time of when the dictation 

file was finished 

R Yes Date 

Downloaded The date and time of when the dictation 
file was downloaded 

R Yes Date 

Deletion Date The date and time of when the dictation 
file was deleted 

R Yes Date 

Backup Date The date and time of when the dictation 
file was backed up 

R Yes Date 

Transcriptionist The name of the Transcriptionist R Yes No 

Transcription Started The date and time of when a 
transcription was started 

R Yes Date 

Transcription 
Completed 

The date and time of when a 
transcription was finished 

R Yes Date 

Process/Status The Process/Status of the dictation file 
 : Process Recording 
 : Process Transcription 

 : Process Speech Recognition 
 

R/W Yes No 

Duration The recording time length of the R Yes Value 
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dictation file (HH:MM:SS) 

File Size The size of the dictation file (KB)  R No --- 

Option Item 1 The content of Option Item 1 R/W Yes No 

Option Item 2 The content of Option Item 2 R/W Yes No 

Option Item 3 The content of Option Item 3 R/W Yes No 

Option Item 4 The content of Option Item 4 R/W Yes No 

Option Item 5 The content of Option Item 5 R/W Yes No 

Option Item 6 The content of Option Item 6 R/W Yes No 

Option Item 7 The content of Option Item 7 R/W Yes No 

Option Item 8 The content of Option Item 8 R/W Yes No 

Option Item 9 The content of Option Item 9 R/W Yes No 

Option Item 10 The content of Option Item 10 R/W Yes No 

Comment Comments for a dictation file R/W Yes No 

Document The name of a document file linked with 

a dictation file 

R No --- 

File Format The extension of the dictation file R Yes No 

Audio Format The format of the dictation file R Yes No 

Original Location The folder in which the dictation file was 
originally stored 

R Yes No 

Receiver The receiver of the dictation file R Yes No 

Sent Date The date and time of when the dictation 
file was sent 

R Yes Date 

Location The location of where the dictation file is 
stored (full path) 

R No --- 

DSS License The name of the vendor that supplies 
the codec for the dictation file 

R Yes No 
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Displayed Property List (Document List View) 

 

The following table lists the properties and their descriptions displayed in the Document List View. 

 

Property Description 

Priority Level A numeric value representing the priority level, 
ranging from 0 to 15 

Priority Priority (High/Normal) 

Speech Recognition Whether or not the associated dictation file has 
been speech-recognized 

Instruction Comment Whether or not the associated dictation file is 
instruction-commented 

Encrypted Whether or not the dictation file is encrypted 

Locked Whether or not the dictation file is locked 

File Name The name of the document file 

Author The Author name 

Worktype The Worktype name 

Transcriptionist The name of the Transcriptionist 

Transcription Started The date and time of when a transcription was 
started 

Transcription 
Completed 

The date and time of when a transcription was 
finished 

Process/Status The Process/Status of the dictation file 
 : Process Recording 
 : Process Transcription 

 : Process Speech Recognition 
 

Option Item 1 The content of Option Item 1 

Option Item 2 The content of Option Item 2 

Option Item 3 The content of Option Item 3 

Option Item 4 The content of Option Item 4 

Option Item 5 The content of Option Item 5 

Option Item 6 The content of Option Item 6 

Option Item 7 The content of Option Item 7 

Option Item 8 The content of Option Item 8 

Option Item 9 The content of Option Item 9 

Option Item 10 The content of Option Item 10 

File Format The extension of the document file 

File Size The size of the document file (KB)  

Dictation The name of the associated dictation file 

Sender The sender of the document file 

Received Date The date and time of when the document file was 

received 

Location The location of where the document file is stored 
(full path) 
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11.6 Default Key Assignments 
 

This section lists the initial default key assignments. 

 

Default Key Assignments 

 

Default Key Assignments 

 

Playback Control Key Assignments 

Direct Recording Key Assignments 

General Key Assignments 

Speech Recognition Key Assignments 

Dragon User Command Key Assignments 

Function Assignments for Function Keys 

 

Playback Control Key Assignments 

Command Default Key 

Play/Stop F9 

Stop - 

Fast-forward F8 

Rewind F7 

Next Index Mark Ctrl+Right 

Previous Index Mark Ctrl+Left 

Next Verbal Comment Ctrl+Shift+Right 

Previous Verbal Comment Ctrl+Shift+Left 

Jump to Top - 

Jump to End - 

Volume Up Ctrl+Up 

Volume Down Ctrl+Down 

Speed Up Ctrl+Shift+Up 

Speed Down Ctrl+Shift+Down 

Tone Up Ctrl+Alt+Up 

Tone Down Ctrl+Alt+Down 

Noise Cancellation Level*1 - 

Insert Index Mark Ctrl+Alt+I 

Delete Index Mark - 

Dictation/Instruction Comment Mode F10 

*1: Each command execution cyclically switches levels in the order of Off, 1, 2, 3, and then back to 

Off again. 

 

Direct Recording Key Assignments 

Command Default Key 

Record Ctrl+Alt+F1 

Record Verbal Comment Ctrl+Alt+F2 

Switch between High and Normal priority Ctrl+Alt+F3 
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Switch between Conference and Dictation Ctrl+Alt+F4 

Switch between Insert and Overwrite mode Ctrl+Alt+F5 

Pending Dictation Ctrl+Alt+F6 

Finish Dictation Ctrl+Alt+F7 

Change Saving Folder*2 Ctrl+Alt+F8 

Send / Don’t Send Finished Dictation*3 Ctrl+Alt+F9 

Delete Instruction Comment Ctrl+Alt+D 

Undo Ctrl+Alt+Z 

Redo Ctrl+Alt+Y 

Cancel Ctrl+Alt+F10 

*2: Finishing a dictation displays the Save As dialog box. With this dialog box, you can specify the file 

name, change the saving destination, and select whether or not to automatically send the file. 

This command is for changing the save destination. Each execution of this command changes the 

save destination to the next folder. 

*3: Finishing a dictation displays the Save As dialog box. With this dialog box, you can specify the file 

name, change the saving destination, and select whether or not to automatically send the file. 

Each execution of this command toggles between auto send and do not set. 

 

General Key Assignments 

Command Default Key 

New Dictation Ctrl+N 

Edit Dictation Ctrl+O 

Do Real-time Speech 

Recognition 

Ctrl+R 

Property View Ctrl+Alt+F6 

Hotkeys On/Off F11 

Download All Ctrl+Shift+M 

Show List Search Dialog Ctrl+F 

 

Speech Recognition Key Assignments 

Command Default Key 

Show Correction Dialog  Ctrl+Shift+F2 

Show Spell Dialog  Ctrl+Shift+F3 

Train Word  Ctrl+Shift+F4 

Add New Word  Ctrl+Shift+F5 

Start Dragon Audio Setup Wizard  Ctrl+Shift+F6 

Create New Command  Ctrl+Shift+F7 

Switch to Normal Mode  Shift+Alt+F1 

Switch to Dictation Mode  Shift+Alt+F2 

Switch to Command Mode  Shift+Alt+F3 

Switch to Numbers Mode  Shift+Alt+F4 

Switch to Spell Mode  Shift+Alt+F5 

Next Field  Shift+Alt+Right  

Previous Field Shift+Alt+Left 

Clear Field Delimiters Ctrl+Alt+C 

Capitalize Word Ctrl+Shift+F8 

Compound Words Ctrl+Shift+F9 

Copy to Clipboard Ctrl+Shift+C 

Microphone Sleep/On Ctrl+Alt+S 

Send For Correction Ctrl+Shift+F1 

Template Ctrl+T 
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Dragon User Command Key Assignments 

Command Default Key 

User Command 1 Ctrl+F1 

User Command 2 Ctrl+F2 

User Command 3 Ctrl+F3 

User Command 4 Ctrl+F4 

User Command 5 Ctrl+F5 

User Command 6 Ctrl+F6 

User Command 7 Ctrl+F7 

User Command 8 Ctrl+F8 

User Command 9 Ctrl+F9 

User Command 10 Ctrl+F10 

Function Assignments for Function Keys 

Programmable 

Button 

Windows Standard ODMS 

[F1] Display Help Display Help 

[F2] Edit Item Edit Item 

[F3] Search --- 

[F4]   

[Ctrl]+[F4] Close Window  

[Alt]+[F4] Exit Application Exit Application 

[F5] Refresh Window Refresh Window 

[F6]  Move Pane 

[F7]  Rewind 

[F8]  Fast-forward 

[F9]  Play/Stop 

[F10]  Switch Dictation/Instruction 
Comment Mode 

[Shift]+[F10] Show Context Menu Show Context Menu 

[F11]  Hotkey On/Off 

[F12]   
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12 Support Contacts 
 

For Purchasing License Keys 

To purchase the following license keys, please contact your dealer or distributor. 

 

• Dictation Module Volume License for Standalone 

• Transcription Module Volume License for Standalone 

• ODMS R7 Volume license 
 

  

Asking about Malfunctions 

When submitting a query, the information below needs to be provided to our support staff along with the 

details of your problem. Please keep the following data handy. 

• Type of PC (manufacturer and model) 

• Amount of memory  

• Hard disk space  

• Name and version of the OS  

• Connected peripheral devices  

 

For assistance in solving a problem such as a malfunction, please contact your dealer or distributor. 

 

Other Support 

Various types of information, including product specifications, PC connections, support for OSes, and FAQs, 

are available on our Web site. For the latest information, access the Olympus website for your region. 
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13 Glossary 
 

Backup 

After a folder's backup settings are configured, any file saved in the folder will be automatically 
backed up to the other specified folder. 

Citrix XenApp/XenDesktop 

Product name of a client/server system that is called a virtual environment enabling operation 
of applications running on a server or of the server PC desktop itself from a remote client PC on 

the network. Diverse client operating systems are supported, including Windows, Macintosh, 
Linux, etc. A Windows server can also be remotely operated from a smartphone or other 

portable device is Citrix client software supports. 

Clean 

A folder attribute and a way to delete files. Old dictation files can be deleted through one of two 
methods: by directly deleting them or by moving them to the Recycle Box and then deleting 
them with the delete option. Setting the Clean attribute enables automatic clean-up of old 
dictation files. 

Composite Mode 

Mode that simultaneously runs multiple standard USB classes when a recorder is connected to a 
PC. Supported USB classes depend on the model. With the DS-7000/3500, three classes 
(Audio, HID, Storage) are operated simultaneously. Audio class supports function as a PC 

microphone and/or speaker, HID class supports button operations, and Storage class supports 
operation as a removable disk. Leaving the device USB connection mode set in Composite 
mode enables smooth operation of Dictation Module and Transcription module functions. 

Direct Record 

A recording method that enables connection of a microphone device to a PC and recording of 
dictation data directly to the PC. Dictation can be directly recorded to a PC using an Olympus 
RecMic Series or other specialized direct record device, or a recorder microphone connected to 
the PC USB port. 

DRM 

This stands for Digital Rights Management. It is a general term for the technologies that protect 
the copyrights of digitally-created contents and regulate the use and replication of them. 

DSS 

This stands for Digital Speech Standard. 

This voice encoding standard has been developed by Olympus and two other companies. It can 

downsize audio data while maintaining sound quality. All of Olympus recorder models support 
DSS. DSS-compliant dictation files have the "DSS" extension. 

DSS Pro 

An audio standard enhanced from the classic DSS. 

Key differences from the DSS standard include QP (Quality Play) mode for high-grade 
recording, an increase from 16 to 32 in the number of settable index marks, support for 
dictation File encryption, and support for verbal comment recording. DSS-compliant dictation 

files have the "DS2" extension. 
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FTP 

This stands for File Transfer Protocol. This is a protocol used for transferring a file over the 
TCP/IP network. 

Hot Key 

A function that allows an application or button operation on the device to be assigned to a key 
on the keyboard and to be executed simply by pressing that key. It can be customized and 
enables the user to work more efficiently by registering frequently used functions. 

HTTPS 

A protocol that integrates SSL (Secure Sockets Layer) encrypted communication into HTTP. 

Instruction Comment 

An Instruction Comment is an instruction or other message recorded for a Transcriptionist. It 
can be created only with Direct Recording and cannot be created when making a recording with 
a standalone recorder. It is maintained as a file separately from a dictation file and is recorded 
to provide a Transcriptionist with instructions. 

Job Data 

A general term to refer to the Author ID, worktype, option item, comment, or other data that 
can be specified for a dictation file by the Dictation Module or Transcription Module. 

Such specified data items serve as keys for dictation file management, classification, and other 
management. 

Noise Cancellation 

An operation that reduces noise output by extracting and filtering out noise components from a 
dictation file. The cancellation effect can be adjusted to three different levels. 

MP3 

An MPEG-1-based audio compression method. Like other major audio compression techniques, 
it uses a lossy compression method that achieves a high compression rate by deducting less 
audible portions from sound data. Dictation Module/Transcription Module supports it only for 

playback. The file extension is .MP3. 

MSI Package 

A Windows Installer-compliant package for installation. 

OLE 

When dragging and dropping a dictation file onto a document file, it can be configured to be an 
embedded object or a linked object. 

Embedding causes audio data to be stored as-is, which results in a large volume of data. 
However, even if the stored data is ported to another PC, it can be played back on the 
destination PC as long as the PC has a player installed that can play back the applicable audio 
format. In the case of a link, only the file name and path of the audio file is stored which means 

a smaller volume of data, but playback cannot be performed if the document file is ported to a 
location from which the audio data embedded in the file cannot be accessed. 

Option Item 

An item associated with a worktype. Up to 10 items can be registered with combinations of 
values. 

Option Items can be input with such tools as Baltech Transponder and a barcode reader. 
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Ownership 

An attribute that, based on Author privileges, prevents a dictation file from moving to the 
Finished folder in Transcription Module after the file has been transcribed. With this attribute 
configured, the file is not moved to the Finished folder in Transcription Module the moment 
transcription has been completed. 

Priority Level 

This is represented by the 16 priority levels of 0 to 15, and allows the user to prioritize 

dictations. 

Proxy 

This is a boundary that separates an internal network from the external Internet. It is a 
computer or software that connects to the Internet on behalf of an internal computer that 
cannot directly access the external network. A proxy centrally controls the access traffic 

between the Internet and the internal network, and blocks unauthorized accesses. 

Standalone System 

The basic system of Olympus Dictation Management System. It represents a system 
environment in which Dictation Module and Transcription Module run on local PCs, and 

management tools such as System Configuration Program are not used. 

Storage Mode 

An operating mode that causes recorder built-in memory or a memory card to be recognized as 
a removable drive when the recorder is connected to a PC. Normal removable disk operations 
are supported, the same as with USB memory and other types of removable memory.  
However, the recorder cannot be used as a PC microphone or speaker when it is connected in 
Storage Mode. When using the recorder for direct recording, you need to switch to Audio mode, 

Composite, mode, or some other operating mode in which the normal USB Audio class is 

supported. 

Terminal Service 

This is a client service provided by Windows Server. It can execute applications and services 
provided by the server on the client side. A separate license such as TS-CAL is required to use 
this function. 

VCVA 

A capability that enables sound-initiated recording (called Variable Control Voice Actuator) in 
order to improve usability and efficiency for prolonged recording. It halts recording after a 

certain period of silence and resumes it in response to sound. The sound level to initiate 

recording can be adjusted. Level settings optimized for different recording environments ensure 
efficient recording. For recording intended for speech recognition, it is recommended to disable 
the VCVA function. 

Verbal Comment 

A voice comment that is embedded in dictation file data. A verbal comment can be recorded 
with a supported recorder. It is provided to transcribe audio data immediately after 
commentary.A verbal comment is recorded at any position in a dictation file based on the need 

for instructions. 

WAV 

A standard dictation file format for Windows. It is also referred to as the WAVE format. The 
specifications include the saving format for recording a digitally converted audio signal. The file 

extension is WAV. 
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WMA 

A standard audio format for Windows. This technology is a component of Windows Media, a 
multimedia technology incorporated in Windows, and is a standard audio compression 
technique. The file extension is .WMA. 

Workgroup System 

It is one of the operating modes in ODMS which operates DM/TM remotely from some 
administration software. The System Configuration Program can be used for remote Dictation 

Module/Transcription Module setting configuration and updating. Furthermore, the licenses for 
multiple users can also be centrally managed. 

Worktype 

This is the data used to classify dictations. The user can classify the types and Authors of 
dictations with the application by selecting a Worktype on the recorder when making a new 

recording. 

Using Option Items associated with a Worktype, additional attributes can be provided. 
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